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CONVIPRE AGORA E RECEBA VIA SEDEX

O SHOPPING DA INSTRUMENTACAO

PROVADOR DE CINESCOPIO PRC-20-P

E utilizado para medir a emisdo e reativar
cinescopios, galvanémetro de dupla acéo.
Tem uma escala de 30 KV para se medir

. AT. Acompanha ponta de prova + 4 placas
(12 soquetes).

PRC 20 P i R$ 350,00
PRC 20 D oo, R$ 370,00

TESTE DE TRANSISTORES DIODO - TD29

Mede transistores, FETs, TRIACs, SCRs,
identifica elementos e polarizagdo dos
componentes no circuito. Mede diodos (aberto
ou em curto) no circuito. ....R$ 220,00

PROVADOR RECUPERADOR DE CINESCOPIO -
PRC40

Permite verificar a emisdo de cada
canhdo do cinescopio em prova e
reativa-lo, possui galvanémetro com
precisdo de 1% e mede MAT até 30 kV.
Acompanha ponta de prova + 4 placas
(12 soquetes). ..ovevrieiiiiinns R$ 330,00

Mede FLYBACK/YOKE estatico quando se
tem acesso ao enrolamento. Mede
FLYBACK encapsulado através de uma
ponta MAT. Mede capacitores eletroliticos
no circuito € VPP ......c.ceeeeee. R$ 290,00

GERADOR DE BARRAS GB-51-M

Gera padrdes: quadriculas, pontos, escala
de cinza, branco, vermelho, verde, croma
com 8 barras, PAL M, NTSC puros ¢/
cristal. Saidas para RF, Video, sincronismo
e Fle, R$ 300,00

E o mais Gtil instrumento para pesquisa de
. defeitos em circuitos de som. Capta o som
| que pode ser de um amplificador, radio AM -
455 KHz, FM - 10,7 MHz, TV/Videocassete -
4,5 MHZ o R$ 285,00

Instrumento preciso e pratico, nas escalas
de 200 pF, 2 nF, 20 nF, 200 nF, 2 uF, 20
pF, 200 pF, 2000 pF, 20 mF....R$ 300,00

MULTIMETRO DIGITAL MD42

Tens&o c.c. 1000 V - precisdo 1%, tensdo c.a. -
750 V, resistores 20 MQ, corrente c.c/c.a. - 20
A ganho de transistores hfe, diodos. Ajuste de
zero externo para medir com alta precisdo
valores abaixo de 20 Q................... R$ 195,00

Otima estabilidade e precisdo, p/ gerar
formas de onda: senoidal, quadrada,
triangular, faixas de 0,2 Hz a 2 MHz.
Saidas VCF, TTL/MOS, aten. 20 dB.
GF39 i R$ 390,00

MULTIMETRO CAPACIMETRO DIGITAL MC 27

Tensdo c.c. 1000 V - precisdo 0,5 %, tensao
c.a. 750 V, resistores 20 MQ, corrente DC AC
- 10 A, ganho de transistores, hfe, diodos.
Mede capacitores nas escalas 2n, 20n, 200n,
2000n, 20 PF. e, R$ 260,00

GERADOR DE RADIO
FREQUENCIA - 120 MHz - GRF3O

Sete escalas de frequéncias: A-100 a 250
kHz, B- 250 a 650 kHz, C- 850 a 1700 kHz,
D-1,7 a4 MHz, E- 4 a 10 MHz, F- 10 a 30
MHz, G- 85 a 120 MHz, modulagdo interna e
eXIerNa. ..o R$ 375,00

GERADOR DE BARRAS GB-52

Gera padrdes: circulo, pontos, quadriculas,
circuilo com quadriculas, linhas verticais,
linhas horizontais, escala de cinzas, barra de
cores, cores cortadas, vermelho, verde, azul,
branco, fase, PALM/NTSC puros com cristal,
saida de Fl, saida de sincronismo, saida de
RF canais 2 & 3. .oooevviiiviiinnn R$ 420,00

FREQUENCIMETRO DIGITAL

Instrumento de medigéo com excelente
estabilidade e preciséo.
FD32 -1 Hz /1,2 GHz ..cocue. R$ 480,00

SABER MARKETING DIRETO

) 6942-8055 - PRECOS VALIDOS ATE 10/06/2001

LIGUE JA (11

FONTE DE TENSAO

Fonte variével de 0 a 30 V. Corrente maxima de saida 2 A. Protecéo de
curto, permite-se fazer leituras de tenséo e corrente AS tensao: grosso
fino AS corrente.

FS35 - Digital ............ R$ 280,00  FR34 - Analbgica ......... R$ 255,00



Editora Saber Ltda.
Diretores

Hélio Fittipaldi

Thereza M. Ciampi Fittipaldi

Revista Saber Eletrdnica Especial
Editor e Diretor Responsavel
Hélio Fittipaldi

Diretor Técnico
Newton C. Braga

Publicidade

Eduardo Anion - Gerente
Daniela Marques Silva
Ricardo Nunes Souza

Impressiao

Revista produzida sem o uso de
fotolitos pelo processo de
"pré-impressdo digital" por:
W.ROTH (11) 6436-3000

Distribuicio
Brasil: DINAP
Portugal: ElectroLiber

REVISTA -

SABER ELETRONICA ESPECIAL
(ISSN - 1518-5990) é uma publica-
¢do trimestral da Editora Saber Ltda.
Redacfio, administragfo, assinatura,
nimeros atrasados, publicidade e
correspondéncia:

R. Jacinto José de Aratijo, 315 -
CEP.: 03087-020 - Sao Paulo - SP -
Brasil . Tel. (11) 296-5333

Atencio:

Esta ediciio ndo €
comercializada pelo sistema de
assinaturas

Tiragem desta edigdo:
25.030 exemplares

Matriculada de acordo com a Lei de
Imprensa sob n° 4764. livro A, no 5°
Registro de Titulos e Documentos -
SP.

Empresa proprietdria dos direitos de
reprodugdo:
EDITORA SABER LTDA.

Associado da ANER - Associagdo
Nacional dos Editores de Revistas e
da ANATEC - Associagdo Nacional
das Editoras de Publicacbes Técnicas,
Dirigidas e Especializadas.

|PUBLICA¢ﬁES ESPECIALIZADAS I

www.anatec.org.br

www.sabereletronica.com.br
e-mail: rsel@edsaber.com.br

GUIA E CONTEUDQO DO CD coooeseveeeeeeeeeeeveeeeeareeevatrisivassssisasarasensntsesaenssssans 2

STARPLUG oot esteeieevte s et st ess e ane s an e cita e nabs st e s csiasecranans 5
Software aplicativo desenvolvido pela Philips, criado para simplificar o trabalho dos
técnicos e engenheiros de aplicagdo no projeto e dimensionamento de fontes
chaveadas (SMPS).

MULTISIM200T ..eeeeeeeeeeeee ettt s s caa s ar s s e anrnanenas 11
Programa desenvolvido pela Electronics Workbench que simula e captura circuitos
eletrénicos.

Y2 Ot DU SO 16

Poderosa plataforma de desenvolvimento de software desenvolvida pela National
Instruments, ideal para programagédo gréfica(G), que usa icones ao invés de linhas
de texto para criar aplicagbes de aquisicdo, controle, andlise e apresentagdo de
dados.

COLETANEAS DE SITES DE ELETRONICA .....covvoiimrvisiceircrressssssssssssessines 24
Neste artigo temos como objetivo passar aos leitores uma cole¢do bastante util de
enderecos de grandes empresas de Eletronica, além de fornecer algumas informa-
cBes sobre como navegar dentro de seus sites, localizando informagbes especifi-
cas.

MPLAB®IDE MICROCHIP ....oveeeireeeeeiteeivineescreasatren e resesnias s snans s asnn e snnsassans 30
Este software retine diversas ferramentas de desenvolvimento fornecidas pela
Microchip e empresas terceirizadas selecionadas para implementagdo de projetos.
Estas ferramentas incluem recursos como compiladores, programadores,
debbugers e emuladores In-Circuit (ICE).

PICLAB 4A .....eeeeeeieeieeeeteeeessceeteassctstsersiasssssisenesasastasesssvasnssannsssanan e sas st e s easnnnnssan 32
Veja neste artigo uma pequena abordagem das caracteristicas destinada ao
aprendizado em sala de aula dos PICs. A placa PicLab, agora na versdo 4A,
permite ao estudante realizar todas as etapas de desenvolvimento e aprendizado:
editar, compilar e simular seu programa usando o MpLab. (Veja o Mini-Curso
MpLab passo-a-passo na pdgina n.° 33).

COMPONENTES UTEIS - DATA-SHEETS DA INTERSIL ....cccovvcomvniccrvicrriirann. 73
Selecdo de data-shhets em formato PDF da Intersil Corporation.

FORMULAS UTEIS PARA CIRCUITOS COM DIODOS ....coeeveereriererriireenenseennnes 46
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Apresentamos como funcionam esses dispositivos e como empregé-los em
algumas aplicagGes prdticas, o que deve interessar aos leitores que precisam
conhecer as mais recentes tecnologias.

Os artigos assinados séo de exclusiva responsabilidade de seus autores. E vedada a reprodugao total ou parcial dos textos
e ilustragdes desta Revista, bem como a industrializagio e/ou comercializagéio dos aparelhos ou idéias oriundas dos textos
mencionados, sob pena de sangdes legais. As consultas técnicas referentes aos artigos da Revista deverdo ser feitas exclusi-
vamente por cartas, ou e-mail (A/C do Departamento Técnico). S&o tomados todos os cuidados razoaveis na preparagéo do
contetido desta Revista, mas ndo assumimos a responsabilidade legal por eventuais erros, principalmente nas montagens, pois
tratam-se de projetos experimentais. Tampouco assumimos a responsabilidade por danos resultantes de impericia do montador.
Caso haja enganos em texto ou desenho, sera publicada errata na primeira oportunidade. Precos e dados publicados em
antncios sd0o por nés aceitos de boa &, como corretos na data do fechamento da edigo. N&o assumimos a responsabifidade por
alteragdes nos pregos e na disponibilidade dos produtos ocorridas ap6s o fechamento.



GUIA E CONTEUDO DO CD

Caros leitores, na edicdo especial
ne 02 de fevereiro/2001 apresenta-
mos a vocés diversos Aplicativos,
Cliparts, Seminario COP8, Fotos,
Dicionario de Cédigos e o Mini-Cur-
so de Microcontrolador. E, pelo nd-
mero de e-mails e cartas cheias de
elogios que chegaram a redagao, es-
tamos indo no caminho certo. Claro
que recebemos algumas criticas, e
para estas respondemos que esta-
mos trabalhando em cima das su-
gestdes enviadas para que esteja-
mos cada dia mais afinados com o
gosto do nosso leitor.

Neste més preparamos algumas
novidades para os profissionais que
estdo ligados a Eletronica. Veja a
seguir os programas que acompa-
nham este CD-ROM:

Iniciando

Para iniciar a multimidia, simples-
mente cologue o CD no drive, espe-
re um pouco e a tela principal surge
automaticamente. No entanto, este
recurso nao é apresentado por todos
os drives de CD-ROM. Portanto, se
ndo acontecer nada, siga estas ins-
trugdes:

i ESPECIAL N°3 K

- Clique no botdo Start (Iniciar) e
entédo selecione a opgéo Run
(Executar) da janela de menu.

- Surge uma caixa de dialogo,
simplesmente digite
D:\especial3.exe, onde DouE é a
letra do seu drive de CD-ROM.

LabVIEW

STARplug

@MPLAB IDE

mul;iﬁ;m

aa TRANSISTORES

Agrobat ﬂeader 2

Utilize os botdes ao lado para iniciar a navegacao.
Para retornar a esta tela, clique sobre a seta ng
canto superior direito.

Cligue aqui pora abrin o

MiN: CURST MPLAB- PASSE.

Aperte a tecla Enter e depois de
alguns segundos, aparecera no
monitor de seu computador a tela
principal da multimidia.

Através desta tela vocé podera ir
para qualquer parte do CD.

Quando desejar voltar a tela prin-
cipal, cligue na seta posicionada no
canto esquerdo superior, ou feche o
navegador que por ventura venha
abrir.

O programa multimidia somente
sera finalizado através da tela prin-
cipal, clicando sobre o "X" que esta
na parte superior do lado esquerdo.

O minimo que esta multimidia
necessita para um bom funciona-
mento & um microcomputador 486,
com Windows 95, 16 MB de memo¢-
ria e leitor de CD de 8x ou superior.

A seguir, mostramos o0 mapa do
CD para que vocé nao tenha duvi-
das sobre sua utilizagdo.

DATA-SHEETS
Coleténea de data-sheets que re-
presentam centenas de paginas de
informagbes em formato pdf, sobre

mais de 50 componentes.

SABER ELETRONICA ESPECIAL N¢ 3/MAI0O/2001



LABVIEW

(versdo 6i - avaliagao 30 dias)

Poderoso software desenvolvido
pela National Instruments, ideal para
solucdes customizadas de controle,
aquisicdo, analise e apresentagéo de
dados. Apresenta uma interface
gréfica que permite programar a par-
tir de objetos funcionais ou instru-
mentos virtuais (VI's), ao inves da
rigida estrutura de programagéo
conhecida.

STARPLUG
(versdo 1.0 - completo)

Aplicativo fornecido pela Philips,
criado para simplificar o trabalho dos
técnicos e engenheiros de aplica-
¢do no projeto e dimensionamento
de fontes chaveadas (SMPS), utili-
zando a nova linha de circuitos inte-
grados da Philips, série TEA151x/
152x.

MPLAB®IDE
(versdo 5.30 - completo)
Apresenta um ambiente grafico
de desenvolvimento de software, que
integra diversas ferramentas de pro-
jetos, um depurador e um simulador

o 1

list p=16F8ha
radix  dec

include <P16F84a.INC>

PORTE
bsf STATUS,RPO
clrf TRISB

STATUS,RPB

—af

~

ESPECIAL NP3 x

de software, para maximizar o de-
senvolvimento de aplicagbes com o
microcontrolador PIC da Microchip.

MULTISIM2001
(demo)
Um software dedicado para pro-
jetos e simulagdo de circuitos eletrd-
nicos, produzido pela Electronics

]

‘.J«'!IIJE
80a800000'
b'e

Cyciss a ¢

Design Bar
Toggle Switch

Component Toolbar

10 : |
i Time 0.00ns |
stor Froquency  4.000008MHz |
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i 4 Mz User

Electromechanical

Parts Bin
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Os arquivos abaixo estao em inglés e no formate pdf, necessitando,
para serem visualizades, do programa Adobe Acrobat Reader ,
{CLIOUE AQUI PARA INSTALAR O ACROBAT READER 4.0)

INTERSIL
FNI4T  FN2189  FNST60  FN4TE5
FN343  FN2223  FN3180  FN4819
FNABC ~ FN2853  FN3G18  FN4B55
FNS32  FN2855  FN36S58  FN4B70
FNGB5  FM28BT  FN3E59  FN4ST1
FN741  FN2865  FN3983  FNASTS
FN788  FN2866  FN4047
FN795  FN2867  FN4275
FN1048  FN3019  FN4405
FN1239 FN3020  FN4S65
FN1836 FN3158

FN4B03  HAS020
FN4910 ICL7108-7
CA3078 fCL76505
CA3140 LM2902-CA324
CA3160

CA3280

eceer

e - r TS ]

WorkBench. Esta nova verséo apre-
senta como diferencial recursos adi-
cionais, tais como um link de aces-
s0 a um banco de dados com mais
de 10 milhdes de componentes, além
de melhorias na performance da
aplicagéo.

TRANSISTORES
(versdo 1.0 - completo)
Trata-se de uma programagéo
elaborada em java script que permi-
te aos usuario conhecer as caracte-
risticas de diversos tipos de transis-
tores.

Acrobat'Reade

140



AGORA NO BRASIL

MICROCONTROLADOR
PROGRAMADO EM BASIC

O BASIC Step € um microcon-

trolador programado em Basic.

Ele é especialmente usado para

controlar circuitos eletrénicos.

Caracteristicas:

Entradas/saidas: 8

EEPROM: 256 byies

RAM: 13 variaveis

Clock: 4MHz

Consumo: 2mA

Porta serial: 300 a 2400 bauds

Comandos em

Portugués e Inglés:

BUTTON, DEBUG, HIGH,

INPUT, LOW, QUTPUT, POT,

PULSIN, PULSOUT, PWM,

REVERSE, SERIN, SEROUT,

SOUND, TOGGLE, CHAVE,

| LIGA, DESLIGA, MEDEPULSO,

ESCREVESERIAL, FIM, etc

) Comprepor AN

reembolso postal

Outros Produtos

' .
Lo
e

Gravadores de PIC,
emuladores real-time,
placas para testes com PIC

Tato Equipamentos Eletrénicos
Rua Ipurinas,164 - S0 Paulo
Tel. (11) 5506-5335

hitp://www.tato.ind.br

EDITORIAL

Neste momento em que escrevo o edi-
torial, ja temos definido para a proxima edi-
¢ao de agosto o primeiro aplicativo com-
pleto para o CD.

E fica aqui a pergunta: o que nosso lei-
tor gostaria que apresentadssemos? Man-
dem logo suas sugestdes, para que pos-
samos prepara-la a tempo.

O Mini-Curso MpLab que trazemos €
um material inédito para a maioria dos lei-
tores que desejam desenvolver projetos
para a familia PIC de microcontroladores
utilizando este aplicativo, que disponibilizamos em nosso CD.

Hélio Fittipaldi

Para aqueles que sabem o trabalho que da fazer os célculos
em projetos de fontes chaveadas temos o StarPlug da Philips, que
é um aplicativo muito util e de facil utilizagéo.

Outro software muito conhecido é o MultiSIM2001da Electronics
Workbench, que estd em
langamento mundial apre-
sentando a nova versao para
este ano.

Uma solugéo
das mais po-
derosas para
aquisicdo, con-

NATIONAL trole, andlise e

INSTRUMENTS'
apresentacao
S MicrocHIP o dados 6

disponibilizada
pela National Instruments com a nova versao do seu LabView que,
entre outras coisas, apresenta o recurso de comunicacdo pela
Internet. 2




Software aplicativo dispo-
nibilizado pela Philips, cria-
do para simplificar o traba-
lho dos técnicos e engenhei-
ros de aplicagdo no projeto
e dimensionamento de fon-
tes chaveadas (SMPS), que
utilizem a nova linha de cir-
cuitos integrados Philips,
série TEA151x/TEA152x.

Na edicéo especial n® 2 da Revista
Saber Eletrénica, expusemos num ar-
tigo a importancia e as implicagbes
envolvidas no dimensionamento dos
transistores de poténcia utilizados no
circuito de comutacéo das fontes
chaveadas ou comutadas (SMPS).
Além disso, hd uma série de outros
circuitos de apoio a serem especifi-
cados, tais como o oscilador, inversor
e regulador, que também requerem
um consideravel tempo do engenhei-
ro de aplicag&o no projeto de uma fon-
te de tensdo e/ou corrente estavel,
segura e com razoavel eficiéncia.

Visando agilizar esta ardua tarefa
de ter que recorrer as férmulas e cal-
culos envolvidos, a divisdo de com-
ponentes da Philips desenvolveu uma
aplicagéo simples, porém notoria, que
se encarrega de todo o projeto das
fontes chaveadas. Basta apenas de-
finir alguns parametros caracteristicos

Fernando Ramos da Silva

a rede elétrica e a carga a ser alimen-
tada e, pronto, o programa faz o
restante.Denominado STARplug,
este programa ou aplicagao faz parte
do anudncio da nova linha de circuitos
integrados(CI's) Philips, destinados
ao circuito de controle das fontes de
alimentagdo comutadas.

APLICACAO STARplug

Para a execugéo do aplicativo, bas-
ta ir até o Windows Explorer, abrir a

pasta \STARplug localizada no drive
de leitura de CD-ROM (D: por exem-
plo) e executar o arquivo STARplug.
exe. Vocé devera encontrar a seguin-
te pagina: (ver figura 1).

Note que a tela principal possui
apenas duas guias de paginas : ge-
neral e schematic. A pagina general
contém os campos que receberéo as
entradas do usuario e as saidas pro-
duzidas pelo programa.

Ja a pagina schematic ilustra o es-
quema eletrénico completo do proje-
to que estiver sendo desenvolvido.

Volage Range |Universal ’-i
Frequency 50Hz ;"i

Insush Cutrent PF A [max]
Transients

¢ Yes (& No

Operating Frequency {100 kHz
Efficiency (Estimate) {73 %

Volkags [900 Vde 1

€ Secondait
& Primait

Regulation

Output lPawel 3,00 Watt

SABER ELETRONICA ESPECIAL N° 3/MAIO/2001

Fig. 1 - Pagina de abertura do Starplug.




Dessa forma, utilize a pagina general
para introduzir os parametros da con-
figuragdo de entrada e saida deseja-
dos, e ative os respectivos botdes

“Apply” de cada secdo, que a aplica- : Regullion @ Socrdsi
¢do dimensionara os componentes Output [Pove P i Vetge B0 v | ol e
i . Para modificar m— e R S |
Conforme.a flgufa 2 o el (nput §egtion———=—-<=-=-y ill —Transt i ~OVP/OCP !:
uma configuracéo feita, perceba que p [0 [z 5] | | A2 [T5Kom 4] [E24 7] ‘ Pimait Inductance (Lp) [1.73 v7 [Ve=22v
os botdes “Apply” alternam para | o r“‘—s,suwwuvgm c3 [moer [3][Ee = | Core Type [E13/6/3 =] | A [zaom [eze ] |
“Change”, e assim faz-se possivel efe- Ef ’ng":H’ oV sl ) ‘ Y P T
tuar as alteracdes. ) T | Flae 275 T v [ vee
No canto inferior direito da pagina D6 [V = 600V /i <= 250ns : Np e Ma | | crRMin [0 %
“general’, ha 4 botdes Alémpdc?s 3 [\ eTovrEmes L % Vidog i34 7 "Tums | Y | CTH bt [0 %
) » !
tradicionais (Print, Close e About) que “Dutput Comp R . 'g rAux Supply— rTL43 e i
: ¥ = : itching Di R B E | Vref (T £ Vi
toda interface gréfica padrao Windows S]] Fehotigy emcting Dicce :: j;tg:: ‘ . ;Z %lﬁ:z_% IL:TM[inTp] 11—"‘,.: :
: . T b ' Ip,max = 3,98 A & 3 ad
possui, existe o botdo “Export”, cuja _ {?33117%2% 8 | re [T2k0hm f 08 [P Diode Vam >=120v) Iref B w
fungéo é possibilitar a gravagdo deum  §| B A | ns o o Vaksat [0 mv
arquivo texto em disco, contendo a { ]"ms‘LZWMJV ::?E_‘&g%ﬂ -
e ~ | .2 KOhm
especificagéo de todos os componen- i P— il
tes do circuito projetado. ce [0 763V il c7 oo
Vale observar, ainda, que s é pos- L2 [104H /lssbin =B00mA | i | C10/100F

sivel utilizar o programa para projetar
fontes chaveadas na configuracéo fly-
back (derivado do conversor abaixa-
dor-elevador) com regulagéo primaria
ou secundaria.

Por essa razao, talvez a Unica res-
salva que possa ser feita a este exce-
lente programa, que demonstrou ser
um indispensavel assistente dos en-
genheiros de aplicagéo no projeto das
suas fontes chaveadas, resida na im-
possibilidade de se poder avaliar a
aplicacéo do Cl STARplug em outras
configuragdes de conversor possiveis,
como a buck ou abaixador de tenséo,
embora esta esteja amplamente dis-
cutida no Application Note da Philips.
Contudo, isto é um pormenor.

e 5 TABplug desin wie

-Requirements

VYoltage Range |Universal ¥]

Input

Frequency 60Hz ¥ Transients

Intush Current W A [max]}
@ Yes " No (1000 vpk {50 ps

System | gperating Frequency {100 kHz
Efficiency (Estimate) {76 %

CI’'S STARplug

Com a flexiblidade de poder operar
com saidas entre 2 e 50 W, aliada a
um robusto projeto com marcantes ca-
racteristicas de protecdo, os Cl’s
STARplug sé@o destinados as aplica-
¢Oes de baixa poténcia em uma am-
pla gama de dispositivos, tais como
os computadores portateis, carrega-
dores de celular e aparelhos de audio
e video.

A familia de produtos STARplug
esta dividida em duas séries, confor-
me ilustra a tabela 1 :

Fig. 2 - Dimensionamento de componentes.

Nota-se que uma das séries, a
TEA152x, j& comercializada na Euro-
pa e América do Sul, pode operar em
dispositivos com alimentagao elétrica
na faixa de 80 a 276 VAC e com po-
téncia disponivel variando de acordo
com os involucros DIP8/SO14 e DBS9
utilizados na constru¢do dos Cl’s.
Enquanto isso, a outra série de pro-
dutos, a TEA151x, dedica-se ac mer-
cado dos EUA e Japéao, e estara dis-
ponivel com alimentagéo elétrica res-
trita aos 115 VAC e com poténcia tam-
bém variando conforme o invélucro
empregado.

Alimentac¢éao Global
Tipo Rds(on) 80..276V 180..276V 150V

DIP-SO DBS | DIP-SO DBS | DIP-SO | DBS | Disponivel(?)
Europa /
América do Sul
TEA1524 3,5 15W 30W 30W 50W 15W 30W Sim
TEA1523 7 10W 20W 15W 35W 10W 20W Sim
TEA1522 12 W 10W 8W 20W W 10w Sim
TEA1521 24 3W - 4 5W - 3w - Sim
TEA1520 50 2W - 3w - 2W - Sim
EUA / Japao
TEA1514 3,5 - - - - 15W 30W Ql2001
TEA1513 7 - - - - 10W 20W QI2001
TEA1512 12 - - - - W - Ql2001
TEA1511 24 - - - - 3w - Ql2001

Tabela 1
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Vejamos agora as caracteristicas
principais de funcionamento dos Cl’s
STARplug visualizando-as a partir dos
seus respectivos circuitos.

Para uma nogéo geral, apresenta-
se na figura 3 o diagrama de blocos
do STARplug.

CARACTERISTICAS

1)Inicio de trabalho (Start-up) se-
guro e protecao contra baixa tensao
de alimentacéo

O pino de dreno(drain) do Cl esta
conectado a alimentagéo do circuito
ja retificada, e quando a tensdo neste
pino atinge um valor adequado, a uni-
dade de provisdo Supply fornece um
fluxo de corrente em direcéo ao pino
Vee. Apenas quando a tensdo no pino
Vce sobe e ulltrapassa um valor mini-
mo pré-definido (Vcc nivel minimo), é
que o STARplug inicia o seu funcio-
namento. Dessa forma, obtém-se um
start-up controlado e seguro.

Em processo de trabalho hormal e
por questbes de eficiéncia, a alimen-

tacdo do Cl ndo mais vem pelo pino
de dreno, mas pelo pino Aux, a partir
de um enrolamento auxiliar do trans-
formador. Todavia, se este for insufi-
ciente, o pino de dreno sera novamen-
te habilitado e ambos alimentaréo o
circuito.

Se ainda assim a tensdo no pino
Vce cair abaixo de um nivel minimo
de tenséo (Vuvlo), o Cl interrompera
a sua operacdo, e realizara um rei-
nicio de trabalho a partir do pino de
dreno.

2) Transistor MOS de poténcia

Todos os Cl's STARplug vém com
um transistor de poténcia embutido
(on-board), cujos niveis altos de ten-
sdo suportados (650V para a série
TEA152x e 485V para a série
TEA151x) justificam-se por medidas
preventivas de se evitar danos aos dis-
positivos.

A resisténcia (Rds-on) do transis-
tor MOS varia de acordo com o tipo
de STARplug escolhido, e é justamen-
te este valor que define o “x” dos nu-
meros de série dos Cl’s.

3) Circuito oscilador e mecanis-
mo de controle

Para a andlise desta etapa de con-
trole do Cl STARplug, atente para a
figura 4.

Uma associacdo paralela de um
capacitor e um resistor conectada ao
pino RC do Cl determina a frequéncia
de trabalho do mesmo. O capacitor é
carregado até o nivel maximo (Vrc-
méx) e, a partir de um sinal de habili-
tacdo, ele se descarrega pelo resistor
até um nivel minimo (Vrc-min). Neste
ponto, o ciclo reinicia-se novamente
com a carga do capacitor. Em modo
stand-by ou repouso, a freqiiéncia de
operacéo cai, e acompanhada de um
maior tempo de carga do capacitor, o
Cl funciona com aproximadamente
100 mW apenas.

A energia transferida a carga é de-
terminada pelo tempo de condugéo do
transistor de poténcia MOS.

Este tempo é determinado por uma
comparagéo realizada no modulo
PWM, responsavel pela geragéo dos
pulsos, da seguinte forma : a tenséo
de regulagéo interna (Vreg_intern) é

1
Voo SUPPLY 81 oram
vaLLey = l—
TEA152x 4
+
— + b L5
_11 | 100 my
o D>
Y / E[
stop *
r
RC e OSCHLATOR THERMAL 8l source
— “ SHUTOOWN Il
4 »| pPrROTECTION
LOGIC
F POWER-UP >
st RESET |—>-
ErE
overcurrent
) 25V .
REG —|—»——{ 10x ———AUX
short circuit winding

Fig. 3 - Diagrama de blocos do STARplug.
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+ 25V
—» VA
hrog E \_/ Vreg_intern
Rreg Reg

Fig. 4 - Mecanismo de Regulagéo.

igual a diferenga entre a tensé@o de
regulac@o externa e uma fonte de ten-
séo interna (2,5V), multiplicada por 10.
A partir disso, Vreg_intern é compa-
rado a tensdo do oscilador e, quanto
maior for esta tenséo do oscilador com
relacdo a outra, maior serd o tempo
de condugéo do transistor. O controle
desempenhado pelo médulo PWM é
demonstrado na figura 5.

4) Circuito para desmagnetizacdo

E necessério um caminho que per-
mita a circulagio de uma corrente que
dé continuidade ao fluxo magnético de
modo a absorver a energia acumula-
da no campo relativa a indutancia de
magnetizacao.

Para garantir a desmagnetizagdo
do nicleo do transformador a cada
ciclo, o conversor opera sempre no

modo descontinuo. Isto se d& pela
conducdo de um dos diodos ligados
em anti-paralelo, a partir do instante
em que ha uma tenséo positiva no
enrolamento auxiliar do transformador.
Com isso, haveréa uma circulagdo de
corrente em diregéo ao pino AUX do
Cl, e enguanto a tensdo no mesmo
for maior do que 100 mV (ver circuito
comparador na figura 6), o oscilador
n&o iniciard um novo ciclo de traba-
Iho, garantindo a execugao da desma-
gnetizagéo citada.

Outra caracteristica deste circuito é
gue o reconhecimento para a realiza-
¢do da desmagnetizagéo é suspenso
guando o transistor MOS abre (para
de chavear), e assim permanece en-
quanto o fransistor estiver neste esta-
do. Isso é importante para evitar uma
falsa detecgdo de desmagnetizacéo

A
Vre
Low Power
‘\ Vreg_intern
High Power
Fig. 5 - Controle PWM.
Aux Raux
l Logle i
RC SW ‘!DOmV
R— o -
Low Freq.

Fig. 6 - Circuito para desmagnetizagéo.

em aplicagbes com baixa tensdo de
saida e o transformador apresentan-
do fuga de indugéo.

5) Eficiente circuito de comuta-
¢édo ( ver figura 7)

O STARplug possui um circuito in-
terno dedicado para a etapa de con-
versao que consiste numa tecnologia
de chaveamento suave do transistor
MQOS, denominada comutacéo por
vale ou switching valley, que minimiza
as perdas de energia decorrentes des-
se processo. Conseqlentemente,
obtém-se uma melhor eficiéncia do
conversor.

No gréfico, temos representado
uma aplicacéo fly-back (derivado do
conversor abaixador-elevador) com
tensao de saida refletida de 80V, onde
a freqUiéncia ideal para chaveamento
do transistor MOS se dé em aproxi-
madamente 480 kHz, ponto no qual o
angulo de fase é de 0 graus (vale).
Mesmo que o transistor seja chaveado
numa frequéncia de 200 kHz, cerca
de 332 de defasagem do vale ou pon-
to ideal, as perdas de energia oriun-
das do chaveamento seriam reduzidas
significantemente, visto que ainda ndo
se teria alta tens&@o no pino de dreno.

6) Circuitos de protecao de cor-
rente

Por meio de um resistor externo, a
corrente através do transistor MOS in-
terno é convertida em tenséo e apli-
cada a dois circuitos comparados, 0s
quais possibilitam ao STARplug imple-
mentar dois tipos de protecéo de cor-
rente, uma contra sobrecorrente e a
outra para detectar curto-circuito no
enrolamento do transformador. Ambas
as implementagdes séo vistas na
figura 8.
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Profection
Logic
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[e]
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piddil

Low Freq.

Fig. 7b - Componentes
no pino de dreno. Cpar

Drain

Fig. 7a - Circuito de comutagéo
por vale.

=}

Drain

i

phase
(deg}

Fig. 7¢ - Angulo de comutaggo tipico (Vout = 80 V).

sensor de temperatura para garantir
uma operagao segura. Caso este va-
lor venha a ultrapassar um limite ma-
ximo, a légica de protecéo é acionada
e, logo, o Cl interrompe o seu funcio-
namento normal. A partir desse ins-
tante, apenas uma corrente minima
circulara pelo circuito. Restabelecidas
as condi¢cdes normais de temperatu-
ra, tudo volta a ser como antes.
Tendo visto as principais caracte-
risticas construtivas do circuito
integrado(C!) STARplug, apresenta-
mos ha figura 9 o esquema eletrénico
de uma fonte chaveada na configura-
céo fly-back e regulagdo secundaria,
com as seguintes especificactes :

Entrada

Tenséo : Alimentagéo global (80 VAC
a 276 VAC)

Frequiéncia : 50 / 60Hz +-10%
Poténcia em modo stand-by :<100mW
Transientes da rede : 1kV/50 ps

Saida

Tensédo :5V / + 2%
Corrente : 600 mA
Poténcia : 3W

Verifica-se até uma certa simplici-
dade de projeto, que requer apenas
alguns componentes externos juntos
ao Cl STARplug série TEA152x, nes-
se caso 0 TEA1521, para a criagéo da
fonte especificada acima numa placa
de circuito impresso com as reduzidas
dimensdes de 40mm x 27,5mm. Para
maiores detalhes, ver bibliografia.

JL
| —

Protection
Logic Biank

Source

e

Overcurrent

. 0.5V

Short winding

4 0.75V

\&

Fig. 8 - Circuitos de protecéo de corrente.

Rsre

Cumpre fazer uma observagéo
quanto a um tempo (normalmente de
350ns) durante o qual o circuito logi-
co de protegao desabilita a leitura dos
comparadores para prevenir uma fal-
sa deteccédo de qualquer uma das

situagdes de falha no instante da co-
mutagdo ou chaveamento do transis-
tor MOS.

7) Protecéo de sobretemperatura
O STARplug contém também um

SABER ELETRONICA ESPECIAL N¢ 3/MAIO/2001

CONCLUSAO

N&o restam dlvidas de que a
Philips e o seu kit STARplug de
circuitos integrados (CI's) robus-
tos, flexiveis e com caracteristi-
cas interessantissimas, aliados a
uma ampla documentagéo e um
programa para auxilio disponi-
veis, vieram para marcar presen-
¢a e impor tendéncias no metr-
cado de dispositivos e aplica¢bes
gue necessitem de baixa potén-
cia. Empresarios e engenheiros
de aplicacdo das industrias de
Informatica e Telecomunicagbes
gue anseiem a um projeto rapi-
do, de baixo custo, compacto e
seguro, eis uma das solugdes.
Basta esperar e ver!
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Fig. 9 - Fonte chaveada em configuragao fly-back.
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Bibliografia: http://www-us.semiconductors. philips.com/powermanagement/starplug/design/

WITERINKE

- KIT ACEITA:80C31 / 80C32 / 87C51/ 87C52 / ATMEL;

~ Software de Comunicacée direta com o PC;

~ Todo programa desenvolvido roda na RAM do kit (chave
load-run com auto-reset), ndo necessitando a gravagéo

de EPROMs a toda hora

- 8o , simuladores, exercicios
e suporte comple(o no slte www.microcontrolador.com.br

- Gontém: 32K EPROM, 32K RAM, 4 PORTS com conector,
RS232C, 8 saidas I/O mapeado, Reg.5V interno, clock 12MHz,
TODOS OS CHIPS COM CONECTORES TORNEADOS!

- KIT DO AUTOR DO LIVRO “MICROCONTROLADOR 8051

DETALHADO Ed. Erica, 2000.

Tel: (11) 229-3192 IMBATIVELI!
COMPRAS: www.microcontrolador.com.br

Anote Cartdo Consulta n® 150201

TRANSFER PARA
CIRCUITO IMPRESSO

e de balxo custo)

{ Iso, sem

¢ \’\) 1, Imprima sobre T LT LT Jdcom

impressora ou copiadora laser

2.[TIX Y para

a placa de cobre

3.em snguldn XY Y corroer |

o

0 MESMO PROCEDIMENTO PODE SER
ADOTADO PARA OUTRAS SUPERFICIES:
ALUMINIO, AGO INOX, PVC, CDS, ETC..

pronsa térmica HT2020 drea wtil: 20 x 20 om
Ferragini Design f.: 16-274.1838
www.ferragini.com.br/ci/

Anote Cartdo Consulta n® 23100

Curso de PIC

Padrao Mosaico Engenharia

Estéd na hora de vocé se atualizar
conhecegdo 0 microcontrolador maijs
'5 ] popular do mercado.

P‘?e 0% 20 horas com turmas
5 ~" em vérios horérios.
L x 6: — Inclui mini gravador e

o livro "Desbravando o PIC",
Vocé néo precisa conhecer assembly.
Préximas turmas e descontos em
nosso site: www.mosaico-eng.com.br

\ 4

Mosaico Engenharia
e 5 anos de experiéncia
ed em projetos eletrénicos

(011) 4992-8775/ 4992-8003
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- A TECNOLOGIA DE SUA L
HEMPRESA MUDOU DE MILENIO?E
«f A8 anos que a Easy Conirol converte suas
o idéias em produtos usando o que o mercado =
= temdemelhor. Comaversatilidade dosPICs =
=5 daMicrochip, a poténcia dos DSPs da Texas =
] e o dominio da eletrénica de poténcia seus =
= produtosndoficamnomiléniopassado. S
2] I e =] Pay]
[ " o O
M i
[} o ] fend
= Q) =
TEXAS =
= MICROCHIP InsiomiEnts 2
= E = Easy Control Tecnologia Ltda g
o Projetos digitais ¢ eletronica de poténcia. fr ‘&
= R.Nova Amazonas,608 - Granja Vianna [~ S
) Tel:(0xx11) 4702-7437 / 5929-2569 = @
easyetrl@sti.com.br é(c:’

CREEEEEEEREEEREEERLEEEEL

MANUTENGAO DE
MONITORES DE VIDEO

Livro ilustrado com diagramas.10% de
desconto aoc mencionar este anuncio.

Esquemas avulsos, manuais de
servigo e usuario, reparacdo e
manutencao em eletronica, dentre
outros.

PECA CATALOGO GRATIS

REVISTA ANTENNA / ELETRONICA POPULAR
(com circulagéo ininterrupta desde 1926)
Av. Mar. Floriano, 167-Centro-RJ- Cep:20080-005
Tel. (0xx21) 223-2442 - Fax: (0xx21)263-8840
E-mail: antenna @ unisys.com.br

www.antennaeletronicapopular.com.br

Anote Cartdo Consulta n? 1020

CIRCUITOS IMPRESSOS

DEPTO PROTOTIPOS

CIRCUITOS IMPRESSOS CONVENCIONAIS
PLACAS EM FENOLITE, COMPOSITE OU FIBRA
EXCELENTES PRAZOS DE ENTREGA PARA
PEQUENAS PRODUCOES

RECEBEMOS SEU ARQUIVO VIA E-MAIL

PRODUCOES

FURAGAO POR CNC
PLACAS VINCADAS, ESTAMPADAS OU FREZADAS
CORROSAO AUTOMATIZADA (ESTEIRA)
DEPARTAMENTO TECNICO A SUA DISPOSICAO
ENTREGAS PROGRAMADAS

SOLICITE REPRESENTANTE

® TEC-CI CIRCUITOS IMPRESSOS

RUA VILELA, 588 - CEP: 03314-000 - SP
PABX: (Oxx11) 6192-2144 / 6192-5484 / 6192-3484
E-mail: circuitoimpresso @tec-ci.com.br

Site: www.tec-ci.com.br
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MultiSIM
Versao 2001

Nesta edicdo damos em CD o
demo do MultiSim, trata-se um progra-
ma, desenvolvido pela Electronics
Workbench, que simula e captura cir-
cuitos eletronicos.

Neste tutorial mostraremos o que
este programa pode fazer. Certamen-
te, ndo se trata do guia completo do
usuario, mas pode dar uma idéia dos
recursos que este software tem e fa-
zer com que o leitor possa decidir se
ele é ou ndo o melhor para sua area
de aplicagao.

Os exemplos dados a seguir ser-
vem como introdug¢éo ao uso do pro-
grama, sendo por isso bastante sim-
ples. Circuitos mais complexos podem
ser analisados segundo procedimen-
tos encontrados na versdo completa
do MultiSim versdo 2001. Para os lei-
tores que tém acesso a Internet, em
caso de duvidas podem fazer a con-
sulta ou pesquisa direta no site http:/
/www. electronicsworkbench.com

1) Facil de Usar

Uma das caracteristicas mais im-
portantes do MultiSim verséo 2001 é
a facilidade de uso. Segundo o fabri-
cante esta € uma das caracteristicas
gue o torna tdo popular. A barra de
projeto da acesso a todos 0s passos
l6gicos para o desenvolvimento e si-
mulacéo de um circuito.

2) Barra de Projeto

Como outras ferramentas do
MultiSim vers&o 2001, a barra de pro-
jeto (Design Bar) pode ser redimen-
sionada e fixada em qualquer ponto.
Por “default”, ela é colocada na parte

superior no centro da tela. O primeiro
botédo desta barra mostra e esconde a
barra de componentes (Component
Toolbar) que ¢é inicialmente fixada a
esquerda e formada por um conjunto
de quadros organizados de tipos de
componentes, conforme ilustra a figu-
rai.
http://www.electronicsworkbench.
com/images/picturei.jpg

3) Colocando um Componente

Para colocar um componente
numa éarea de trabalho, basta clicar
com o mouse no estoque de partes
(Parts Bin) na barra de componentes
(Component Toolbar).

Clicando no segundo botédo temos
a abertura do estoque de componen-

tes restando enté@o clicar no que se
deseja usar.

Escolha, por exemplo, o estoque
de chaves (switches) e com um duplo
toque na chave SPST (um pdlo, uma
posicéo) vocé faz a selegdo desse
componente bastando arrasta-lo ate
a area de trabalho. Clicando novamen-
te no botdo quando a posicao deseja-
da é alcancada, o componente é fixa-
do.

No programa completo existe uma
lista de 16 000 componentes que po-
derdo ser usados nos projetos.

Agora, usando 0 mesmo método
empregado para fixar a chave pode-
se fixar uma bateria e um ponto de
ligacédo a terra. Esses componentes
estéo no primeiro quadro do estoque

Design Bar

Toggle Switch

Component Toolbar

Electromechanical
Parts Bin

e e ]

Figura 1
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de componentes (Sources). Uma lam-
pada pode ser encontrada no quadro
dos indicadores (indicators) que é o
décimo para baixo. Coloque na area
de trabalho uma lampada identificada
como 5V x 1 W. A figura 2 mostra
como estamos no nosso projeto de
exemplo.
http://www.electronicsworkbench.
com/images/picture2.jpg

Se precisarmos de um resistor
para o nosso exemplo, também pode-
remos encontra-lo nos quadros de
componentes basicos.

Uma vez que o resistor seja arras-
tado e colocado na area de trabalho,
bastara clicar duas vezes sobre ele
para ter as suas caracteristicas. As-
sim, abre-se uma caixa de didlogo que
permite alterar a resisténcia conforme
as necessidades do projeto. Veja que
as unidades podem ser alteradas tam-
bém em relagédo aos prefixos.

4) Interligando os componentes

Para interligar os componentes
basta clicarno pino terminal de um dos
componentes e depois clicar no pino
do componente ao qual se deseja fa-
zer sua conexdo. E muito simples:
clique no terminal de um resistor e
arraste o mouse até o terminal da l1am-
pada. Basta soltar o botdo do mouse
e a ligacéo é feita automaticamente.
Se o trajeto colocado na tela para o
fio ndo lhe agradar, vocé podera clicar
em qualquer ponto dele arrastando-o
para novas posi¢ées, modelando des-
te modo os fios.

Na figura 3 mostramos como fica
a tela com essas ligagdes.
http://www.electronicsworkbench.
com/images/picture3.jpg

5) Simulagao

Para simulacéo existe uma chave
que liga e desliga o circuito no lado
direito superior da barra de projeto
(Toggle Switch).

Quando esta chave é acionada
pelo simples clicar do mouse sobre
ela, o circuito é alimentado e entra em
funcionamento “virtual”.

E claro que para saber se o circui-
to esta funcionando sera preciso ligar
os instrumentos as suas diversas par-
tes. Ligando o circuito ndo podemos
ver a lampada acender, mas se ligar-
mos um voltimetro poderemos perce-
ber pela sua indicagéo que ela rece-

12

be alimentacéo e que, portanto, vai
acender. Por esse motivo, os instru-
mentos virtuais sdo importantes no
processo de simulagao.

6) Instrumentos Virtuais

Um dos meios mais comuns de se
verificar os resultados de uma simula-
¢do no MultiSim verséo 2001 é atra-
vés dos instrumentos virtuais.

Clicando no terceiro botdo da bar-
ra de projeto (Design Bar), a barra de
instrumentos (Instruments Toolbar) é
aberta.

Como nas outras barras, bastara
arrastar o cursor sobre ela para se ter
acesso aos diversos instrumentos dis-
poniveis no MultiSim versdo 2001. Sdo
11 instrumentos em ordem alfabética,
sendo o osciloscopio um dos mais im-
portantes.

Ele pode ser colocado na area de
trabalho clicando-se sobre ele e arras-
tando-o até o ponto desejado.

Se ligarmos o osciloscépio ao cir-
cuito com sua entrada A & I&mpada e
aterra poderemos ver a forma de onda
quando ligamos e desligamos a cha-

T e
Figura 2

Figura 3
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:lectromcs EWB, a Solugéio para
«BENCH Projetos de Circuitos mais

conhecida do mundo.

.;'

MultiSim

Captura de Esquemas, Simulacdo & Logica Programavel
O Multisim & uma ferramenta completa para projetos de sistemas que oferece
captura de esquemas, um abrangente banco de dados de componentes,
simulag&o SPICE, simulag&o e entrada de VHDL/Verilog, capacidades
de RF, caracteristicas de pos-processamento e perfeitaintegragéo
como EWB Ultiboard para layoutde PCL. E uma ferramenta para
projetos facil de usar que oferece a funcionalidade avangada necessaria
paraprojetos de alta qualidade, e esta disponivel em configuragdes para
satisfazer todos os niveis de projetistas. Suas opgdes de modelos e pregos
combinados com uma diversidade de caracteristicas para projetos em equipe
tornam o Multisim ideal tanto para profissionais isolados como para equipes de
engenheiros que agora podem projetar com uma ferramenta EDAcomum.

UIJ[iBO ARD  Poderoso Layout de PCl e

Autoroteamento Avangado
O Electronics Workbench Ultiboard é um poderoso, porém fécil de usar, programa para
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ve de simulacdo. Evidentemente, se
tivermos um oscilador, precisaremos
ajustar os controles do osciloscopio
para ter as amplitudes (ganhos) e a
base de tempo de acordo com a fre-
quéncia do sinal que deve ser
visualizado.

Isso é conseguido clicando-se
duas vezes sobre o osciloscépio.

Na figura 4 mostramos a ligacédo
do osciloscopio ao circuito simulado.
http://www.electronicsworkbench.
com/images/picture4.jpg

Os instrumentos usam comandos
complexos SPICE para tornar a
visualizacdo mais transparente ao
usuario.

7) Simulag¢ées SPICE, VHDL e
Verilog HDL

O MultiSim oferece diversos tipos
de simulacdes incluindo as baseadas
no SPICE, o que permite aproveitar
0s modelos criados pelos fabricantes
dos componentes. Por outro lado, isso
torna o MultiSim facil de usar. Basta
escolher o detalhe e ele faz o resto.
Na figura 5 mostramos como os diver-
80s processos usados para estas si-
mulacdes se relacionam.
http://www.electronicsworkbench.
com/images/picture5.jpg

8) Andlise

O MultiSim inclui alguns recursos
de andlise de circuitos que n&o podem
ser encontrados no mundo real.
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Como exemplo disso, é possivel
aplicar sinais de intensidades muito
maiores do que as que seriam obti-
das no laboratério para uma simula-
¢éo, bastando para isso ajustar o ins-
trumento, veja a figura 6.

Um teste de um amplificador com
uma corrente de saida muito alta quei-
maria o componente real, mas nao o
virtual.
http://www.electronicsworkbench.
com/images/picture6.jpg

Em testes com circuitos pode-se
verificar os efeitos da temperatura so-
bre um circuito como o indicado, bas-

Schematic

Interface g

SPICE
N > Simulator

Instruments ———

Post-

processor VHDL

Simulator

Moot | o
j«——» HDL
Simutator

MathSoft
MathCad

Figura 5

tando alterar a simulagcdo em
“temperature sweep”, que é encontra-
da na caixa de didlogo, ou ainda mo-
dificar a carga em passos controlados
plotando os resultados.

O MultiSim possui o “Postoproces-
sor” que € o sexto botao da barra de
projeto e que permite editar e mani-
pular os resultados da simulagdo. Por
exemplo, pode-se computar poténcia
multiplicando corrente por tensao e
obter a forma de onda corresponden-
te.

9) Macros e Blocos de Hierarquia

O MultiSim proporciona um siste-
ma de hierarquia para permitir que
vOCcé organize seu projeto. Vocé pode
criar uma macro selecionando uma
parte de seu circuito, copiando-a e
colando-a como uma macro.

Um duplo clique no box de macro
resultante permite que vocé trabalhe
com ela.

A macro sera armazenada no ar-
quivo de circuito que a usa.

Esse recurso é importante se al-
guém faz uma alteragé@o no circuito e
depois deseja voltar ao original.

]
Fi

gura 6
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CONCLUSAO

Evidentemente, o exemplo que
mostramos é muito pouco em rela-
¢a0 ao que realmente pode ser fei-
to. Usando circuitos simulados, se-
melhantes aos que fornecemos nas
EdicGes Especiais 1 e 2, com diver-
so0s graus de complexidade, o leitor
podera ter uma idéia de até onde

pode chegar seu projeto.
http://www.electronicsworkbench.
com/images/picture?.jpg

Figura
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DESCUBRA O PODER DO

abVIEW 6i

Fernando Ramos da Silva

LabVIEW(versdo 6i avaliagcdo 30 dias): Poderosa, intuitiva e
flexivel plataforma de desenvolvimento de software desenvolvida
pela National Instruments, ideal para solugdes customizadas de
controle, aquisicdo, andlise e apresentagéo de dados. Tudo isto é
obtido a partir de uma interface grafica programavel com objetos
funcionais ou instrumentos virtuais (VI's), ao invés da rigida estru-
tura de cédigo das linguagens de programagéo conhecidas.

LabVIEW é uma linguagem de
programacéo grafica(G) que usa
icones ao invés de linhas de texto
para criar aplicagdes de aquisicéo,
controle, andlise e apresentagéo de
dados. Por basear-se numa metodo-
logia intuitiva para engenheiros e ci-
entistas, o LabVIEW oferece a flexi-
bilidade de uma linguagem de pro-
gramacao poderosa sem o énus da
dificuldade e complexidade associa-
das. Em detrimento as linguagens
de programacéo baseadas em tex-
to, onde as instrugbes determinam
a execugdo do programa, o
LabVIEW utiliza programagéo
dirigida por fluxo de dados, onde os
dados determinam sua execucao.

O LabVIEW apresenta sua ver-
sa0 6i, a qual expandiu algumas fun-
cionalidades destinadas ao uso das
aplicacbes através da Internet. Ve-
jamos algumas dessas caracteristi-
cas da verséo 6i :

- Utilizando uma ferramenta denomi-
nada LabVIEW Player, as aplica-
¢Oes podem ser compartilhadas
pela Internet. Basta fazer um
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download dessa ferramenta a par-
tir do site da National e instala-la.
Através de um browser com link
para o LabVIEW Player, pode-se
executar seguramente os progra-
mas ou VI's;

- Vocé pode compartilhar dados en-
tre suas aplicagdes através do es-
quema publicagé@o-assinante, ou
seja, qualquer item de uma
interface que seja publicado pode-
ra ser acessado por outras aplica-
¢bes LabVIEW, Java, Visual Basic
ou por qualquer pagi-

T,

teristica de execuggo distribuida de
aplicacbes através de uma rede de
computadores. Assim, é possivel
distribuir a carga de uma aplica-
¢Ao entre varios equipamentos em
diferentes plataformas distribuidas
pela rede (Windows 2000/Linux/
Apple), de uma forma totalmente
transparente; note pela figura 1
que podemos ter varios processa-
dores e recursos de maquinas co-
operando para a execugao da ta-
refa.

- Publicacao de relatérios em forma-
to HTML;

- Processo simplificado de conexao
e configuragéo dos dispositivos de
medicao através de uma Unica fer-
ramenta - o Measurement and
Automation Explorer;

- Total integragéo do LabVIEW com
outras aplicacbes de 32 bits como
Microsoft Visual Basic/C++. Atra-
vés da ferramenta Application

na Web. Por exemplo,
quando um determi-
nado controle de uma
interface ultrapassa| _
um valor limite, este ‘:’i
dado é publicado e .'"-‘ﬁ 1“;
passa a interagir com | T
qualquer aplicagéo <
mencionada acima e
que fora definida como
um “assinante” daque-
le dado;

- Foram realizados me-
Ihoramentos na carac-

Control PC
Running LabVIEW

S
"%ﬂ LobVIEW Real Time

Fig 1 -Execucéo distribuida para rodar segbes de uma aplicagdo
em maltiplos computadores interligados através da rede.

' Remate PC Runring
Yisual C++

Notional Instruments
PX| System Running

W Remotel

. }- " Ruming LobWEW
i

DAQ Board
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Apresentacao

0 LabVIEW 6i facilita a integragéo da Internet em suas
aplicagdes de medidas e automacéo, permitindo compartilhar
suas aplicag@es e dados com os colegas em outros
departamentos ou pelo mundo a fora. Com o novo gerador
de relatdrios HTML vocé pode publicar resultados de
testes e dados instantaneamente a partir de qualquer
controle, indicador ou ainda distribuir programas (Vis)

a colegas em qualgquer parte do mundo através do
LabVIEW Player. Com o Poder do LabVIEW 6i e os
produtos de aquisi¢do de dados da National

Instrument as possibilidades s#o infinitas.

Descubra vocé mesmo o poder do LabVIEW 6i

VNATIONAL
’ INSTRUMENTS

Visite nosso site
www.ni.com
ni.com/info/labview




Builder, é possivel criar bibliotecas
de ligacdo dinamica (DLLs) de
qualguer programa ou VI para que
os demais ambientes de progra-
magcao possam acessa-las;

- Ganhos consideraveis de perfor-
mance sao obtidos por quem mi-
gra suas aplicagdes para a verséo
6i. Entre outros, as aplicacdes do
usuério séo executadas mais ra-
pidamente em cerca de 10 a 30%;
as leituras de arquivo s&o 15%
mais velozes; os requerimentos de
disco rigido e memoria para as
aplicacoes foram reduzidos;

- Adicao de novos componentes para
o projeto da interface do usuario e
melhoramentos introduzidos na
programacao gréfica dos VI's para
facilitar o desenvolvimento das
aplicacoes.

Existem varias ferramentas e
maodulos, tais como controle PID e
gerenciamento de dados, que po-
dem ser adicionados para expandir
a funcionalidade do LabVIEW no
desenvolvimento de aplicagbes
especializadas. O LabVIEW é com-
pletamente integrado para comuni-
cacdo com uma ampla variedade de
interfaces e dispositivos de hard-
ware, como GPIB, VXI, PXI, RS-232,
RS-485 e, nesse aspecto, sua prin-
cipal caracteristica que auxilia e
agiliza o trabalho do desenvolvedor
é o fato de existirem drivers de
software prontos para a comunica-
¢do com uma ampla variedade de
dispositivos e instrumentos.

APLICACOES

O LabVIEW ¢ usado extensiva-
mente em varios segmentos indus-
triais ao redor do mundo, tais como
Telecomunicacgdes, Fabricagéo,
Automotivo, Semicondutor, Biomé-
dico, Aeroespacial e Eletronica. Sua
aplicabilidade abrange todas as fa-
ses de desenvolvimento do produto,
incluindo pesquisa e desenvolvimen-
to, engenharia e validacéo, fabrica-
¢éo, controle de qualidade e servi-
¢os. Por esse motivo, o LabVIEW
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Fig 2 - Telecomunicagbes.
tornou-se uma ferramenta padréo
para a industria (ver figura 2).

O AMBIENTE LABVIEW

No LabVIEW vocé constréi uma
interface do usuario utilizando um
grupo de ferramentas e objetos.
Essa interface do usuario é conhe-
cida como painel frontal. Vocé en-
tao adiciona cédigos usando repre-
sentagdes gréficas de fungdes numa
interface conhecida como diagrama
de blocos para controlar os objetos
do painel frontal. Se organizado ade-
guadamente, o diagrama de blocos
sera semelhante a um fluxograma.
Os programas LabVIEW s&o chama-

istagram Parmq_lur_#_

Fig. 3 - Exemplo de painel frontal

dos instrumentos virtuais, ou VI's,
porque sua aparéncia e operagéo
assemelha-se a instrumentos fisi-

cos, tais como osciloscopios e

multimetros. Todo VI utiliza fungbes

que manipulam entrada de dados
oriunda da interface do usuario ou
de outras fontes, e demonstra a cor-
respondente informagéo ou move-a
para outros arquivos ou computado-
res na rede. Vocé pode ajustar pon-
tos de parada (breakpoints) e uma
execucgédo passo-a-passo atraveés
dos programas para facilitar o seu
desenvolvimento e manutengéo.

Vejamos a seguir 0s principais com-

ponentes deste ambiente:

- Painel Frontal: E a interface do
usudrio no programa ou Vi, e é
construida com controles e indica-
dores, os quais sd0 o0s interativos
terminais de entrada e saida, res-
pectivamente. Exemplos de con-
troles sdo os botdes e outros dis-
positivos de entrada. Indicadores
podem ser expressos pelos grafi-
cos, LED’s e outros displays. Os
controles simulam os instrumentos
como dispositivos de entrada e for-
necem dados para o diagrama de
blocos do V. Indicadores simulam
0s instrumentos como dispositivos
de saida e demonstram dados ad-
quiridos ou gerados no diagrama
de blocos. Veja figura 3.

SABER ELETRONICA ESPECIAL N¢ 3/MAIO/2001



- Diagrama de Blocos: Depois de
construir o painel frontal, vocé adi-
ciona codigo usando representa-
cao grafica de fungdes para con-
trolar os objetos do painel frontal.
O diagrama de blocos contém este
codigo-fonte grafico e nele os ob-
jetos do painel frontal aparecem
como terminais no diagrama de
blocos. Vocé nao pode “deletar’ um
terminal do diagrama de blocos,
sendo que 0 mesmo s6 desapare-
ce quando vocé apaga o objeto
correspondente existente no pai-
nel frontal. Todo controle ou indi-
cador no painel frontal tem um ter-
minal correspondente no diagrama
de blocos. A execug&o dos dados
ocorre através da conexao de fios
entre cada né do diagrama de blo-
cos, incluindo terminais de contro-
le e indicadores, funcdes e estru-
turas. Observe a figura 4.

Paletas: As paletas existentes no
ambiente de programagao do
LabVIEW contém as opgdes ne-
cessdrias para criar e editar o pai-
nel frontal e o diagrama de blocos.
As paletas subdividem-se em pa-
letas de ferramentas (700/s), pale-
tas de controles (Controls) e pale-
tas de fungbes (Functions). A pa-
leta de ferramentas serve para
operar e modificar o painel frontal
e o diagrama de blocos. Além dis-
s0, toda vez que vocé seleciona
uma ferramenta, o icone do mouse
muda para o icone da ferramenta.
Ja a paleta de controles esta dis-
ponivel apenas no painel frontal e
contém os controles e indicadores
para criar a interface do usuario.

a) Paleta de ferramentas visivel no
painel frontal e no diagrama de blocos.

(b) Paleta de controles visivel i
apenas no painel frontal.

Acquisition Loop

50

E2 g |

Digital Thermometer.vik it

|
|

T
»Disabled

| date Statistics

A Ultima paleta é a de fungbes, a
qual esta disponivel apenas no di-
agrama de blocos e contém os ob-
jetos necessarios para se progra-
mar o VI, tais como operagdes arit-
méticas e aquisi¢cOes de dados.

Veja na figura 5 as trés paletas

mencionadas.

INSTALAGCAO

Para realizar a instalagdo desta
verséo trial 30 dias do LabVIEW 6i,
selecione-o a partir do menu “Pro-
gramas” e atente a pasta que sera
criada para armazenar o programa
ou indique outra pasta conforme sua
preferéncia. Abandone a midia do
CD e execute o LabVIEW a partir do
caminho definido durante a instala-
¢do. Vocé devera encontrar a tela
da figura 6.

Fig. 5 - Paletas disponiveis no ambiente LabVIEW.
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Figura 6

A partir desta figura é possivel
encontrar uma documentacao basi-
ca a respeito do funcionamento e
caracteristicas do LabVIEW, além de
alguns exemplos de aplicagdes
construidas (opcédo Demo Center).
Porém, iremos concentrar nossa
atengdo para a criagdo de um sim-
ples programa ou VI para expor a
funcionalidade do LabVIEW. Para
tanto, selecione a opcéo encontra-
da no botdo vermelho “Start using

Show Clipboard
Show Esror List Culsl

TieleftandRight  CllbT
Tils Up and Down
Eull Size. Cliie/

e
primexemplo,vi Diagram *

S e
c)Paleta de fungdes visivel

apenas no diagrama de blocos.
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LabVIEW”. A tela ilustrada na figura
7 serd apresentada.

Mais uma vez, temos uma série
de estudos de caso acessiveis a
partir da guia “Search Examples”.
Selecione a opgao “New VI” para
visualizarmos as principais interfa-
ces do LabVIEW com as quais ire-
mos trabalhar. Note pela figura 8 que
a tela do diagrama de blocos permi-
te através do menu“Window”, ativar-
mos a apresentagdo da paleta refe-
rente aos objetos de funcdes, en-
quanto que a tela da interface do usu-
ario permite utilizarmos a paleta re-
ferente aos objetos de controles.

FAZENDO UM SIMPLES
EXEMPLO

Iremos demonstrar passo-a-pas-
s0 a criagdo de um primeiro exem-
plo com o LabVIEW. Trata-se de uma
aplicacao basica onde existira uma
funcdo de geracéo de numeros ale-
atérios entre 0 e 1, cujos valores
ser&o plotados num grafico.

| - Interface do usudrio

1- Deixe as paletas de ferramen-
tas (Tools) e de controles (controls)
abertas sobre a interface para facili-
tar a utilizacdo dos objetos contidos
nas mesmas. Para fazer isso, use a
sequéncia Window->Show
Controls e Tools Palette;

2- Crie um botao de emergéncia
ou parada selecionando através da
paleta de controles a seqiiéncia
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Controls->Boolean->Stop Buttom
(ver figura 8). Clique e arraste este
objeto para a interface;

_:> Untitled 1 *

val ¢

Figura 8

3- Clique com o botéo direito do
mouse sobre o botdo de parada e
selecione Visible ltems->Label para
demonstrar ou esconder o seu rétulo;

4- Use a ferramenta
de posicionamento

PDSItIDm"SIZEf’S elect] disponivel na pale-

ta Tools para deslocar, redimensionar
ou selecionar um objeto para poste-
rior delec@o a partir da tecla Del.

5- Pressione o botdo “seta
para cima” ou Up na

ILlp ta Owning Palette] paletaidereoiiro;

fes ou Controls
para retornar ao grupo principal de
objetos desta paleta;

6- Crie um gréfico onde seréo
plotados valores em forma de onda
(waveform) através da seqliéncia
Controls->Graph->Waveform
Chart (ver figura 9).

Clique neste objeto e arraste-o
para a interface do usuario. Vocé

Figura 9

podera utilizar a ferramenta de edi-
cdo de texto (edit text) da paleta Tools

—  para dar um nome ao gra-
@ fico como por exemplo,
“Plotagem de Valores Ale-

3

atorios”.

7- Como iremos gerar valores ale-
atérios de 0 a 1, devemos alterar a
escala do eixo Y do grafico. Para
tanto, selecione o objeto ou ferra-

menta para edi¢des

de valores (operate
----- - va/ue) na paleta de fer-
ramentas e dé um du-
plo clique nos valores -10.0 e 10.0
alterando-os, respectivamente, para
os valores digitados O e 1. Pronto, a
simples interface do usuério esta
pronta e devera estar semelhante ao
demonstrado na figura 10.

Il- Criacdo do cédigo fonte no
diagrama de blocos

1- Selecione Window->Show
Diagram caso tenha fechado a tela
de diagrama de blocos ou apenas
alterne da interface do usuario para
ela. Deixe as paletas de ferramen-
tas (Tools) e de fungbes (Functions)
abertas sobre a interface para facili-
tar a utilizagéo dos objetos contidos
nas mesmas.

Os dois objetos ou terminais ja
existentes no diagrama de blocos
correspondem ao botdo Stop e ao
grafico criado na interface do usua-
rio;

2- Crie a funcéo para geracéo
dos numeros aleatérios do nosso
exemplo a partir dos itens
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Loop. Este lago While executara tudo
que estiver dentro dele até que a
condicéo de término receba um va-
lor verdadeiro ou falso, sendo que o
padrao é “Continue, se verdadeiro”.
Clique sobre a fungao While Loop na
paleta, selecionando-a. Apds isso,
clique sobre um determinado ponto
do diagrama de blocos e abra a ja-
nela do lago diagonalmente fazendo
com que todos os objetos nele exis-
tentes figuem dentro desta fungao.
Pode soltar o botéo do mouse.

4- A transferéncia

de dados entre os ob-
jetos no diagrama de
blocos ocorre através de fios. Sele-
cione a ferramenta fiagdo (wiring)
existente na paleta de ferramentas
(Tools) e conecte o terminal corres-
pondente ao botdo Stop ao terminal
condicional do lago While. Para fazé-
lo, com o objeto fiagdo da paleta se-
lecionado, clique sobre um terminal
e depois sobre o outro.

= Gerag&o de N 0-1
gzpon de Hueee =3 Plotagem de Yalores Aleatdrios|
}nz

! Mumerie 5 - Este programa ou VI utiliza um

botéo de parada ou Stop, e por esse

= i : motivo a opgdo de parada do lago
TSI || |\l devera ser mudada para “Stop

BB B B Baal iftrue”. Para fazer este ajuste, clique
com o botéo direito do mouse sobre
B BB .

o terminal condicional do lago While
> > > |8

| ; (ou na borda do lago) e escolha a
Eval i
LK - ,~b@@@®

opcao especificada acima. Perceba
~

@l]

¥

>

EHE

L4

a mudanca na aparéncia do termi-
nal condicional do lago. O diagrama
de blocos do programa devera estar
como nha figura 12.

EE,E

Figura 11

|

Functions->Numeric->Random
Number (0-1). Clique sobre este ob-
jeto e arraste-o para o diagrama de |
blocos, localizando-o préximo ao ter- g—
minal correspondente ao grafico
“Plotagem de Valores Aleatérios”.
Isso devera ser feito para que o
LabVIEW conecte automaticamente
os dois objetos através de um fio (ver
figura 11).

3- Use o botdo “seta para cima”
ou Up da paleta de fungbes para
voltar ao grupo principal. Crie um
lago While através da selecé@o I
Functions->Structures->While Figura 12

EeracEo de rimeros 107 Plotagem de Yalores Aleatdrios

|CoBL]|
(= —

Botdo de paradal
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TESTANDO O PROGRAMA

1- Alterne para o painel frontal
através das teclas (CTRL+E) ou atra-
vés do menu Window->Show Panel.
Selecione a ferramenta indicadora da
paleta de ferramentas conforme vis-
to anteriormente.

2- Cligue no botédo Run (->) en-
contrado na barra de ferramentas da
interface para iniciar a execugéo do
programa. Quando quiser, clique so-
bre o botdo Stop existente na nossa
interface e interrompa o funciona-
mento do programa. Uma determi-
nada amostragem devera estar
como na figura 13.

3- Grave este programa em dis-
co a partir das opgdes File->Save
As-> e siga as instrugdes da tela.

OBTENDO AJUDA

O LabVIEW oferece ajuda eletrd-
nica para todos os objetos utilizados
na criacéo do seu projeto.

Para ativa-la, selecione o objeto
e pressione a sequéncia CTRL+H ou
através do menu Help->Show
Context Help.

Na figura 14 a seguir, vemos uma
pequena descri¢do para a fungéo de
geracao de nimeros aleatérios utili-
zada no nosso exemplo.

Geragéo de niimeros (0-1
&

]

Botdo de parada

CONCLUSAO

Procurou-se demonstrar neste
artigo algumas caracteristicas e be-
neficios do LabVIEW, este podero-
so software totalmente grafico que
facilita o desenvolvimento de aplica-
¢des de automacéo e instrumenta-
¢ao nos mais variados segmentos da
industria. Através da ilustragdo de um
simples exemplo desenvolvido nes-
te artigo, expusemos o0 ambiente em
si e suas ferramentas para que vocé
possa expandi-lo futuramente em ou-
tras aplicagdes onde o limite sera a
sua criatividade. Até a proxima! &

@~ number: Oto 1

Random Number (0-1)

Produces a double-precision
floating-point number between 0
and 1, exclusively. The distribution
4 is uniform.

Click here for more help.

Plotagem de Valores Aleatdrios]
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Pare‘;ﬂ | i | 1 '-‘.:.5 'Com direito a registro no CREA

CEE 650199 puhhcado I
| ']

goE‘I.GJ"m
Estudando em sua propria casa, e apenas nas horas
de folga, vocé pode obter a habilitacdo profissional
; ! que ira representar a sua independéncia ou um
= 8" emprego melhor, com melhores salarios e todos os
direitos assegurados pela legislacao.

£ realmente muito facil. No Instituto Monitor vocé ndo precisa
assistir aulas, ou mesmo ir até a escola {apenas as provas s&o
presenciais). Voc@ ndo gasta dinheiro com condugdo ou materiais. Tudo
0 que vocé precisa lhe & fornecido. Vocé estuda as ligdes que lhe sdo
enviadas, no conforto do seu lar, e aprende facilmente, porque elas sé@o
adequadas para o aprendizado a distancia em linguagem simples e
acessivel.

Uma vez matriculado{a) vocé pode concluir seus estudos e receber
seu Diploma {com registro no CREA) em um ano ...ou menos, no tempo
que o seu ritmo determinar, depende apenas de vocé. E, se vocé tiver
alguma dificuldade, professores estardo sempre prontos para atendé-
lo(a) por telefone, fax, correio, internet ou pessoalmente em nossa sede.

O Monitor também oferece
estes excelentes cursos:

B Técnico em Transacdes Imobiliarias -
Corretor de Iméveis (com CRECI)
B Técnico em Contabilidade (com CRC)

B Técnico em Secretariado (com DRT)

B Técnico em Informatica
B Supletivo de Ensino Fundamental (1° Grau)
B Supletivo de Ensino Médio (22 Grau)

r
Sr. Diretor: [J Faga minha inscriggo no curso de Técnico em Eletronica.
!\}.S T B LT O l Farei os pagamentos de acordo com o plano:
N ‘onltor | {11 dnica mensalidade de R$ 640,00 [ 3 mensalidades de R$ 217,00
A | 16 mensalidades de R$ 115,00 ]9 mensalidades de R$ 80,00
= [] Envie-me gratuitamente mais detalhes sobre os cursos.
FORMANDO TECNICOS DESDE 1939 '
Gaixa Postal 2722 « CEP 01060-970 + S&o Paulo - SP |
Rua dos Timbiras, 263 * Centro + S&o Paulo - SP End.: Ne:
e-mail; monitor@uol.com.br I Bairro:
www.institutormonitor.com.br I oy ;
elefone: e-maitl
PEgA PELO TELEFONE: . . -

-, .} &a I REQUISITOS: Ser maior de 17 anos e ter concluido ou estar cursando o ensino médio. O aluno seréa informado,
| f:ﬁ é?_’.. «é,@ quando da concretizagdo da matricula, sobre a documentagao e a forma dos pagamentos
o

L—_—————————————————— — — -




COLETANEA DE
"SITES" DE ELETRONICA

A Internet é uma das ferramentas
de trabalho mais importantes para o
profissional da Eletrénica de hoje. No
entanto, os bilhdes de péaginas de in-
formagbes que podem ser acessadas
com simples toques dos dedos tam-
bém podem causar sérios embaragos
para quem ndo sabe navegar em um
mar de informagdes tdo amplo.

O uso do inglés como linguagem
predominante e a necessidade de se
empregar termos técnicos especificos
em cada caso pode levar os leitores
que n&o tém muita facilidade neste tipo
de tarefa a enfrentar dificuldades para
encontrar uma informacéo especifica.

Nosso objetivo é passar aos leito-
res uma colegéo bastante Util de en-
derecos de grandes empresas de Ele-
trénica, além de fornecer algumas in-
formagBes sobre como navegar den-
tro de seus sites, localizando informa-
¢0es especificas.

Lembramos que a Internet é dina-
mica e que mesmo as grandes em-
presas modificam constantemente
seus sites, retirando ou mudando pa-
ginas de informagdes com facilidade.
Isso significa que uma informagéo que
hoje pode estar disponivel num ende-
reco, em pouco tempo ou mesmo de
forma imprevisivel, podera ndo estar
mais. Assim, as informagdes contidas
neste artigo séo as que obtivemos na
época da edi¢do desta publicagéo.

PHILIPS COMPONENTS

O enderego da pagina de entrada
da Philips Components é dado a se-
guir:
http://www.components.philips.
com/InformationCenter

Na barra de opgdes do lado es-
querdo temos as seguintes opgbes:
News — noticias
Markets — Mercados
Functions & Technologies — Fungbes
e Tecnologias
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Media Communications — Meios de
Comunicacgbes

Careers — Empregos

Company Profile — Perfil da Empresa.

O Bot&o “Search” (Busca) permite
encontrar informag¢des sobre assuntos
especificos ou mesmo componentes.

Clicando em “Global home” e de-
pois em “Country Sites” pode-se aces-
sar o site da empresa no Brasil, que
esta em portugués.

O endereco abaixo da as lltimas
noticias da empresa.
http://2116.35.77.141/noticias.jhtml

Na barra de opgdes a esquerda o
leitor podera acessar informagdes so-
bre:

- Produtos

- Institucional

- Noticias/Imprensa

- Descobrindo a Philips

- Links para outros paises

NATIONAL SEMICONDUCTOR

Esta empresa fabrica uma grande
variedade de semicondutores que po-
dem ter todos os data-sheets e
application-notes acessados a partir
da sua pégina de entrada na Internet,
no endereco abaixo:
hitp://www.national.com

Existem duas op¢Ges para o aces-
so a informacdes:

Uma é digitando diretamente na
caixa amarela do SEARCH (Busca) o
nome do componente, por exemplo
LM317. Outra, € indo as opgbdes logo
abaixo em azul onde temos todos os
data-sheets disponiveis e a possibili-
dade de localizar componentes por
parametros

O site com enderego acima esté
em inglés, mas existe a opcédo em
portugués que estd no seguinte en-
dereco:
http://www.national.com/PRG/

Motorola

“Digital DNA

from Motorola

Home Solutions Products

Smart Networks s
Developer Forum

Semiconductor
Products

“Digttal DNA

Contact About Us Site Map

Motorola Expands Portfolio of 16-Bit Flash-Based Hybrid Controliers

Products

To mast the needs of embedded systems design engineers who are continually

Documentation

challenged by increasing pedarmance requirements for control-osientad
applications, Matorola, Inc. announced the expansion of its portfolio of Flash-based

hybrid controllers. The 86F826 and 56FB27 are based on the 56800 core, the first

Solutions

in the industry to integrate into a single architecture the performance of traditional

digital signal processors (DSP) with the control functionality of microcontroliers

Support

News

more,..
Merchandise

: B Motorola Introduces RF LDMOS
ACH IR Broadcast Devices Designed for

(MCU). Both chips are ides! for a multitude of control, telephony and other
applications requiring highly-integrated, high-perormance solutions with all the
flexibility enabled by Flash technology. These devices are part of 3 comprehensive
DSP controller portfolio from the worldwide market leader in embedded processors.

Recent Press

Motorola Combines Matworking

Broadcast Transmitter Equipment Software with Market-Leading
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Basicamente, o que temos ¢é a
mesma péagina de entrada em inglés
do endereco acima, mas traduzida.

Para outros idiomas existe o se-
guinte link de opgdes:
http://www.national.com/
intl_access.html

Nele, pode-se optar pela pagina
em Espanhol, Alemao, Francés, Italia-
no, além de outros idiomas.

Um ponto importante das informa-
¢bes da National Semiconductor s&o
os excelentes Applications-Notes que
tratam de informagbes sobre uso de
seus produtos.

TEXAS INSTRUMENTS

Um dos mais completos sites da
Internet é o da Texas Instruments que
pode ter a pagina de entrada acessa-
da no enderego:
http://www.ti.com

Nas trés janelas da parte superior
do lado esquerdo tém-se as opgoes
de assuntos a serem localizados,
quando entdo pode-se ir diretamente
aos setores correspondentes. No en-
tanto, para componentes especificos
ou aplicagdes pode-se utilizar a jane-
la de SEARCH (Busca).

Na opcao Tl GLOBAL pode-se
acessar os sites da Texas em diver-
sos paises. Para o Brasil, o enderego
em portugués, direto da pagina de en-
trada é:
http://www.ti.com/sc/brasil/mundo/
mundo.htm

E importante observar que o “fun-
do” do site continua com muitas par-
tes em inglés e que apenas uma par-
te encontra-se em portugués, mas as
opgdes de busca e acesso sao as
mesmas.

FAIRCHILD SEMICONDUCTOR

A Fairchild Semiconductor tem
uma linha de semicondutores que
consta basicamente dos seguintes
itens: analégicos e de sinal, discretos,
interfaces, l6gicos, microcontrolado-
res, memdrias néo volateis e optoele-
trénicos.

Na pégina de entrada, cujo ende-
reco é dado abaixo, o leitor tera aces-
so a informacdes sobre todos 0s pro-
dutos desta empresa.
http://fairchildsemi.com/index.html!

Applications-notes e Data-sheets
tdm uma pagina que pode ser

Wi TEXAS INSTRUMENTS

THE WORLD LEADER Im DSP AND ANALODG

Samiconductor Products 1§

Find Development Tuols

Find Appfications

HOME

COMPANY INFORMATION | EMPLOYMENT

SEARCH [ | [Specify sn area i @  tovanceoseae

TIOLOBAL CONTACT LS SITE MaP

: o SEMICONDUCTORS B \ DIGITAL SIGNAL PROCESSING
| oeTaEmEy]  [Aeguawsssspa] | TMS320LF2401A DSP
FIND THE RIGHT DIGITAL SIGNAL

PROCESSEOR AND BROWSE ESSENTIAL

NOTES,

EXPLORE ANALOG PRODUCTS, APPLICATIONS

| The industry’s smallest DSP controler
} snables mors compact.
| -

DESIGN RESOURCES.

SYSTEM BLOCK DIAGRAMS | WEBCASTS | DISTRIBUTORS | PACKAGING | TRAINING

AS SEEN ON TV - MORE ABOUT TI PROGRAMMABLE DEPs AND ANALOG PRODUCTS »

TRAINING, AND DESIGH TOOLS.

« Amplifiets and Comparators
» Data Converters

* Power Management

& rubust

1 designs while
decreasing system
costs.

- Sign.

3

DIGITAL INNOVATIONS

* Witelegs Netnotdng

* Weless Communications
© DMAP™

> Moie Digital Innavatisrg

acessada logo da entrada. Temos tam-
bém o SEARCH (Busca) que permite
localizar informagdes sobre os com-
ponentes da empresa.

Destaca-se um conjunto de
searchs especificos para data-sheets,
applications-notes e power.

Um recurso importante que a
Fairchild coloca a disposi¢éo de quem
acessa seu site é o WEBSIM, que con-
siste de um programa que ajuda a
calcular circuitos com MOSFETS de
poténcia.

O enderego para o acesso a este
software é:
http://www.transim.com/fairchild

MOTOROLA

O site da Motorola com seu Digital
DNA que apresenta novas solugées
para projetos digitais pode ser
acessado em:
http://e-www.motorola.com/
index.html

Na pagina de abertura deste site
encontramos os /inks necessarios aos
diversos assuntos disponiveis e tam-
bém a janela de SEARCH (Busca)
onde pode-se digitar uma palavra cha-
ve ou 0 nome de um componente.

Logo abaixo desta janela temos as
opgoes diretas de assuntos disponi-
veis como:
Products — produtos
Documentation — Documentagéo
Solutions —Solugdes
News — Noticias
Merchandise — Mercado
Register/Login — Registro/Entrada.

Em especial, sugerimos aos leito-
res que precisam de informagdes téc-
nicas que se dirijam diretamente a
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pagina de documentag&o, cujo ende-
reco é:
http://e-www.motorola.com/
webapp/DesignCenter

Nesta pagina existem janelas onde
pode-se selecionar produtos e
tecnologias; depois ha uma janela
para se selecionar familia ou fungéo
do componente especifico, tipo de
documentagéo e a quantidade de do-
cumentos que se pretende visualizar.

Esta site s6 esta disponivel em in-
glés.

INFINEON

No dia primeiro de abril de 1999 a
Siemens Semicondutores passou a
ser denominada Infineon Techno-
logies. Desta forma, produtos da
Siemens Semicondutores podem ter
informagbes acessadas na pagina
desta empresa, cujo enderego é:
http://www.infineon.com

Na pagina de entrada todas as in-
formacgdes sobre o conteudo do site
estdo disponiveis destacando-se em
especial o item products (produtos),
que também pode ser acessado dire-
tamente pelo enderego:
http://www.infineon.com/cgi/
ecrm.dll/fecrm/scripts/prod_cat.jsp

Nele, temos toda a linha de dispo-
sitivos semicondutores da Infineon,
separados por grupos tais como me-
mérias, microcontroladores, compo-
nentes de GaAs, semicondutores de
poténcia, fibras dpticas, etc.

INTERSIL

A Intersil é um dos grandes forne-
cedores mundiais de dispositivos
semicondutores. Na sua linha de pro-
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dutos destacam-se semicondutores
tradicionais como das linhas ICL e CA,
tais quais os conhecidos conversores
AD (ICL7106 e ICL7107) além de uma
linha moderna de produtos, como :
para comunicagdes, redes PRISM e
redes LAN, gerenciamento de ener-
gia, poténcia, espaco e analdgicos e
lineares. No enderego abaixo pode-se
partir para a obtengéo de informagdes
sobre todos os produtos da Intersil.
http://www.intersil.com

Destacamos a disponibilidade em
formato PDF de uma enorme quanti-
dade de data-sheets e applications-
notes que podem ajudar e muito aos
projetistas.

ON SEMICONDUCTOR

A On Semiconductor é uma das
grandes empresas de semicondutores
dos Estados Unidos, mas com fabri-
cas em diversos paises do mundo.
Esta empresa tem uma linha de
semicondutores prépria e outra absor-
vida da Motorola.

No enderego abaixo temos a pagi-
na de entrada para o site da ON Semi.
http://www.onsemi.com/home

Neste site destacamos a possibili-
dade de se obter data-books comple-
tos sobre diversas linhas de produtos
desta empresa como, por exemplo,
manuais de circuitos integrados
CMOS, chaves analdgicas, TTL LS,
MECL, transistores de poténcia
bipolares, etc, para os quais o forma-
to em PDF permite que se tenha uma
reducéo consideravel do espago para
sua gravagao.

De fato, existem manuais de até
mais de 500 pdaginas totalmente dis-
poniveis para download.

Para acesar data-books e outros
documentos disponiveis,o endereco é:
http://www.onsemi.com/pub/prod/
0,1824,productsm_Literature,00.html

Os tamanhos dos documentos va-
riam de 1 a 35 megabytes. Lembra-
Mos que para os documentos maio-
res sera importante que o leitor dis-
ponha de acesso rapido & Internet.

ZETEX SEMICONDUCTOR

A Zetex Semiconductor é uma
empresa britdnica que fabrica
semicondutores tendo como ponto for-
te de sua linha os CMOS, MOSFETs,
Diodos de Capacitancia Variavel,
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nRRD-\-'-' ELECTRONICS, INC

SITE SEARCH

{Gor Worldwide Offices & Line Card

HELP

FIND & BUY PARTS ONLINE »

To find a listing of the Atrow sales offices nearest you and the supplier
linecards available from those offices please enter the information requested
below. Our search engine will quickly give you the address, phone and fax
number of our nearest sales offices including a listing of the linecard and a

4 secondary search feature will allow you to restrict your search and view a
list of suppliers by product technology. Convenient links to the supplier web

Zip Search I

PART NUMBER SEARCH =
PRODUCT CATEGORY SEARCH » map or detailed driving instructions.
DATA SHEET SEARCH »
HOMEPAGE » Looking for a Specific Type of Product?
HOT PRODUCTS =
RE/MICROWAVE »
TAILORED SOLUTIONS »
YORLDWIDE OFFICES » sites will help you continue yout research from there!
QUALITY PROGRANS = For Customers Within the U.S. Please:
SEMIRARS/EVENTS o .
Enter Zip Code: I
LEARN ABOUT ARROW v . )
CORPORATE OVERVIEW » For Customers Outside the U.S. Please:
INVESTOR RELATIONS »
COMPONENTS GROUP «
COMPUTER PRODUCTS GROUP »
CAREER OPPORTUNITIES »

Select Location: [*Selecta Country* ¥ | Location Search 5-:1

CONTACTUS »

CSIC, além de semicondutores de
GaAs. O site desta empresa pode ser
acessado no seguinte endereco:
http://www.zetex.com

A Linha de Produtos pode ser
acessada no seguinte fink:
http://www.zetex.com/guides.shtm

Em especial, destacamos a dispo-
nibilidade de documentos sobre a apli-
cagdo de MOSFETs de Poténcia no
seguinte endereco:
http://zetex.com/s68shtm

Nesta pagina podemos encontrar
documentacdo sobre projeto de
ionizadores, controle de motor de pas-
s0 e driver para relés de uso
automotivo. Esta documentacéo esta
em inglés.

MAXIM

A Maxim fabrica componentes
analdgicos, de sinais mistos, RF, fibra
Optica, que operam desde DC até
GHz. A pagina de entrada desta em-
presa na Internet estd no seguinte
endereco:

http://www.maxim-ic.com

Nesta péagina temos o SEARCH
que permite localizar componentes
especificos a partir de palavras-cha-
ve, tipos ou parametros. Temos tam-
bém uma janela para selecionar fami-
lias de componentes que incluem
conversores AD, DA, amplificadores
operacionais, comparadores, etc. Uma
grande quantidade de applications-
notes por categorias pode ser

©199% Aoow Elotsondes, Ine. Al Rights Reserved,

acessada diretamente no seguinte
link:
http://dbserv.maxim-ic.com/
appnotes10.cfm?filter=category
Artigos técnicos podem ser aces-
sados no seguinte /ink:
http://dbserv.maxim-ic.com/
tarticle/article.cfm?filter=tech
Também ¢é importante o link se-
guinte onde temos o acesso aos Ulti-
mos data-sheets publicados pela em-
presa:
http://dbserv.maxim-ic.com/
I_datasheet3.cfm

MICREL

Logo abaixo do nome desta em-
presa, na sua pagina de abertura, o
leitor encontrard uma janela para ob-
ter informagdes sobre seus produtos,
ja acessando uma lista com os tipos
disponiveis.

O endereco da pagina de abertura
da Micrel é:
http://www.micrel.com/index.shtml

A Micrel possui as seguintes linhas
de produtos:
Clocks e légica de alta velocidade
Comunicagdes de alta velocidade
Circuitos lineares e de interface
Fontes de alimentagdo/LDO
Chaves de poténcia
Rédio freqléncia

O link para acessar os application-
notes é o seguinte:
http://www.micrel.com/product-
info/applist.shtml.
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Destacamos os applications-notes
que tratam de uma chave de poténcia
controlada por légica, uma fonte
chaveada de 30 W operando em 500
kHz e um regulador ajustavel de 0 a
25 V. Todas essas informacdes estéo
disponiveis em formato PDF na pagi-
na indicada acima.

MITEL

A Mitel Semiconductor é uma em-
presa que se especializou em produ-
tos para interfaces l6gicas, comunica-
¢oes oOpticas, ISDN, sincronizagéo de
sistemas, DSPs profissionais, etc.

A péagina de entrada para o site
desta empresa esta em:
http://www.mitelsemi.com

CYRIX

A Cyrix, além de sua linha de mi-
croprocessadores, fabrica tambem
produtos para comunicagdes VIA e
produtos para redes e periféricos. O
endereco na Internet da Cyrix é:
http://www.cyrix.com

No /ink de produtos podem ser
acessadas informagbes sobre todos
os itens desta empresa incluindo-se
data-sheets.
http://www.cyrix.com/products/
index.htm

INTEL - Brasil

O site da Intel em portugués pode
ser acessado no seguinte enderego:
http://www.intel.com.br

Destacamos, neste enderego, 0
acesso as informacgdes sobre 0s
microprocessadores da linha Pentium
com todos os manuais em formato
PDF disponiveis para download.

Para o Pentium Il o /ink é:
http://www.intel.com.br/portugues/
home/pentiumiii/index.htm?iid=
porthome+roll_Pentiumlii&

Para o Celeron o Jink é:
http://www.intel.com.br/portugues/
home/celeron/index.htm?iid-
porthome+roll_Celeron&

Para o Pentium IV o link é:
http://www.intel.com.br/portugues/
home/pentium4/index.htm?iid=
porthome+feature_text&

INTERNATIONAL RECTIFIER - IR

Esta empresa caracteriza-se por
fornecer semicondutores de poténcia
como, por exemplo, Power-HEXFETS,
Power-MOSFETS, Circuitos Integra-
dos, IGBTs, FETKY, Relés, Pontes,
Tiristores, Sistemas de poténcia,
Diodos e muito mais.
http://www.irf.com/Wp3méa8c/

A linha de produtos da IR pode ser
acessada pelo seguinte /ink:
http://iwww.irf.com/product-info

A seguir damos o link para o aces-
so aos data-sheets em formato PDF,

Na relacéo que aparece no link te-
mos diretamente o tipo do componen-
te a que o documento se refere.
http://www.irf.com/product-info/
datasheets/data

XICOR

A XICOR é uma empresa do Vale
do Silicio que tem como principal li-
nha de produtos os circuitos de sinais,
gerenciamento de energia, gerencia-
mento de sistemas, memorias e pro-
dutos para fibras opticas. A pagina de
entrada para o site da XICOR esta em:
http://www.xicor.com

Os applications-notes da empresa
e data-sheets podem ser obtidos pe-
los seguintes finks:
http://www.xicor.com/
app_notes.php

http://www.xicor.com/
datasheets.php

S&o dezenas de aplications-notes
em formatos PDF com tamanhos que
variam entre algumas dezenas de
kbytes até centenas de kbytes.

NEC

O site mundial da NEC, fabricante
de componentes eletronicos, esta no
seguinte endereco:
http://www.nec.com

Para entrar no site em portugués
desta empresa, digite:
http://www.nec.com.br

A linha de produtos no Brasil se
destina basicamente a telecomunica-
¢oes, supercomputadores e produtos
pessoais.

HITACHI

O site global em inglés da Hitachi
tem o endereco abaixo:
http://global.hitachi.com

Embora exista uma janela para se
selecionar a area, ndo ha uma opgéo
para a América do Sul e, portanto, em
portugués. Dentre os produtos, des-
tacamos uma ampla linha de
semicondutores, cinescopios, equipa-
mentos de medida, LCDs, etc.

O link para entrar na pagina de pro-
dutos eletronicos € o seguinte:
http://global.hitachi.com/Prod/ie-
prod/info.html

Nele, temos a opgéo para semicon-
dutores e circuitos integrados, instru-
mentos eletrénicos e computadores,
além de outros.

{| 7.2¥ Cordless Drill
Reversible with &
position torque
control and 15

1 piece accesories

| || with storage kit.

Save £5.00

Order Code : FZ0O
Previous Price : £19.99
| Today's Prica | £14.99

Digital Videocam
VGA Greatwvalue !
Simply plug into
the USB port and
go. Ideal for
home and Family.
Use as a security
product in the
office Save over
£14

Order Code : 2Y23
Price : £39.99

M‘(_w New Producis..

bt
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MONDO-TRONICS INC.

PRODUCTS

— products.
DISTRIBUTORS

NEWS ROOM

CONTACT INFO

SAMSUNG

O site da empresa coreana € aces-
sado no seguinte endere¢o (em in-
glés):
hitp://www.samsung.com

Se bem que existam links para
sites em outras localidades, no Brasil
néo existe e, portanto, ndo esta dis-
ponivel a versdo em portugués.

FUJITSU

Na ampla linha de produtos desta
empresa destacamos os dispositivos
semicondutores, computadores, servi-
dores e produtos para dados e voz.
http://www.fujitsu.com/produtcs

O acesso a pagina de semicondu-
tores é feito pelo seguinte link:
http://www.fujitsu.com/products/
semiconductor/cs

Nesta pégina, entretanto, apenas
existe um comentario sobre os produ-
tos disponiveis. Para mais informagoes
o leitor devera navegar no site e even-
tualmente solicitar as informagdes di-
retamente.

EXAR

A Exar é uma empresa especializa-
da em solugdes sobre silicio para co-
municagdes de banda larga.

Dentre os produtos que podem ser
acessados a partir de /ink na pagina
abaixo, destacamos as UARTs e as
solugdes para audio e video.
http://www.exar.com

ASTEC

A péagina de produtos da Astec é
encontrada no seguinte enderego:
http://www.astec.com/products/
index.html
Dentre os produtos desta empresa,
destacamos:
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Welcome to the Mondo-tronics Ine. web site, featuring the latest
information about Muscle Wires, Shape Memory alloys and robotics

We provide resources for educators, engineers, scientists and
hobbyists to embrace new technologies and build skills in electronics,
mechanics, programming and logical operations.

Chaves de alta e baixa poténcia
Adaptadores e carregadores
Fontes de alimentagéo
Conversores DC/DC

Na pédgina acessada pelo /ink aci-
ma pode-se encontrar datas-heets
para download em formato PDF.

TOSHIBA

O site da empresa japonesa nos
Estados Unidos é encontrado no se-
guinte endereco:
http://www.toshiba.com

O link para dispositivos semicon-
dutores é encontrado digitando-se:
http://www.toshiba.com/taec

Este link pode ser acessado tam-
bém pela pagina de entrada da em-
presa.

Nele, encontramos uma janela
para os sites de produtos que contam
com as seguintes principais opgoes:
Analégicos / DACs / Microcon-
troladores / ASICs / Baterias / Displays
/ Vélvulas

Em especial chamamos a atengdo
para a pagina de valvulas que, além
dos tubos para TV e aplicacbes espe-
ciais como raios X, também inclui
magnetrons, triodos e tetrodos de po-
téncia.

Essa pégina podera ser acessada
pelo seguinte /ink:
http://www.toshiba.com/taec/cgi-
bin/display.cgi?table=Family&
FamilyD=9

ROHM

A ROHM do Japéo possui uma
ampla linha de produtos eletrdnicos,
destacando-se os dispositivos
semicondutores como:
http://rohm.co.jp/index_g.html

ARROW

Grande distribuidor mundial de
componentes eletrdnicos. O site fica
em:
http://www.arrow.com

Desta pagina pode-se acessar os
distribuidores no mundo inteiro pelo
seguinte fink:
http://www.arrow.com/www/
worldwide_linecard/index.html

AVNET

A AVNET ¢é um distribuidor mun-
dial de componentes eletronicos com
pagina mundial em:
http://www.avnet.com

O site da AVNET no Brasil pode
ser acessado no link:
http://www.avnet.com.br

RADIO SHACK

Famosa nos Estados Unidos e no
mundo inteiro, esta empresa se espe-
cializou em kits e aparelhos prontos
de diversas linhas como computado-
res, scanners para escuta de todas as
faixas de onda, rédio pessoal, brinque-
dos, etc. Nos Estados Unidos ela pos-
sui uma rede de milhares de lojas,
chegando mesmo a ter no Brasil duas
de suas lojas. O enderego do site mun-
dial da Radio Shack é:
http://www.radioshack.com

Em especial, sugerimos aos leito-
res gue visitem os sites de componen-
tes eletrénicos e kits que sédo encon-
trados acessados pelos seguintes en-
derecgos:

Componentes:
http://www.radioshack.com/
category.asp?cookie%5Fteste=1&
catalog%5Fname=CTLG&category%5
Fname=CTLG%5F010%5F000%5
F000&Page=1

Kits: http://www.radioshack.com/
category.asp?cookie%5Fteste=1&
catalog%5Fname=CTLG&category%5
Fname=CTLG%5F009%5F000%5
F000&Page=1

MAPLIN

Uma outra grande empresa famo-
sa pela venda de componentes e kits
€ a Maplin, da Inglaterra, e que pode
ser acessa em:
https://catalogue.maplin.co.uk/
mainframe.asp
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MONDO-TRONICS

Esta empresa é uma fornecedora
de dispositivos e kits relacionados com
a montagem de robds e dispositivos
diversos de Mecatronica. Na sua loja
podem ser acessados, um interessan-
te catalogo de robds e outros disposi-
tivos como musculos de SMA (Shape
Memory Alloy), caixas de redugéo e
literatura sobre o assunto. O site da
Mondo-Tronics esta em:
http:/www.mondo.com

ROBOT-STORE

A loja da Mondo-Tronics para a
venda de componentes, kits e litera-
tura para Robdtica e Mecatrénica é a
Robot-Store, cujo endereco é:
http://www.robotstore.com

TiNi ALLOY COMPANY

Esta é uma empresa especializa-
da em um tipo de SMA feito de titanio
e niquel, e que tem uma grande linha
de aplicagbes para seus produtos,
além de literatura que pode ser de
grande interesse para os leitores que
trabalham com Robética e Mecatréni-
ca. O enderego é:

http://sma-mems.com

PAGINA DO EXPERIMENTADOR
COM DSP

Para o leitor que se aprofundar no
uso de DSPs em seus projetos, esta
pagina traz uma enorme quantidade
de informacdes importantes que véo
desde a operagéo basica do DSP até
uma grande quantidade de links. A
pégina de entrada para este site é:
http://www.tapr.org/tapr/html/
dspf.html
Livros sobre DSPs:

Uma boa quantidade de livros téc-
nicos sobre DSPs é sugerida se o lei-
tor digitar:
http://www.tapr.otg/tapr/html/
dspf.html

ELECTRONICS WORKBENCH
Softwares para a Eletrénica podem
ser obtidos de diversos fabricantes e
em diferentes niveis. Um dos mais
conhecidos é o Electronics
Workbench, que contém diversas fer-
ramentas para o projetista como o
MultiSim. A versdo 2001 j& pode ser
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experimentada com o download da
verséo demo no seguinte site:
http://www.interactive.com

Além dos circuitos simulados que
o leitor pode encontrar no CD da pri-
meira edi¢ao desta revista, no site do
Electronic Workbench existe um link
para se fazer o download de circuitos
simulados publicados na revista ame-
ricana Poptronics.
http://www.electronicsworkbench.
com/poptronics/

LIVROS DE ELETRONICA

Existem diversas editoras america-
nas que trabalham com livros de Ele-
trénica, os quais podem ser compra-
dos por fornecedores conhecidos via
Internet, tais como:
Amazon:
http://www.amazon.com
Barnes and Noble:
http://www.barnesandnoble.com

PROMPT BOOKS

Esta empresa tem uma linha edi-
torial que vai desde cursos basicos,
livros para técnicos de manutengao,
teoria, livros de Eletricidade e Robdtica
e Informatica.
http://www.samswebsiste.com

NEWNES

A Newnes é o ramo editorial de
Eletronica da Multinacional briténica
Butterworth-Heinemann com filiais em
todo o mundo. Além de uma série de
pocket-books, esta editora trabalha
com livros sobre EMI, componentes,
informatica, circuitos, telecomunica-
¢oes, etc.

O endereco na Internet é:
http://www.bhusa.com/newnes/us/
subindex.asp?country=United
+States&mscssid=
9BPP71EKOESR2L6200
AKH843NPCU4UA2

TAB

Pertecente ao grupo McGraw Hill,
o TAB Books é o setor encarregado
de livros da area de Eletronica.

O site desta editora pode ser
acessado em:
http://www.pgb.mcgraw.hill.com/
tab-eletronics/tab-eletronics-
home.html.

Dentre os livros em inglés que s&o
destacados estdo a série de repara-
¢ao de TV para iniciantes, o Curso de
PIC, e como programar o Basic Stamp.




| S MICROCHIP

The Embedded Control Solutions Company®

MPLABCIDE

Software para Desenvolvimento de Projetos com PICmicro® da Microchip

Carregue o MPLAB® (Integrated
Development Environment— IDE) em
um PC com o sistema operacional
Windows da Microsoft® e vocé (pro-
jetista) tera uma estacéo de desen-
volvimento unica e completa para
editar, compilar, simular, emular,
debugar e gravar seu programa. O
MPLAB® IDE reune diversas ferra-
mentas de desenvolvimento forne-
cidas pela Microchip e empresas
terceirizadas selecionadas para
implementacédo de projetos. Estas
ferramentas incluem recursos como
compiladores, programadores,
debbugers e emuladores In-Circuit
(ICE). O grande fato a ser destaca-
do sobre o MPLAB IDE é que ele é
gratis incluindo todas suas atualiza-
¢Oes futuras e opera em praticamen-
te qualquer PC. MPLAB® ¢é a plata-
forma ideal de desenvolvimento de
toda a familia PICmicro® de micro-
controladores da Microchip.

Projetado para operar em ambi-
entes com o sistema operacional
Windows, o MPLAB® IDE oferece um
gerenciador de projeto, um progra-
ma editor de texto, uma barra de fer-
ramentas configuravel pelo usuario
e uma barra de status que fornece
informagdes sobre 0 processo de
debug. O MPLAB® IDE é uma pode-
rosa ferramenta de desenvolvimento
de alta produtividade com simulagcdo
de tempo real.

Usando os compiladores C da
Microchip ou outros compiladores
terceirizados (como os da IAR,
HiTech, CCS, etc), o projetista pode
escrever seu codigo em C e compila-
lo diretamente sob o MPLAB® IDE.
O cédigo também pode ser escrito
em linguagem assembler se assim
0 projetista escolher. Uma vez que o
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programa esteja pronto, o MPLAB
IDE pode ser conectado a um dos
dois programadores oferecidos pela
Microchip (PICSTART® Plus ou PRO
MATE® ) para efetivamente progra-
mar o PIC. Pode-se utilizar também
o MPLAB-ICD In-Circuit Debugger,
da Microchip, neste caso o cédigo
objeto pode ser baixado através do
MPLAB® IDE para o PIC usando o
médulo ICD ligado a porta serial do
PC. Deste modo “debuga-se” as fun-
¢bes do programa em tempo real.

Uma outra alternativa para o pro-
jetista é usar o Emulador In-Circuit
MPLAB ICE2000 que, quando liga-
do & porta paralela do PC, permite
uma integragéo completa do codigo
do programa para o sistema MPLAB
ICE. Com o MPLAB ICE, o controle
completo de emulagéo esta sob seus
dedos permitindo observar janelas,
pontos de interrupcéo, efetuar
friggers complexos, trace points e
acompanhar todo processo que es-
teja acontecendo na sua prépria pla-
ca ou produto em tempo real.

Eis alguns destaques:

- O MPLAB® IDE possui um
gerenciador de projeto incorpora-
do, que permite um controle facil
sobre diversos projetos. Cada
projeto é fixado e salvo na sua
prépria pasta para arquivamento
simples ou trabalhos de
multiprojetos.

- O Editor MULTILAB é um editor
de funcdo completa que permite
escrever ou editar arquivos-fonte
de firmware ou outros arquivos de
texto no mesmo ambiente do
MPLAB® IDE.

- O MPASM universal assembler
oferece um assembler completo

incluindo macros, conditional
assembler e defines nos mais
diversos formatos de fonte e
listagem.

- A biblioteca MPLIB linka diversas

func¢des de biblioteca sob apenas
um “guarda-chuva” de projeto
para facilitar o assembler.

- O MPLAB® SIM é um software

simulador que proporciona a
simulagéo direta pelo PC de um
dispositivo para a verificagcdo de
codigos sem a necessidade e
investimento inicial de hardware.
Este € um grande recurso para a
verificagdo da operacdo de
codigos, verificagdo de fungdes
de tempo ou outros pré-testes
basicos de programacao.

- O MPLINK linker é um programa

linker que conecta os compilado-
res Microchip e assemblers
realocaveis. Ele combina um
mdodulo objeto de entrada gerado
pelos compiladores e um Unico
arquivo executavel. Ele gera
também a informagéo simbdlica
para o debbuging com o MPLAB®
IDE.

- Facil de usar
- Trabalha com a maioria dos PCs

gue possuam o Sistema
Operacional Windows

- Integra ferramentas da Microchip

e de terceirizados

- Editor
- Simulador
. Interface de usuario simples para

aprender a operar ferramentas
multiplas

. E GRATIS.

Apresentamos a seguir o mini-

curso do Mplab 5.00 (e versdes su-
periores).
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MICROCHIP

0 Microcontrolador Mais Facil
de Programar do Mercado!

O Primeiro Microcontrolador
de 8 pinos do Mundo!

» RedugAo Significativa de Espago e Hardware.
 Oscilador & Reset Internos.

« § 1/0s com Source/Sink de 25mA.

* Opgao de EEPROM e A/D internos.

« In-Circuit Serial Programming™ (ICSP™).
 $6 33 instrugdes de Programagdo (RISC).
 Arquitetura Harvard.

» Tecnologia Microchip.

Electronic Americas 2001!

' PICSTART® PLUS W m %
Kit de Desenvolvimento Low Cost Venham nos Visitar na Feira Ll o
L= 8=
i -

Velocidade até 20 MHz, ICSP™.
Opgdes com EEPROM Interna

Somente 35 |IISII'III;OBS com PsieckIs
PIC16FXXX
= Familia Mid-Range
oftware de Desenvolvimento i o o
Periféricos: Comparadores, USART,
12¢, SPI, PWM, A/D de 8 e 12 bils, Driver
G RATU' 0 M PMB ' i St ot ke
I -3 (Inclusﬂ nn cn da Revlsm) : Circuitos Brown-Out e Waichdog Internos.
& Meméria Flash de Programa.
Oscilador Interno de 4MHz/32KHz*
Tecnologia Microchip.

".;' €xplore o Universo de Produtos Microchip no site wiww.microchip.com

\ MICROCHIP

Lo
Consulte ja nossa Rede de Distribuicéao... IrControl.

Distribuidores Autorizados: | Representante
Exclusivo no Brasil:

lm A aut-comp b HITEmgsﬂ FUTURE ELECTRONICS ‘ S8 ArTivAR LTDA

Fone: (011) 4066-9400 Fone: (011) 6915-7443 Fone: (011) 5188-4130 Fax. (019) 3236-9834 | Fone: (01?231'82717
Fax. (011) 4066-9410 Fax: (011)6915-7579 Fax: (011)5188-4191 future.campinas@future.ca | Fax (011) 255-051
vendas@farnell.com autcomp@autcomp.com.br microchip@hitech.com.br + microchip@artimar.com.br

The Microchip name and logo, PIC and PICmicro are registered trademarks and Microchip are trademarks of Microchip Technology Inc. in the U.S.A. and other countries. All other
trademarks are property of their respective owners. ©2001 Microchip Technology inc. All rights reserved




VIDAL

Solucoes com Microcontroladores

Placa Pickab 4A

Didatica, com gravador
ja incorporado. Ideal
para estudos e projetos
com PICs. Grava 16F84A
e a linha 16F87X.

Treinamento
Pratico em PICs
com énfase em

programagao.

Livro em 3
portugués com &
CD-ROM de \’;:?
exemplos. ;

A Médulo 16F62X

PICs 16F627 e 16F628.
Para uso com
a placa PicLab 4A

1% MINICON
4‘ Controlador com
o 22 |/O livres, LCD,

~ fonte e 5 teclas.

£

Ideal para avtomacéio

PicLab 4A

Somente 6 alunos,
com 1 aluno por micro.

Grava e executa com 0s

Assessoria e desenvolvimento de
Projetos sob medida.

VIDAL

Solugdes com
Microcontroladores

www.vidal.com.br
consultas @ vidal.com.br
(11) - 6451 - 8994
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APRENDENDO PICs

Para o aprendizado de microcon-
troladores, além de programas com-
piladores e simuladores, o estudan-
te acaba se deparando com a ne-
cessidade de gravar uma pecga do
componente e colocar para “rodar”,
0 que nem sempre é possivel devi-
do ao custo de ferramentas de
hardware e a dificuldade na monta-
gem dos protétipos.

A PLACA PICLAB 4A

Voltada para o uso em sala de
aula no aprendizado dos PICs, a pla-
ca PicLab, agora na versao 4A, per-
mite ao estudante realizar todas as
etapas de desenvolvimento e apren-
dizado: editar, compilar e simular seu
programa usando o MpLab (ver arti-
go sobre o MpLab), e com a placa
PicLab 4A, gravar e executar o pro-
grama em velocidade real.

Devido ao seu projeto modular, a
placa PicLab 4A permite que, além
de usar os periféricos nela presen-
tes, (LEDs, teclas, serial, LCD, ...) 0
usudrio possa interligar praticamen-
te qualquer outro componente, ou
até mesmo mddulos externos com-
pletos (relégios de tempo real,
displays de LEDs, teclados matri-
ciais, EEPROMs I[2C, smart-
cards,...), pois 0 seu conector de ex-
panséo permite acesso a todos os
pinos do PIC, inclusive o reset, além
de funcionar como fonte de alimen-
tagcdo. Aiém disso, a placa possui um
conector para gravagédo de PICs

externamente, mais conhecida por
ICSP (in-circuit serial programming),
0 que permite ao usudrio usar a pla-
ca como gravador para os modelos
suportados, mesmo ja estando mon-
tados.

MODULOS DE EXPANSAO

O projeto da placa PicLab 4A foi
desenvolvido visando garantir o
upgrade da mesma sem a necessi-
dade de se adquirir outro modelo.

Assim, através de modulos a
mesma pode ser expandida para tra-
balhar com novos PICs.

Um exemplo é o novo médulo
adaptador 16F62X, que permite uti-
lizar os PICs 16F627 e 16F628 na
placa PicLab 4A, aproveitando todas
as caracteristicas dela e dos novos
modelos, que incluem clock e reset
internos.

Caracteristicas da placa PicLab 4A

. Gravador In-circuit na placa;

. Oscilador cristal 4 MHz;

. Teclas;

. Leds;

. Oscilador Astavel;

. Soquete LCD;

. Interface RS 232-C;

. Sinais analogicos;

. Pontos de expansao;

. Soquetes de 18 e 40 pinos;

. Saida ICSP;

. Expansivel com médulo externo
para os modelos 16F62X;

. Cabo de gravacao;

. CD-ROM com exemplos e progra-
mas.
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Mini-curso

Mp

Lab

passo-a-passo

GUIA PRATICO PARA SIMULACAO E ESTUDOS.

USANDO O MpLab 5.00 E
SUPERIOR

Introducéo e ajustes

O MpLab é um ambiente integra-
do para o estudo e desenvolvimento
com a familia PIC de microcontrola-
dores.

Sua principal caracteristica é a
total integragdo de seus modulos
com o ambiente Windows, permitin-
do a facil copia de arquivos e trechos
de arquivos de um aplicativo para
outro.

Para se escrever um programa no
MpLab, precisamos antes assimilar
o conceito de “projeto”.

O “Projeto” no MpLab

Entende-se por projeto um con-
junto de arquivos e informagdes que
diz ao MpLab qual a situagéo de um
certo trabalho em particular.

Por exemplo, num certo projeto
designado EXEMPLO.PJT temos
duas janelas abertas: exemplo.asm
e exemplo.Ist.

Em outro projeto designado
TESTE.PJT temos trés janelas aber-

tas: teste.asm, teste.lst. e File.

Register Window.

Com o gerenciamento de proje-
tos presente no MpLab néo precisa-
mos “lembrar’ quais as janelas que
cada projeto estava usando no mo-
mento em que encerramos o traba-
lho, pois ao carregarmos o projeto
desejado todas as informagdes re-
lativas a0 mesmo seréo recupera-
das.

IMPORTANTE: Ao encerrar seus
trabalhos né&o va fechando as jane-
las abertas. Feche apenas o MpLab
e na janela “Save Project” selecione
Yes, ou caso pretenda apenas en-
cerrar o trabalho atual, selecione no
menu “Project > Close Project”, e
responda Yes se necessario, para
salvar as alteracoes.

Usando o MpLab
pela primeira vez.

Crie uma pasta (diretério) em seu
HD com o home c:\Opic (com o nu-
mero 0 antes, a pasta sempre esta-
ra no topo dos menus).

Vamos criar um novo projeto, de
nome EXEMPLO.PJT, neste
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diretério. Inicie o MplLab. Sua
tela devera ser parecida com a da
figura 1.

Selecionando o processador
Se o processador indicado no
rodapé ndo for o 16F84A, siga a se-
guinte sequéncia nos menus:
Options -> Development Mode, e
selecione aficha “Tools” e teremos
a tela da figura 2.

Marque a opgcdo MPLAB-SIM
Simulator e selecione PIC16F84A
no menu & direita, deixando sua se-
lecdo conforme acima e depois dé
um click no botdo Apply e em se-
guida em OK.
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Sua tela agora deve estar confor-
me a tela inicial (figura 1).

Ajustando o clock para simulagéo

Para podermos obter do simula-
dor informagdes precisas sobre nos-
s0 programa quando simulado, de-
vemos informar ao mesmo qual a fre-
guiéncia de clock com que o chipfun-
cionara. Selecione na linha do menu
do MpLab

Options > Development Mode
> e selecione a ficha “Clock”

e obteremos a janela da figura 3:

- Inicialmente selecione se a fre-
glUéncia estard em MHz, kHz ou Hz;

- No campo “Desired Frequency”
entre com a freqliéncia desejada, por
exemplo, 4 para 4 MHz ( o campo
“Actual Frequency” mostra a fre-
quéncia atual com que o simulador
estd calculando os eventos);

- No box “Oscilator Type” selecio-
ne modo XT;

- Dé um cliqgue em “OK” e na nova
janela apenas responda “OK” nova-
mente.

- Veja no rodapé do MpLab a fre-
gléncia sendo reconhecida pelo pro-
grama.

TRABALHANDO COM
“PROJETOS”

Criando um novo fonte para tra-
balharmos com um projeto
Iniciaremos um novo projeto
sempre pela criagdo de um novo fon-
te. Execute a seguinte seqliéncia:

File > New

Um novo fonte de nome
Untitled1 serd criado, e o MpLab |he
perguntara se deseja criar um novo
projeto.

Responda “NO” para prosse-
guir na criagao do fonte.

Voce obtera a tela da figura 4:

Ajuste o tamanho da janela
Untitled1 conforme sua convenién-
cia.

Nesta janela digite o texto con-
forme a figura 5:
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fie Eralect BAr [Relg :3.7‘;'
Talx] Tl
1| Development Mode

Configuration ] Poser Y Pins 7 Break uphom
; ] Clock ] Memory

rNone[Edital Only] Processor:| PIC1GF84A
l"' MPLAB-SIM Simulator Not all peripherals have support for | =
I ~ MPLAB-ICE Emul

Serial 170 is not simulated.

.+ PICMASTER Emulator | [Click 'Details' for additional
2 CEMC
MPLAB-ICD Debugger | Inauite ] Details...

information on PIC1GF84A.

Bzaes [ T[T T PICI6Reds pox00 w00 ~zdec Bk On [Sim 4MHz [User

Figura 2 - Selegdo do processador.

MFLNI

renl Mode

Configuratien ] Power i ‘ Bieak Dplmm it
Tools ] Porls T

Dscillator Type:
XT 3

Desired 4.000000 f > MHz

e kHZ
Actual Frequency: - 4.000000 " Hz

iSim
Figura 3 - Ajustando o clock para a SImulagao

Elle Ernml Ecit thugP‘CTAHT Plus

niCol | 1 | (WA NoWis NS PICTBF84A [peth0D  wOild -~zdce  BEDn Sm 4Nz User
Figura 4 - Janela com o novo fonte ainda sem nome.
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Apds a digitagéo (confirme se o
seu texto esta igual ao acima, sem
erros), salve com o nome
EXEMPLO.ASM.

Como? ApoOs escrever o progra-
ma, selecione nos menus.

File > Save as...

e na janela aberta digite 0 nome
exemplo.asm para o fonte E e sele-
cione no drive C a pasta C:\Opic.

Agora dé um click no botdo OK e
sua tela devera estar conforme a fi-
gura 5, mas com a barra de titulo do
fonte trocada, ao invés de Untiled1,
com o0 nome e caminho completos,
c:\OPic\exemplo.asm.

Criando o projeto

Agora que ja criamos o fonte va-
mos criar o projeto para trabalhar-
mos com O mesmo.

Selecione Project > New Project

e a janela da figura 6 se abrird
(veja na janela do fonte o nome e
caminho do arquivo, como dito ante-
riormente):

Escreva no campo "File Name".
exemplo.pjt e de um click em OK
(isto é , como salvar na pasta ¢:\OPic
o projeto exemplo.pjt)

IMPORTANTE: O fonte e o pro-
jeto devem estar na mesma pasta

O nome do fonte néo precisa ser
0 mesmo do projeto.

Sempre que um novo projeto é
criado, a janela “Edit Project” sera
exibida automaticamente.

Editando o projeto
(novo ou ja existente)

Entende-se por editar o projeto
escolher qual fonte fara parte do
mesmo, sendo usado no processo
de compilacdo, além de ajustar os
parametros do compilador.

Quando o projeto é novo, esta
opcéao aparecera automaticamente.

Podemos ainda usar a edigéo do
projeto para trocar o fonte ou o com-
pilador usado no desenvolvimento.

" MPLAB
File Project Edit Debug PICSTART Plus Options

=] g}

list p=16f8ka
radix  dec

include <P16F84a.INC>
org 8

clrf PORTB

bsf STATUS ,RP8
clrf TRISB
bef STATUS,RPB

loop
incf PORTH, F
loop

e
radix de ——

. ~X File Name: 0K [
include <P E e
‘ E; Cancel i
org 9 = .
clrf PO ! Help 1
bsf ST
clrf TR
bcf STH
loop [‘ » 3
incf POy} o o
goto lo| List Files of Type: Drives:
%“Proiecl Fies(~pil ~| [[&e ~]

END

Rni7C12 | 17 | (WA NoWiep NS [PICIGFBSA poOW00  wh0 --zdce Bk OR Sim AMHz User
Figura 6 - Janela “New Project” do nosso exemplo.

S T i

Target Filename [

Ieuemnlo_hex J E

Include Path | _.m&."'“ﬁ'__l
Help I |

Librasy Path 3
Linker Script Path |

loop ==

D Mode: |[MPLAB-SIM16FBAA Change... |

- Project Files

4

Add Node. || |
Cppp Node.. ! .
Datete Node i ' |
Build Node l 4‘ |

i
Hode Properties... l ;

17 | WA NoWiep INS [PICTEF84A [pe0w00 (w(h00 -~zdec Bk On 5im AMHz [User
Figura 7 - Editando o projeto exemplo.pit.

Lnt76ai2
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Para indicarmos o fonte de um
projeto ou caso desejemos alterar os
parametros do compilador, devemos
usar a seqiiéncia:

Project -> Edit Project

e em nosso exemplo teremos a
tela da figura 7.

Observe que em nosso caso, O
campo “Target filename” indica que
o alvo, isto é, o objetivo final de nos-
so trabalho, é a geracéo do arquivo
exemplo.hex, que serda o arquivo
hexadecimal a ser gravado no PIC.

Ajuste o campo “Development
mode” para exibir MpLab-SIM,
16F84A. Ajuste o campo “Language
tool suite” para Microchip.

No Campo “Project files” dé um
click com o mouse em cima do texto
“exemplo[.hex]” e observe que os
botbes Add Node e Node Properties
ficardo realgados (caso ainda nao
estejam).

Sua janela deve estar como a fi-
gura 7 mostrada. Se ndo estiver, re-
pita os ajustes.

Vamos comegar a ajustar o Mplab
para trabalhar com nosso “projeto”.

Ajustando as propriedades do
“né” principal, exemplo.hex

Dé um click no botdo Node
Properties. A janela da figura 8 deve

- MPLAR - CMIPICAEEMBELEL T
Eilh Propect “Edt Letug . PICETART P Optbas Tooks

S RIBEE
B e Wi \eronpln aem

~ Praject )
T penet Filoname ) OK || b
(o N
in |
Ll gptions
i { Description | 1 [ { | Data ~
i = |
| |Define -4 On =
loop .=  {HexFarmat ¥ INHX8M .0 INHX8S . INHX32 |
pe | Error File ¥ On .. of 1
. {List File ¥ On 1 off |
Cross-reference File  On ¥ off
' IWaming levet # all -1 warn+err .. err i
| |Case sensitivity 5 On « B |
Macro expansion - On 4 Off H
Default radix 4 HEX - DEC -1 0CT
Tab size -1 On 1

| Command Line

H |iaINHX8M fes /l+ /x- 2wl Jc- Jp16F84A ] i

| Additional Command Line Options

JeEa oxages] Cancel | nelp |

Figura 8

- Janela “Node Properties”.

=lmix)

| Include Path

Add Node 2
Librai yome do arquivo: Pastas -“
[: c:\Opic
= - ety o4
exemplo_asm et B B O =
1 o G-Y
leop L= 3 Opic siuda |
Deveb
Rede...
Langu v
-

y  Exibir arquives do lipo:

Unidades:

1$nulce files (*.c;*.asm}

5

l@c: ;J

E

Tl

& ele Mode. l }

i

uild Hode

list p=16f8%a
radix  dec i [ :
Target Filename i

include <P16F84a.. | [exenplabex ] 4
i Cancel

ora o include Path

clrf  PORTB Library Path flekd

bs§ STATUS ,RP} ’_w—_‘—“‘]

clrf  TRISB [ =

bef STATUS ,Rpi | Linker Sciipt Path

loop B

incf  PORTB,f 5

gote  loop Made: [MPLAB SIMTGFB4A thange... |
£ Project Files g «
| {exemplo [.hex] Add Node. I
i exemplo [.asm]
"‘ {Zopy Node... l
; frelete Hods f
‘ Build Hods |
i Node Pigpeiics I
B

Figura 10 - Janela “Edit Project” completa.
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Ti7Cd2 | 17 | WR NoWiap (NS PICTEFSs [psDd0  wOidd| ~zdoc  BKOn [Sm[aMRz User

Propesties. ..

" peW00  wOx00 - -zdcc Bk On!Sim 4MHz [User

Figura 9 - Janela “Add Node”.

surgir (suas opgoes pré-selecionadas po-
dem estar diferentes).

Caso as opgdes marcadas sejam dife-
rentes, use o mouse e ajuste os campos
de forma que suas opg¢des fiquem iguais
as da figura 8 e depois dé um click no bo-
tdo OK. Este ajuste é muito importante !

Sua tela retornara a da figura 7 (Edit
Project).

Neste ponto informamos ao MpLab qual
compilador usar, que arquivos gerar
(listagem, erros, ...), formato do arquivo
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.HEX, entre outros. Para cada proje-
to novo vocé devera ajustar desta
forma.

Adicionando um fonte
(também chamado de né)

Agora vamos informar ao MpLab
gual fonte serd usado na compilagéo,
dando um clickno botdo Add Node.
Nossa janela ficara como a figura 9:

Lembre-se: o fonte deve estar na
mesma pasta do projeto.

Observe que a janela ja aparece
com a pasta atual do projeto e mos-
tra em nosso caso o fonte criado
anteriormente, exemplo.asm.

Selecione o fonte e dé um click
em “OK”.

Agora sua janela “Edit Project”
deve estar conforme a figura 10.

Ent&o, basta dar um click no bo-
tdo OK que o processo de edi¢éo do
projeto estara completo.

Neste ponto vocé devera estar
com a janela como a da figura 5, mas
com os nomes do projeto e do fonte
indicados nas barras de titulo do fon-
te e do Mplab. A partir deste ponto j&
podemos compilar e simular o nos-
SO programa.

OBSERVACOES
IMPORTANTES:
Se o MpLab travar repentinamen-
te, todo seu trabalho sera perdido.
Como evitar ?
- Selecione Project > Save Project
- Selecione File > Save All
Este procedimento de salvar an-
tes de compilar é automatico depois!

COMPILANDO O PROGRAMA

Para compilar o fonte basta teclar
F10. Se ndo houver erros de sintaxe
(escrita) ou outros, havera a indica-
¢éo de tudo OK pela janela Build
Results, mensagem “Build comple-
ted successfully”, conforme a figura
11.

Feche a janela Build Results.

IMPORTANTE: O fato da compi-
lagdo ndo apresentar erros néo sig-

- CADPIEAEXEMPLO. P T

Hoc \npn Aueremple a5

list p=16f8ka

weadd e Anr
B} Build Hesults
Building ENXEWPLO.HEX...
Compiling EXEMPLD ASH:

Command line:
Message[382] €:\BPIC\EREMPLO.ASH 11 :

Build completed successfully.

A3 peB00 wik0d F-zdee

He Pmleol g\:ﬁl Q:bug PICSTAHTHU: Options  Tools Wmdow Hely

*'Cz\ARQUIU~1\MPLAB\MPASHWIN_EXE /alNHX8M /fe+ /1+ /x- /fuB /c- fpi6F8at
Register in operand not in bank 6.

Ensure ti

Bk On 1Sim 14 MHz [User

Figura 11 - Janela Build Results, apos compilagdo OK.

nifica que o programa funcionara
conforme o desejado, pois erros de
i6gica ndo sdo detectados pelo com-
pilador. Se houver erros, uma janela
aparecera indicando todos os avisos
e erros detectados pelo compilador.

Exemplo de erro

Na fonte presente na tela, escre-
va logo apds o org 0, na primeira ins-
trucdo, PORTAB ao invés de
PORTB, e entdo compile novamen-
te teclando F10.

Sua janela Build Results devera
ficar conforme a figura 12:

= ‘MPLAR - C:AOPICAEXEMPLO PJT

list p=16f8k4a
radix  dec

i B Build Hesults
cBuilding EXEWPLO.HEX...
¢Compiling EXEMPLO ASH:

¢ Command line:

cError[113] G:\BPIC\EXEMPLO.ASH 9
t Message[362] G:\OPICAEXEHPLO.ASN 11

loap

<
“Build failed.

“C:\ARQUIV~1\HPLAB\MPASHWIN.EXE /aINHX8M fe+ /1+ /fx- fw® fc- /pi
: synbol not previously defined (PORTAB)
: Register in operand not in bank 8. Ensu

jHPLAB is unable to find output File “EXEMPLO.HEX".

710 | A0 |NoWrep NS TPICTEFBAA [pc0WlB  (w0x00|-~2zdoe  (BK On [Sm |4 MHZ! [User

Observe a mensagem ao final,
Build Failed. Isto é um indicativo de
que algo errado no fonte néo permi-
tiu a construcdo do arquivo final.

Observando a janela, vemos uma
linha com a seguinte mensagem:

Error[113] C:\Opic\EXEMPLO.ASM 9 :
Symbol not previously defined (PORTAB)

Esta mensagem estd informando
gue na linha 9 o simbolo (label, no-
me, ...) PORTAB néo est4 definido.

IMPORTANTE: Inicie sempre a
andlise de erros pelo primeiro erro
desde o inicio.

Figura 12 - Janela Build Results ap6s erro na compilagao.
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Onde estédo as definicbes relati-
vas aos registros e bits do PIC ?
Selecione

File > View

e abra o arquivo P16F84A.INC na
pasta onde instalou o MpLab (Ex.:
C:\Arquivos de Programas\Mplab).

Veja que la estéo todas as defini-
¢Oes relativas ao PIC 16F84A, como
enderecos das portas, 0 nome pelo
qual o compilador reconhece os bits,
etc. N&o esqueca de fechar o arqui-
vo antes de prosseguir.

Onde estad o erro ?

Em nosso caso, com apenas al-
gumas linhas de cddigo, fica facil a
localizag&o do erro, mas para fontes
maiores (e eles ficardo cada vez
maiores), temos outro meio de che-
gar a linha com o erro.

Va com o cursor para a linha do
primeiro erro, veja a descricdo do
mesmo e entdo dé dois clicks rapi-
dos com o mouse sobre esta linha,
e a janela com o fonte serd mostra-
da por cima da janela Build Results,
€Om O cursor ja posicionado na linha
que gerou o erro.

Basta corrigir e repetir todo o pro-
cesso teclando F10 novamente, até
gue nenhum erro ocorra.

Praticando

Repita este exercicio de criar er-
ros e identifica-los varias vezes, bem
como sair e entrar no MpLab crian-
do outros projetos.

Termine retirando todos os erros
e testes realizados, mantendo o pro-
jeto exemplo.pjt e seu fonte,
exemplo.asm, conforme situagéo ini-
cial.

TRABALHANDO COM

PROJETOS JA EXISTENTES

A principal diferenca que encon-
tramos quando abrimos um projeto
jé existente estd no fato de nao pre-
cisarmos selecionar novamente o
fonte ou ajustar o compilador, bas-
tando selecionar nos diretérios exis-
tentes o projeto desejado.

Para melhor entendimento, feche
0 MPLAB e volte para o Windows,
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respondendo YES para todas as per-
guntas, e volte a iniciar o MPLAB.

O Mplab vai perguntar se vocé
deseja abrir o Ultimo projeto traba-
lhado. Se desejar, apenas click em
Yes. Em nosso caso, click No.

Entéo selecione 0 menu Project
e veja que no rodapé do menu que
se abriu temos 0 nome dos ultimos
projetos em que trabalhamos.

Caso o projeto desejado esteja
indicado, basta dar um click no mes-
mo. Veja a figura 13.

Se o projeto desejado nédo esti-
ver indicado, dé um click no item
Open Project, e teremos uma nova
janela conforme a figura 14.

Escolha o diretério onde esta o
projeto desejado e depois 0 nome do

~ MPLAB

Eie | Pioject Edit Debug PICSTART Plus Opfions Jook Window Help

CukF2

L Pyt . ChisfS:

$iake Fropt Fg |
Hufig Al 10
Hind Hode AF1G

‘ frsteft Language Tool...

1 e:5000vidaf\Oclient\Dherme:s\menker\625\moni_B25.pit
2 ¢:\000vidal\Delient\Dalmirwalvulatyaivula.pit

3 o\000vidahOchentialvaro\picorpmipicorpm. pit

4 c:\Opichestimulo. pit

— _

mesmo, e entdo dé um click em OK
para ter o projeto aberto.

Se uma janela como a da figura
15 aparecer, apenas clickem OK e
prossiga.

O MpLab estd apenas indicando
que seu fonte deve ser (re)compila-
do, pois ndo achou o hexadecimal
do mesmo. Isto pode ocorrer por ter-
mos fechado o projeto antes de ter-
mos retirado todos os erros, por
exemplo.

Neste caso pressione F10 para
compilar e prosseguirmos com o
exemplo.

A partir deste ponto valem as
mesmas regras ja vistas sobre edi-
¢80 do projeto, compilagdo, correcdo
de erros, ...

I 1 IPICISCES2S lpeDW00 w000 -zdcc Bk On Gm 4 MHz User

Figura 13 - Menu “Project” com os Ultimos projetos trabalhados.

Edit [isbug PICSTART Mla 0

2Bl 2] [BE

Birectories:

[emie

estimulo. pjt H15g e
esemplo. pit 29 Opie

¥

List Files of Type:

f {Project Files (~pit) ]

|

o e TS

i | PICIEFBAA [pe0W00  wilalD --zdoc Bk O

Figura 14 - Selecionando projeto j4 existente.
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SIMULAGAO SIMPLES

Veremos agora técnicas para si-
mular nosso programa, desde exe-
cugfo passo a passo até animagao.

Simulando o fonte do projeto
EXEMPLO

Para evitar qualquer problema
devido a agdes erradas que vocé
possa ter realizado, feche o MpLab
e abra novamente selecionando o
projeto EXEMPLO.PJT

Compile teclando F10 e corrija
eventuais erros de digitagio.

Principais teclas para o controle

da simulacéo

F6 RESET
Equivale ao reset da CPU.
Posiciona o contador de
programa no enderego 0000, e
coloca uma barra preta sobre a
linha correspondente.
Esta barra indica “a proxima”
instrugéo a ser simulada.

F7 STEP
A cada toque em F7 o MpLab
executa uma instrucédo do
programa. E como se nosso
processador rodasse uma
instrugéo de cada vez. Se for
mantida pressionada, executara
as instrucbes no intervalo de
repeticdo automatica da tecla.

CTRL + F9 ANIMATE
Roda o programa passo a
passo dinamicamente, tornando
possivel acompanhar
visualmente a seqiiéncia do
programa.

F9 RUN
Realiza a simulagao rapida, sem
atualizar a tela. Ideal para
simular situacdes que tomariam
demasiado tempo na animagé&o.
Apenas a janela StopWatch é
atualizada (veremos mais tarde)

F5 STOP
Interrompe a simulagéo
dinamica iniciada pelo
Ctri+F9 ou pelo F9

No hex file has been built for
this project

R, oy [ PiCiered

pc0A00  [wi0s00 - zdcc  [Bk On [Sim 4 MHz {Debut

Figura 15 - O projeto aberto ainda néo possui um .HEX valido.

Realizando uma simulacéo diné-
mica para testes

Deixe seu projeto com a aparén-
ciaigual & da figura 5. Compile (F10)
e entdo pressione a tecla F6. Vocé
deve obter uma tela como a da figu-
ra 16.Va pressionando F7 e veja que
a barra preta, indicativa da proxima
instrucdo a ser simulada, vai se des-
locando, acompanhando a execugéo
do programa. Pressione Control +
F9 e veja a simulagéo ocorrer dina-

list p=16f84a
radix  dec

include <P16F84a.INC>
org (]

clri PORTB]

bsf STATUS,RPO

clrf TRISB

bcf STATUS ,RPB
loop

incf PORTE, f

goto loop

END

micamente. Para parar, pressione
F5. Veremos a seguir como abrir uma
outra janela que nos mostrara o tem-
po decorrido de simulagéo.

Janela Stopwatch. Vendo o tempo
de execucao
Para abrir a janela Stopwatch,
siga a seqliéncia no menu:
Window > Stopwatch... e ajuste 0
tamanho e a posigdo das janelas
para que fiquem como a figura 17.

fzdce  BkOn[Smi4

F|gura 16 Tela |m<:|a| apos 0 “reset” do processador.
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— MPLAR - CADPICAEXEMPLO.PIT
File F‘rmect Edit Debug PICSTART Hus _pimx Toals Wmdow ﬂeb

Para que a simulacdo ocorra, a
janela exemplo.asm deve ser a ja-
nela ativa, como na figura 17 (basta
dar um click dentro da mesma).

Apbs qualquer ajuste na janela
stopwaitch, veja que as teclas de si-

& < \Opichexempls

list p=16f8ha
radix  dec

include <P16F84a.INC>

mulagéo ndo funcionam, até que a . org 8
i i i Gl PORTE
janela do_ fonte seja selemoqada. "if BT o el )
& LTSI Soeve
Pressione F§ (resef) e vejaque a B | S =
cada F7 prgssmnado 0s camp?s R s Zero ]‘ e e
“Cycles” e “Time” do stopwatch véo gato  laop Pranosso Fronuency | 4000000 Wi

¢ Clear On Reset

Close '

7| WA NoWiep NS [PICIGFBAA |pu:0sdD | wOr00 - ~zdcc  [BKOn (S 4 bz [Usei
Figura 17 - Janela Stopwatch junto & janela exemplo.asm.

se alterando, indicando o nimero de
ciclos e o tempo decorrido desde o
reset (ou desde o ultimo click no bo-
téo Zero).
Experimente
Control+F9.
Pare a simulagdo (F5) e dé um
click no botdo Zero do stopwatch, e
veja que os valores “Cycles” e “Time”
serdo zerados, mas ao voltar a jane-
la do fonte, a simulagcéo pode pros- org
seguir do ponto onde parou.

= ﬂe'p

também com

Al e \Dpic\exempla. sam

list p=16f84a
radix dec

incluc Watch_1
Address Symbol

Esta caracteristica permite-nos ol ' '

. bsf R
determinar o tempo exato de um clrf —16F84A
certo trecho de programa. . bcf o _CP_OFF

loop S o _CP_ON
. incf  PORTB,f -HS_0sC
Observando registros da CPU goto  loop =] -'L,':;F?ng -
durante a simulagédo - |_PWRTE_ON
Além de podermos ver o tempo -RC_OSC
de execugao, podemos observar

como os registros internos se com-
portam durante a execugdo do pro-
grama.

—~ MPLAD - C-\IPIC\EXEMPLY P
!;xb Dluti Edt Qebug PlfAT-:HT F‘u] Lpluun

list p=16f84a
radix dec

inclucyF
fAddress Symbol

arg

bs¢

clrf
bcf

loop AL
incf PORTB, ¥
goto loop

END

¥ mﬁ L!mdm ﬂ

s Stopwatch

Format
=2l

¢ Hexadecimal Decimal
Binary - ASCH
| M Float - ERE Hoat

Size e S rlasa }
+ bt S16bit - 24bit
o 32:bit bit

¥

e

77 [ /R0 [NoWhap NS IPICTGFBAA [po0wd0  widk0

1 Byte Order
I ¢+ Highlew

o Lowigh

Display bits
@ Hirf) > bty C b2 2 20
T obirs © bt B T

[~ 2dd TR DR Bm 4 Mz TS

Figura 19 - Ajustando as propriedades do registro escolhido.
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Flgura 18- In|c1ando a |anela
Watch para ver registros.

No menu selecione a sequiéncia:
Window > Watch window > New
watch window e sua janela ficara
como a figura 18:

Na janela ativa (Add Watch
Symbol), no campo “Symbol:” escre-
va PORTB (os registros do PIC de-
vem ser selecionados em mailscu-
las) e depois click no botdo
Properties. Vocé pode ainda correr
a barra de rolagem vertical e seleci-
onar com o mouse o registro dese-
jado. Sua tela devera estar como a
da figura 19, com uma nova janela

SABER ELETRONICA ESPECIAL N2 3/MAIO/2001



onde ajustaremos as “propriedades”
de visualizagéo do registro selecio-
nado.

Ajuste Format para DECIMAL e
Size para 8 bits, e entdo dé um click
no botdo OK, fechando a janela de
propriedades do registro seleciona-
do.

Veja que ao fechar a janela
PROPERTIES a janela Watch_1 ja
contera a seguinte linha:

Address Symbol Value
06 PORTBD 'O

IMPORTANTE: O valor inicial do
PORTB aqui indicado pode ser dife-
rente do seu!

Para ficar mais facil acompanhar
a simulagéo ajuste o tamanho e a
posi¢do da janela Watch_1 para que
sua tela fique conforme a figura 20.

Se desejar, acrescente outros
registros da CPU e entdo dé um
clique em “Close” para fechar a ja-
nela “Add Watch Symbols”. Faca da
janela exemplo.asm a janela ativa e
divirta-se com os recursos de simu-
lagdo do MpLab.

Com Control + F9 veja o progra-
ma rodando, o tempo decorrido e a
variagdo do PORTB.

Se precisar de maiores detalhes
sobre as possibilidades de simula-
céo, consulte o Help do MpLab, em

e mmn CAOPICAE S TIMULOCRI T

c\pichestmulo.asm

list p=16F84a
radix dec

include <P16F8%4a.INC>

org L]

clrf PORTB

bsf STATUS,RPB
clrf TRISB

bcf STATUS ,RPB

loop
btfss PORTA,8
goto loop
incf PORTB, f
goto loop

END

"""" 718 | (WH INoWisp NG | [PICTGFBAR  (pe0x0 (w0 |-~ zdee

ZTMPLAB - CrVOPICAEXEMPLI.PIT
Flc Prugecl Edit thug PlCiT#HT Plu: Qplwm Tuola

e

list p=16f8k4a
radix  dec

include <P16F84a.INC>
arg [}

clrf PORTB

bsf STATUS ,RPO
clrf TRISB

bef STATUS ,RPB

incF PORTB, f
goto laop

ERD

17 | R

Wil Bt

’Noﬁ?.’aplﬁfmmeram ﬁmm twnam, zdec

address Symbol
86 PORTH

5 Cycles
B i (A
- Time
Pmmtnl Frequency
| v Clear {In Reset

o (BKOR [Sim [4MHz [User

Figura 20 - MpLab com fonte, stopwatch e visualizagdo do PORTB.

Help > MPLAB Help

SIMULANDO SINAIS
EXTERNOS NO MPLAB

Objetivo

Demonstrar a capacidade do
MpLab em simular variagdes exter-
nas nos pinos do PIC.
Procedimento

Inicie o MpLab e certifique-se de

~ value
8'000000008"
p'e '

nddress Symbol
PORTA
PORTB

06

Lo cmo
Time = | Dﬁﬂns

| Processor Fiequency | 4.000000 MHz

i Clear Bn Reset

Bk O [Sim 4 MHz (User

Figura 21 - Projeto e Fonte ESTIMULO prontos.
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que o mesmo estd no modo de si-
mulacéo do 16F84A.

Seguindo os passos ja vistos
para a criagéo de fonte, projeto,
dimensionamento de janelas e simu-
lag&o, crie um novo fonte e um Novo
projeto na pasta c:\Opic de nomes
ESTIMULO.ASM e ESTIMULO.PJT.

Na janela Watch_1 acrescente o
PORTA com propriedade em binario
e o PORTB com propriedade em
decimal.

Neste exemplo o PORTB sera
incrementado somente se RAQ esti-
verem 1.

No fonte, conforme j& visto ante-
riormente, digite (respeitando as
tabulagdes):

list p=16F84A
include <P16F84A.INC>
radix dec

org O

clf PORTB ;iniciaemO
bsf STATUS,RPO ; banco 1
;para ajuste do trisb

clf TRISB ;portb é todo saida

bef STATUS,RPO ;banco 0
loop:

btfss PORTA,0 ; se RAO =1 pula
;1 linha
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[ HPLAR - CATPICESTIMOLD 83T

list p=16f84a
radix dec

include <P16F84a.INC>
org [}

clrf PORTB

bsf STATUS,RPB
clrf TRISB

bcf STATUS,RPO

loop

btfss PORTA, B
goto loop

incf PORTEB,f
gato loop

END

+ Asprchionpus Stimulus Dialog

[FsmT® ] stm2(ry | stm3(P) | Stm4®)

©=l=" low (L) Coloca nivel
‘0’ no pino

i %)
ue

B* 00600080"

e

High (H) Coloca nivel
1" no pino

Toggle(T) Inverte o estado no
pino (inicia
sempre em Q)
e Experimente dar uma fungao di-
ferente para cada botdo e observa o
resultado.

Stim 5 [P) Stim 6 (P) . Stim 7 {P} Stim 8 (P}

Stim § (P} Stim 10 (P} Stim 11 (P} Stim12 (P)

L (o)

Close l Help ‘

IntCol | 18 | WA Nowiop INS PICIGFSA [pcDdid  wisd include <P16F§Ha.INC>

Figura 22 - Botdes de estimulo.

goto loop ; RAO =0, repete
; O teste
incf PORTB,f ; se chegou
; aqui, RAO =1
goto loop ; repete tudo
END

Sua tela devera estar como a fi-
gura 21.

No menu principal selecione:

Debug > Simulator Stimulus >
Asynchronous Stimulus e vocé de-
vera obtera uma janela conforme fi-
gura 22.

Observe que existem 12 “botbes”
com nomes de Stim 1 a Stim 12 e
dentro dos parénteses a letra P

Vamos ver cada ajuste em deta-
lhes.

Com o botéo direito do mouse dé
um click no botéo Stim 1 (P) e vocé
obtera o menu da figura 23.

Observe que a opgéo Pulse esta
selecionada. Esta é a opg¢ao padréo,
indicada dentro dos parénteses
como (P).

As op¢bes para estimulo externo
sdo:
Pulse (P) D& um pulso no pino
selecionado (de 0
para 1 e retorna a 0)
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Value
PORTA B' 00066000"
PORTE D'e

list p=16f84a
radix dec

org [}

clrf PORTB

bsf STATUS,,RPB
clrf TRISB
bef STATUS ,RPO

laoop
btfss PORTA, 0
goto loop
incf PORTS, f
goto loop

- C_vcfesl o |
‘-—;Zf‘:?——j Time‘t !]J]ﬂm 1

| Processor Fl_eq_uencyé - 4.000000 MHz
¥ Clear On Reset

e | sam3P) | Sime@r
Giey | stim7 (P) Stim 8 (P)
6P} | Stm11({P) | SEm12(P)

TWHNG Wiap NS PICIEFBAR [pc0Wl (w000 |-~ zdse 16K On (Sim 4 MHz [User
Figura 23 - Ajustando os botbes de estimulo.

niCal

Address Symbol Value
PORTYA 8'06080080°
PORTB p'e

list p=16F84a
radix dec

include <P16F84a.INC>
org a

clrf PORTB

bs§ STATUS ,RPA
clrf TRISB
bef STATUS ,RPO

loop

btfss PORTA, B
goto loop
incf PORTB, f
goto loop

Cyeles | [}
SR
‘;Zu__-;{ Time | 0.00ns
Processor Frequency | 4.000000 MHz
v Clear On Reset

END Pin Selection

Double click to selact. |

| Agprchioncus §

Stim 1 (P}
Stim 5 (P]
Stim S (P}

Stim 4 (P}
P1 | simBpPy |
Pl | Stm12(P)

718 | W NoWiap INS FICTEFSAS [peBal . w0 -zdoe MRz et
Figura 24 - Ajustando os pinos que receber&o o estimulo.

nTGll
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Como relacionar os pinos do PIC
aos botdes

Observe que a primeira opgdo do
menu é Assign pin....

Selecionando esta opgdo um
novo menu se abre, conforme a fi-
gura 24.

Entéo, para associarmos o botéo
desejado a um certo pino do PIC,
basta dar um duplo click no pino de-
sejado. Como treinamento, faga 0s
seguintes ajustes:

Botdgo 1:  RAO (T)
Botdo 2:  RAT1 (L)
Botdo3:  RA2 (P)

e veja se os botdes ficaram con-
forme a figura 25.

Agora, durante a simulagéo, po-
demos fazer com que sinais exter-
nos sejam aplicados ao PIC e ver
seu comportamento. Basta durante
a simulagdo dinamica (CTRL F9)
clicar sobre os botbes desejados, e
o estimulo associado ao mesmo sera
aplicado ao PIC e o simulador res-
pondera de acordo.

Exemplo com estimulo
Baseado no projeto ESTIMULO.

list p=16f84a
radix dec

include <P16F84a.ING>
org ]

clrf PORTB

bsf STATUS,RPB
clrf TRISB

bcf STATUS,RPB

loop

btfss  PORTA,B
goto loop

incf PORTH, F
goto loop

END

I Azynchronous Slimufus Dialog

RaAt (L) RA2 [Pl

Stim 4 (P}

CE =
Address Symbol Value
a5 PORTA B'B6696068"

06 PORTB p'e

| Z ] Cycles J Rl o
Time 0.00 ns

i | Processor Frequency | 4.00billiﬁ HHz

v Clear On Reset
Ciose ! Help ‘

TRitan T

stm5(P) | StmG(P) Sum7{P) | Stm8(P)
Stm3(P) | Stimi10(P} Stm11(P) | Stmi2(P)
Help [

19 | WA Nowrap INS [PICIGFB46  peOWll w0 --zdoc B

Figura 25 - Botoes de estimulo ja ajustados.

PJT j& pronto, vamos efetuar a si-
mulagdo com estimulo no pino RAQ.

Certifique-se que temos o seguin-
te ajuste: RAO (T)

Apds a compilagdo e eventuais
corregdes, desloque a janela de es-
timulo para um ponto que néo atra-
palhe a visualizag&o dos registros e

faca do fonte a janela ativa.

Tecle CTRL F9 e veja na simula-
¢8o que a instrugéo btfss porta,0ini-
cialmente sempre vé a entrada RAO
emO.

Dé varios clicks bem espacados
no botdo RAO (T) e va analisando o
comportamento do PIC. =

CURSO BASICO DE

TELEFONIA BASICA
DISCO DATILAR
TELEFONES NACIONAIS
MICRO PABX
INSTALAGOES
PROJETO
EQUIPAMENTOS
NORMAS TECNICAS
TELEFONIA CELULAR
CABEAMENTO UTP

KIT PARA MICROCONTROLADORES

8051

Kir para desenvolvimento de protétipos com microcontroladores da ATMEL
compartivel com 80%1/80%1.

Ideal para aprendizagem de Hardware, Linguagem C e Assembler:

. Usa o Microcontrolador AT8958252 (ATMEL) 100% compativel com a familia 8071.
- ProgramAvel No pROpRIO circuito via InTerface Paralela.

- Safda Serial RS272.

- Entrada com chaves Push Burron,

- 8K de mem6ria Flash.

» 2K de meméria E2PROM

- 256 Byres de memoOria RAM

- 32 Poris de 1/O

- Pode ser usado como prROGRAMAdOR.

0,00 s. envio |

0 kit é composto de:

= Placa programadora

= Display LCD 2 linhas

= Documentacao em 2 disquetes
(Ingiés), com exemplos de
programas emassembler e
Linguagem C

= Cabo de programacao (ISP)

=» Instrucdes para instalacéao

SABER MARKETING DIRETO LTDA.
Verifique as instrugBes na solicitagio de compra da Gltima péagina.

Maiores informactes: Disque e Compre (11) 6942-8055 -
Rua Jacinto José de Aratijo, 309 - Tatuapé - Sao Paulo - SP
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Filmes de Treinamento em fitas de video
Uma colegdo do Prof. Sergio R. Antunes
Fitas de curta dura¢do com imagens

Didaticas e Objetivas

*05 - SECRETARIA EL. TEL. SEM FIO...ov v, 26,00
*06- 99/ DEFEITOS|IREISECRYIELS/EI@NSH. ... Lh . L, 31,00
*08 - TV PB/CORES: curso basico............cccvecvenee ... 31,00
*09 - APERFEICOAMENTO EM TV EM CORES........cc.cco.o.... 31,00

*10'- 99'DEFEITOSIDENVEB/COREST NS
11 - COMO LER ESQUEMAS DE TV.....cccovnnerrecnene

*12 - VIDEOCASSETE - curso basico.......... ... 38,00
16 - 99 DEFEITOS DE VIDEOCASSETE .......ooooveeeeereereeeenn, 26,00
*20 - REPARACAO TV/VCR C/OSCILOSCOPIO..... ... 31,00
*21 - REPARACAQ DE VIDEOGAMES..................... ... 31,00

*23 - COMPONENTES: resistor/capacitor......
*24 - COMPONENTES: indutor, trafo cristais..
*25 - COMPONENTES: diodos, tiristores..............cceveviviiecnne 26,00

26 - COMPONENTES: transistores, Cls...........cccoeveuenunin. o S11-100)
*27 - ANALISE DE CIRCUITOS (basiC0).......cccuvveverervrrrnrarnns 26,00

*28 - TRABALHOS PRATICOS~ DE SMD........... .... 26,00
*30 - FONTE DE ALIMENTACAO CHAVEADA............ ... 26,00
*31 - MANUSEIO DO OSCILOSCOPIO........ccccccueurneee .... 26,00

*33 - REPARACAO RADIO/AUDIO (EI.Basica)...
34 - PROJETOS AMPLIFICADORES AUDIO....
*38 - REPARAGAQ APARELHOS SOM 3 EM 1..... ... 26,00
*39 - ELETRONICA DIGITAL - curso bésico...........
40 - MICROPROCESSADORES - curso bésico.
46 - COMPACT DISC PLAYER - curos basico..........
*48 - 99 DEFEITOS DE COMPACT DISC PLAYER... I
*50 - TEC. LEITURA VELOZ/MEMORIZAGAO.......... ... 31,00
69 - 99 DEFEITOS RADIOTRANSCEPTORES.... :

*72 - REPARAGCAO MONITORES DE VIDEO....

*85 - REPARACAO DE

MICROCOMPUTADORES IBM 486/PENTIUM.................... 31,00
*86 - CURSO DE MANUTENGCAO EM FLIPERAMA................ 38,00
87 - DIAGNOSTICOS EM EQUIPAMENTOS MULTIMIDIA........ 31,00
*88 - ORGAOS ELETRONICOS - TEORIA E REPARAGAOQ......... 31,00
*94 - ELETRONICA INDUSTRIAL SEMICOND. DE POTENCIA.... 31,00

Adquira ja estas apostilas contendo uma série
de informacdes para o técnico reparador e estudante.
Autoria e responsabilidade do

prof. Sergio R. Antunes.

GANHE DINHEIRO
COM MANUTENCAO

TITULOS DE FILMES DA ELITE MULTIMIDIA

MO1 - CHIPS E MICROPROCESSADORES
M02 - ELETROMAGNETISMO

MO3 - OSCILOSCOPIOS E OSCILOGRAMAS
MO04 - HOME THEATER

MO5 - LUZ,COR E CROMINANCIA
MO6 - LASER E DISCO OPTICO
MO7 - TECNOLOGIA DOLBY

M08 - INFORMATICA BASICA
M09 - FREQUENCIA, FASE E PERIODO
M10-PLL, PSC E PWM

M11 - POR QUE O MICRO DA PAU
M13 - COMO FUNCIONA ATV
M14 - COMO FUNCIONA O VIDEOCASSETE

M15 - COMO FUNCIONA O FAX

M16 - COMO FUNCIONA O CELULAR

M17 - COMO FUNCIONA O VIDEOGAME

M18 - COMO FUNCIONA A MULTIMIDIA (CD-ROM/DVD)

M19 - COMO FUNCIONA O COMPACT DISC PLAYER

M20 - COMO FUNCIONA A INJECAO ELETRONICA

M21 - COMO FUNCIONA A FONTE CHAVEADA

M22 - COMO FUNCIONAM OS PERIFERICOS DE MICRO

M23 - COMO FUNCIONA O TEL. SEM FIO (900MHZ)

M24 - SISTEMAS DE COR NTSC E PAL-M

M25 - EQUIPAMENTOS MEDICO HOSPITALARES

M26 - SERVO E SYSCON DE VIDEQOCASSETE

M28 - CONSERTOS E UPGRADE DE MICROS

M29 - CONSERTOS DE PERIFERICOS DE MICROS

M30 - COMO FUNCIONA O DVD

M36 - MECATRONICA E ROBOTICA

M37 - ATUALIZE-SE COM A TECNOLOGIA MODERNA

M51 - COMO FUNCIONA A COMPUTACAO GRAFICA

M52 - COMO FUNCIONA A REALIDADE VIRTUAL

M53 - COMO FUNCIONA A INSTRUMENTACAO BIOMEDICA
M54 - COMO FUNCIONA A ENERGIA SOLAR

M55 - COMO FUNCIONA O CELULAR DIGITAL (BANDA B)
M56 - COMO FUNCIONAM OS TRANSISTORES/SEMICONDUTORES
M57 - COMO FUNCIONAM OS MOTORES E TRANSFORMADORES
M58 - COMO FUNCIONA A LOGICA DIGITAL (TTL/CMOS)

M59 - ELETRONICA EMBARCADA

M60 - COMO FUNCIONA O MAGNETRON

M61 - TECNOLOGIAS DE TV

M62 - TECNOLOGIAS DE OPTICA

M63 - ULA - UNIDADE LOGICA DIGITAL

M64 - ELETRONICA ANALOGICA

M85 - AS GRANDES INVENCOES TECNOLOGICAS

M66 - TECNOLOGIAS DE TELEFONIA

M67 - TECNOLOGIAS DE VIDEO

M74 - COMO FUNCIONA O DVD-ROM

M75 - TECNOLOGIA DE CABECOTE DE VIDEO

M76 - COMO FUNCIONA O CCD

M77 - COMO FUNCIONA A ULTRASONOGRAFIA

M78 - COMO FUNCIONA A MACRO ELETRONICA {\\,‘b’
M81 - AUDIO, ACUSTICAE RF >
M85 - BRINCANDO COM A ELETRICIDADE E FiSICA ‘36

M87 - BRINCANDO COM A ELETRONICA DIGITAL

M89 - COMO FUNCIONA A OPTOELETRONICA q? )
M90 - ENTENDA A INTERNET S

M91 - UNIDADES DE MEDIDAS ELETRICAS //Q‘

&

Qi

M86 - BRINCANDO COM A ELETRONICA ANALOGICA QQ ()

Pedidos: Verifique as instrugdes de solicitagdo de compra da tdltima p4gina ou peca maiores informagdes pelo
TEL.: (11) 6942-8055 - Precos Vilidos até 10/06/2001 (NAO ATENDEMOS POR REEMBOLSO POSTAL)
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COMPLETE SEUS
CONHECIMENTOS

102 CIRCUITOS

Autor: Newton C. Braga

o 64 paginas - R$ 4,50
Neste livro, os engenheiros, técnicos,
. “ i estudantes e mesmo hobistas po-
’ dem contar com circuitos bésicos
tanto usando componentes discre-
tos como utilizando blocos fechados na

forma de circuitos integrados, o que lhes economi-
za tempo, dinheiro e até o dissabor de uma configura-
¢do que ndo atenda as suas necessidades.

INSTALACOES ELETRICAS
SEM MISTERIOS

Autor: Newton C. Braga

80 paginas - R$ 9,50

Neste livro, o leitor vai encontrar os pro-
cedimentos que vao desde a simples tro-
ca de um fusivel até a instalagdo com-

pleta de todos os elementos de uma casa

ou ainda a colocagéo de tomadas, ligagdes

a terra necessarias ao correto funcionamen-

to de dispositivos modernos como fornos de
microondas e computadores, além das normas de se-
guranga fundamentais neste tipo de trabalho.

CURSO BASICO DE
ELETRONICA I e Il

Autor: Newton C. Braga
Volume |- 144 péaginas - R$ 8,90
Volume Il - 140 péginas - R$ 9,50
IIIII Nossa miss&o é abrir as portas do mun-
[ os leitores a das o primeiro passo rumo
¥ as profissdes do futuro. Professores e
alunos das escolas de segundo grau agora
¥ devem escolher uma matéria Eletiva pela
nova LDB podem optar por uma que real-
Y mente se enquadra nas necesidades do
mundo atual que é a eletronica e usar este
livro como texto basico para seu aprendizado.

FACA O SEU PEDIDO:

PELO TEL. (11) 296-5333,

ATRAVES DO SITE www.edsaber.com.br ou
preencha o pedido da pagina 79.

PEDIDO MINIMO R$ 25,00 +R$ 5,00 DE ENVIO

CURSO BASICO DE TELEFONIA

Autor: Pedro A. Medoe

128 paginas - R$12,50

Conseguimos reunir neste livro, alguns
asssuntos béasicos da Telefonia em ge-
ral, onde combinamos com algumas pra-
ticas que podem ser desenvolvidas em
alguns casos, para aplicacgéo direta
como produtos acabados, para apli-
cacéo direta como produtos acaba-
dos, onde o leitor podera usufruir
desses equipamentos, bem como
comercializa-los, se for o caso.

MANUTENCAO DE

COMPUTADORES
GUIA PARA FUTUROS PROFISSIONAIS

Autor: Newton C. Braga
104 péginas - R$ 9,90
Saiba como instalar periféricos e fazer
Up-grades, interpretar mensagens de
erros com as possiveis causas e pro-
cedimentos para sanar problemas
de hardware e software. Dicas de
compras de pegas e parte de
computadores, como também
configurar e tomar medidas de
protecdo ao PC.

CURSO DE INSTRUMENTACAO

ELETRONICA - MULTIMETROS l e Il

Autor: Newton C. Braga
Volume | - 88 paginas - R$ 11,50
Volume 1l - 119 péaginas - R$ 12,50
De todos os instrumentos de medidas elétri-
cas, o multimetro é sesm dudvida o que apre-
senta maior nimero de aplicagbes praticas.
No primeiro volume o autor ensina como fun-
ciona o multimetro, como escolher um de
acordo com sua atividade profissional ou
técnica, como usa-lo nas
medidas de grandezas elé- -
tricas bésicas com seguranga e fi-
nalmente como testar uma grande
-\ quantidade de componentes. No se-
% gundo volume ¢é tratado aplicagdes
4 em eletricidade, automoéveis e os
usos avangados na eletrdnica,
além de circuitos praticos para
obter mais de seu multimetro.




FORMULAS UTEIS PARA
CIRCUITOS COM DIODOS

1. DIODO SEMICONDUTOR

Para um diodo semicondutor ide-
al (jungdo p-n) a corrente no sentido
direto depende da tensdo e da tem-
peratura, de acordo com a seguinte
férmula:

Formula 1
Corrente no diodo:

I =Irmax = [e("%) - 1]

Onde:

| € a corrente direta, em amperes (A)
Irmax é a corrente de bloqueio ou
saturacdo, em ampéres (A)

U é a tenséo aplicada, em volts (V)
Ut é o potencial térmico, em volts (V)
e=2,71828

2. RETIFICADOR DE MEIA
ONDA

Este circuito (figura 1) emprega
um diodo e fornece uma tensao DC
pulsada com a mesma freqliéncia da
tenséo AC de entrada. Sao validas
as seguintes férmulas:

Formula 2.1
Tensao média:
- Umax

Uavg = o
Onde:
Uavg é a tensdo média na carga, em
volts (V)
Umax é a tensado de pico ou maxi-
mo, em volts (V)
I1 é a constante 3,1416
Obs.: A queda de tensdo nos diodos (0,2 V
nos de germanio e 0.6 V nos de silicio) nédo
foi levada em conta nesta férmula.
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Férmula 2.2
Corrente média:

Imax

lavg = -

Onde:

lavg é a corrente média na carga,
em amperes (A)

Imax é a corrente de pico AC de en-
trada, em ampéres(A)

I1é 3,1416

Exemplo de aplicacéo:

Determine a corrente média
numa fonte de meia onda onde a
corrente maxima retificada é de 600
mA.

Dados: Imax = 600 mA
I1=3,14
lavg = ?

Usando a féormula 2.2:

600
3,14

lavg = =191,08 mA

Obs.: pode-se usar também Imax em ampé-

res, calculando lavg em amperes.

3. RETIFICADOR DE ONDA
COMPLETA

Corrente e tensdo num retificador
de onda completa podem ser calcu-

Carga

—_—
I

a) Dois diodos

I—— Figura 1
$ 4”01

Tavg 3 o G e - - -Umax

] Uan m.......ﬂ._Uavg
Carga Saida "
Figura 2
X

Tavg

3

\/

b} Ponte

SABER ELETRONICA ESPECIAL N° 3/MAIO/2001



ladas pelas seguintes férmulas: Essa
formulas sdo vélidas tanto para sis-
temas de 2-diodos como para tipo
ponte com 4 diodos. Veja a figura 2.

Férmula 3.1:
Tensdao média:

Uavg - 2xUmax

Onde:

Uavg é atens@o média na carga, em
volts (V)

Umax é a tenséo de pico, em volts
(V)

I1é 3,1416

Férmula 3.2
Corrente média:

|avg = 2ximax

Onde:

lavg é a corrente média na carga,
em ampéres (A)

Imax é a corrente de pico, em am-
péres (A)

I1é 83,1416

Férmulas derivadas:

Formula 3.3
Corrente maxima:
Iméii= Iavgxl'l

Onde:
Imax é a corrente maxima, em am-
péres (A)
lavg é a corrente média, em ampe-
res (A)
I1é 3,1416

Obs.: A queda de tensdo nos diodos néo é
considerada.

Exemplo de aplicacéo:

Calcule a tensao de pico num re-
tificador de onda completa onde a
tensdo média de saida deve ser9 V.

Dado: Uavg =9V
I1=3,14
Umax =?

Aplicando a formula:

_ 9x3,14
-T2

Umax = 14,13 volis

4. COEFICIENTE DE
FILTRAGEM LC

O coeficiente de filtragem é defi-
nido como a relagdo entre a ampli-
tude da componente alternada na
entrada e a amplitude da componen-
te alternada na saida. Atente para
figura 3. Seu calculo pode ser feito
pelas seguintes férmulas:

L

/\/ Uwin CT Uw out
O : lo

\_v'_/

Filtro

Figura 3

Férmula 4.1

Coeficiente de filtragem |
Uwin

o= —

Uwout

Onde:

o é o coeficiente de filiragem

Uwin é a componente alternada na

entrada do filtro, em volts (V)

Uwout é a componente alternada na

saida do filtro, em volts (V)

Férmula 4.2
Coeficiente de filtro Il

a=w?CL-1

Onde:

o é o coeficiente de filtragem

o = (2 x I x f) onde f é a freqUiéncia
da corrente alternada na entrada do
filtro, em hertz (Hz)

C é a capacitancia, em farads (F)

L é a indutancia, em henrys (H)

Exemplo de aplicagéao:
Determine a amplitude da com-
ponente alternada na saida de um
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filtro RC operando na rede de 60 Hz
com uma saida de 12 V. O filtro é
formado por um capacitor de 1 000
UF e um indutor de 10 H.

Dados:

L=10H
C=1000uF=10°F
f=60Hz
Uwin=12V
Uwout = ?

Aplicando a férmula 4.2 para cal-
cular:
0.=[(2x3,14x60)>x 10°x 10)-1] =
1419 -1 = 1418

Calculando Uwout:

12
Uwout = 1418 =0,0014 0ou 1,4 mV

5. COEFICIENTE
DE FILTRO RC

O coeficiente de filtro para um cir-
cuito RC é definido como a relagéo
entre Uwout e Uwin analogamente
ao filtro LC. Figura 4. Sdo usadas as
seguintes férmulas para seu calcu-
lo:

R

,\/ Uw in CT Uw out
N }

—0

\_\/_'_/
Filtro
Figura 4

Férmula 5.1
Coeficiente de filtro:

_ Uwout
%="Uwin

Onde:

o é o coeficiente de filtro

Uwout é a amplitude da componen-
te AC na saida do filtro, em volts (V)
Uwin é a amplitude da componente
AC na entrada do filtro, em volts (V)
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Férmula 5.2
Coeficiente de filtro como fun-
¢ao de RC:

a= V(oxRxCyZ+ T

Onde:

o € o coeficiente de filtro
w=2xIIxfondefé afreqiiéncia de
Vac na entrada do filtro, em hertz.
R é a resisténcia, em ohms (Q)

F é a capacitancia, em farads (F)

6. FATOR DE RIPPLE

O fator de ripple (y) é definido
como a relagdo entre o valor rms da
tensdo de safda e o valor DC da ten-
s&o de saida vezes 100. Veja a figu-
ra 5. A férmula seguinte permite cal-
cular este fator:

Férmula 6.1
Fator de ripple:

y=Urms y 109
Udc
Onde: v é o fator de ripple
Urms é o valor rms da tenséo de
saida, em volts (V)
Udc é a tensdo média da saida, em
volts (V)

Fatores de ripple:

(Carga resistiva)
a) Retificador de meia onda = 120%
b) Retificador de onda completa =
48%

Saida (V) 4

Figura 5

7. INDUTANCIA DO FILTRO

A férmula seguinte é usada para
calcular a induténcia num filtro (figu-
ra 6).

’(}0, CT it

O— > Q

Figura 6 Filtro

Férmula 7.1
Indutancia de filtro:

_1+a
I'_mzxc

Onde:

L é a indutancia, em henrys (H)

o é o coeficiente do filtro
w=2xIIxf, onde f é a frequéncia,
em hertz (Hz)

C é a capacitancia, em farads (F)
Obs.: podemos definir a grandeza
como a eficiéncia do filtro e o seu

TABELA 1 - Caracteristicas de Retificadores (cargas resistivas)

Onda completa Onda
Parametro Meia Onda (transformador com completa
tomada central) (Ponte)
Udc na carga Umax 2 x Umax 2 x Umax
I1 I1 I1
Urms na carga Umax Umax Umax
2 V2! v
Tensé&o Inversa nos diodos Umax 2 x Umax Umax
Ur = (max)
Fator de ripple (y) 120% 48% 48%
Fator de armazenamento 3,49 x Pdc 1,75 x Pdc 1.28 x Pdc
do transformador expresso | (primario e (secundario) (primério e
em relagdo a poténcia de | secundario) 1.23 x Pdc secundario)
saida na carga (primario)

Pdc = poténcia de saida em watts (W)
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valor sera calculado pela seguinte
férmula:

Férmula 7.1a
Eficiéncia:

=1
=2

Onde:
o, é o coeficiente de filtro
7 € a eficiéncia do filtro

8. CAPACITANCIA DE FILTRO

O capacitor de filtro pode ser cal-
culado como funcéo da induténcia de
filtro, da freqliéncia AC e do coefici-
ente de filtro. S0 usadas as seguin-
tes férmulas:

Férmula 8.1
Capacitancia de filtro:

1+0

C= o’xL

Onde:

C é a capacitancia de filtro, em farads
(F)

o é o coeficiente de filtro

o =2xIIxfonde fé a freqliéncia
AC, em hertz (Hz)

L é a indutancia da bobina, em
henrys (H)

Formula Derivada

Férmula 8.2
Capacitancia de filtro Il

Onde todas as grandezas séo as
mesmas da férmula anterior exceto
M, que é a eficiéncia do filtro.
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9. DOBRADOR DE TENSAO
CONVENCIONAL

A figura 7 mostra o circuito de um
dobrador de tenséo. A tenséo de tra-
balho dos capacitores (minima) é
calculada pela férmula seguinte:

Férmula 9.1
Dobrador de tensao:

Uc1 = Uc2 = Umax

Onde:

Uc1 e Uc2 séo as tensdes de traba-
lho dos capacitores, em volts (V)
Umax € o valor de pico da tenséo
AC de entrada, em volts (V)

Obs.: 0 minimo PIV dos diodos é 2
x Umax

10. DOBRADOR DE TENSAO
EM CASCATA

Este circuito emprega dois diodos
e capacitores e as tensdes de traba-
Iho séo calculadas pelas férmulas
dadas a seguir. Observe a figura 8.

Férmula 10.1
Dobrador de tensdao em Cascata:
Uct =Umax Uc2 =2 x Umax
Onde:
Uc1 and Uc2 s@o as tensdes de tra-
balho dos capacitores, em volts (V)
Umax é o valor de pico da tenséo
AC de entrada, em volts (V)
Obs.: o PIV dos diodos e 2 x Umax
(minimo).

11. DOBRADOR DE TENSAO
EM PONTE

A figura 9 mostra uma configura-
¢édo usando 4 diodos com a tenséo
de saida duas vezes maior que a
tensé&o de entrada.

Férmula 11.1
Tensdo nos capacitores:
Uc1 = Uc2 = Umax

U = Umax sen wt

IDQ

Y,

O

Figura 7 J:
Dy C1
U = Umax sen wt Carga
"\ = T i
o l ;
Figura 8
{ D4
Cq
°—| D— =g Carga

Onde: Uc1 e Uc2 séo as tensbes
minimas de trabalho dos capaci-
tores, em volts (V)

Umax é o valor de pico da tenséo de
entrada em volts (V)

Obs.: 0 minimo PIV dos diodos é 2
x Umax.

12. TRIPLICADOR DE ONDA
COMPLETA

O circuito da figura 10 é de um
triplicador por de tensdo. Os compo-
nentes sdo calculados da seguinte
maneira:

Férmula 12.1
Tensao nos capacitores:

Uc1 = Uc3 = Umax
Uc2 = 2 x Umax

Onde: Uc1, Uc2, Uc3 séo as tensbes
minimas de tabalho dos capacitores,
em volts (V)

Umax é a tenséo de pico de entra-
da, em volts (V)

13. TRIPLICADOR DE TENSAO
EM CASCATA

No circuito da figura 11 a tenséo
de saida é o triplo da tenséo de en-
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trada. As caracteristicas dos capaci-
tores sdo dadas pelas seguintes for-
mulas:

Foérmula 13.1
Tensao nos capacitores:

Uc1 = Umax
Uc2 = Ue3 = 2 x Umax

Figura 9

O
U=Umax sen wt
D1

U = Umax sen wt

o}

Figura 10
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Co Cargal

—
FDz

Gy
I L
*C
U = Umax sen wt
D1

o—

Figura 11

Onde:

Uct, Uc2 e Uc3 sdo as tensbes mi-
nimas de trabalho dos capacitores,
em volts (V)

Umax é o pico da tenséo de entrada
AC, em volts (V)

Obs.: Minimo PIV dos diodos 2 x
Umax.

14. QUADRUPLICADOR DE
TENSAO DE ONDA
COMPLETA

A figura 12 mostra um quadru-
plicador de tenséo usando 4 diodos.
A tensdo minima de trabalho dos
capacitores é calculada pela seguin-
te formula:

Férmula 14.1
Tensao nos capacitores:

Uc1=Uc2=Uc3=Uc4= 2 x Umax

Onde:
Uct, Uc2, Uc3 e Uc4 sdo as tensdes
minimas de trabalho dos capaci-

Dy
%
—
Ol D2 S
©
o o
U = Umax sen wt
Ca D3
o] =
D4
Figura 12

tores, em volts (V)

Umax é o pico da tens8o de entrada
AC, em volts (V)

Obs.: Minimo PIV dos diodos usa-
dos é 2 x Umax.

15. DIODO ZENER

As férmulas dadas a seguir s&o
usadas nos célculos com circuitos
que usam diodos zener como 0 mos-
trado na figura 13.

Férmulas 15.1
Corrente maxima através de
um diodo zener:

Uin(max) - (U_ + Rxl,)

Iz(max) = .
Iz(min) = Yin(min) - FSUL +Rxl))
Onde:

Iz(max) é a maxima corrente no
zener, em ampéres (A)

Iz(min) € a minima corrente no zener,
em ampéres (A)

Uin(min) é a tens&o minima de en-
trada, em volts (V)

Uin(max) é a tensdo maxima de en-
trada, em volts (V)

U, é atenséo de saida, em volts (V)
I é a corrente de saida, em ampe-
res (A)

R é a resisténcia, em ohms (Q)

Férmulas 15.2
As férmulas a seguir sdo para
calcular a faixa de valores de R.

Uin(max) - U,
Iz(max) + 1,

R(min) =

Uin(min) - U,

B S o) ]

Onde:

R(min) é o menor valor de R, em
ohms (Q)

R(max) é o maximo valor de R, em
ohms (Q)

Uin(max) é a méxima tenséo de en-
trada, em volts (V)

Uin(min) ié a menor tensdo de en-
trada, em volts (V)

Iz(min) & a menor corrente no zener,
em ampéres (A)

Iz(max) é a méxima corrente no
zener, em ampéres (A)

U, é atenséo na carga, em volis (V)
I, é a corrente de carga, em ampe-
res (A)

Formula 15.3
Corrente maxima no zener:

Iz(max) = P(max) / Uz
Onde: Iz(max) é a corrente maxima
no zener, em ampeéres (A)

P(max) é a dissipagdo maxima do
zener, em watts (W)
Uz é a tensdo zener, em volts (V)

Formula derivada:

Férmula 15.4
Dissipacdo maxima do zener:

P(max) = Uz x Iz(max)

Onde: P(max) é a poténcia maxima
dissipada pelo zener, em watts (W)
Uz é a tensdo zener, em volts (V)
Iz(max) é a corrente maxima atra-
vés do zener, em amperes (A)

Exemplo de Aplicacao:

Uma carga de 20 mA deve ser
alimentada com uma tensdo de 9 V
estabilizada. A tensdo de entrada do
regulador pode mudar entre 12V e

Figura 13

o= & if==dy T ll,_

Uin l UL []RL
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15V e a corrente através do zener
deve ser mantida entre 10 e 50 mA.
Calcular o valor de R. Figura 14.

Dados:

|, =20 mA
U=9V
Uin(max) =15V
Uin(min) =12V

Iz(max) =50 mA =0.05 A
Iz(min) =10 MA =0.01 A

a) Calculando R(min) e R(max):

Rminy=_ 159 - 6 _ o000
0,05-0,02 0,03

R(max) =_12-9 _ 3 _ 0Q
0,02-0,01 0,01

Podemos adotar 220 ohms, uma
vez que se trata de valor padréo den-
tro da faixa calculada.

b) Determinando a poténcia
dissipada:

P(max) = 0.05 x 9 = 0.45 watts

Um diodo zener de 1 W é reco-
mendado para esta aplicagéo.

16. DIVISOR DE TENSAO
CAPACITIVO

A reatancia capacitiva de um
capacitor pode ser utilizada num re-
dutor de tens@o a partir do qual pode-
se projetar fontes sem transforma-
dor como a mostrada na figura 15.
Supondo uma carga resistiva pode-
mos calcular R e C com as seguin-
tes formulas:

o il
T(Z) (Xc) T
Uin U R
v
3 4
Figura 15
Férmula 16.1
Calculando R:
R=_Y_

R ~ IL-20mA
; T
Uin (max) =15V Y2 u
= L=9V []
Uin (min) =12 V
I El l
e <
Figura 14
Onde:

U é a tensdo na carga, em volts (V)
| é a corrente na carga, em amperes
R é a resisténcia de carga, em ohms
Obs.: U e | sdo valores médios
quadraticos (rms).

Férmula 16.2
Impedancia:
7= Ulin

Onde:

Z é a impedancia do circuito, em
ohms ()

Uin é a tensao de entrada, em volts
| é a corrente total na carga, em
amperes (A)

Férmula 16.3
Reatancia capacitiva:

Xc=NZ2-R?

Onde:

Xc é a reatancia capacitiva do
capacitor usado, em ohms

Z é a impedéancia do circuito, em
ohms (Q)

R é a resisténcia de carga, em ohms
Q)

Férmula 16.4

C= 10¢
2xJIIx fxXe

Onde:

C é a capacitancia, em microfarads
(WF)

I1é3,1416

f éafreqiiéncia da rede de energia,
em hertz (Hz)

Xc é a reatancia capacitiva, em ohms
(Q)
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Exemplo de aplicacao:

Determine a capacitancia de C no
circuito mostrado na figura 16 de
modo a alimentar uma I&mpada de
12 V x 50 mA a partir da rede de
energia de 127 VCA (60 Hz).

Dados:

Uu=12V
Uin=127V

| =0.02 A (20 mA)
f=60Hz

C=7?

a) Calculando R

12

R="02

= 600 ohms

b) Determinando Z

127

Z= 0,02

=6 350 ohms

¢) Agora, Xc pode ser calculado:

Xc = (6350)2-(600)2

Xc =v40,3 x 108 - 0,36 x 10°
Xc =v39,94 x 108

Xc=6319 Q

Encontrando C:

108
C= 5x3.14x60x6.319

el 0P | 0
C= %377 x10°
1
C=_1_
2377

C = 0.47 pF ou 470 nF, que é o
valor mais préximo.

T (EZ) 12V
117 Vac 50 mA

Figura 16

Sil
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CIRCUITOS

1. Regulador Chaveado
tipo “Step-Down”

O regulador de tensédo chavea- g
do apresentado na figura fornece

+7a LM2575-
uma tensao de saida de 5V a par- 32V 5.0 2
tir de tensdes de entrada de 7 a M +5V
32 V com corrente de até 1 am- 100 yF J: -E 330 mH
pére. O LM2575 (ou LM2576) da I 100
National Semiconductor pode ser 1N5822 I
encontrado com tensdes de sai-
da de 5, 12 ou 15V e com tipos
ajustaveis. O LM2576 ¢ indicado para correntes de até 3 A. Nos dois casos, com

correntes de 1 ou 3 A, o circuito integrado precisa ser dotado de um bom radia-
dor de calor. A eficiéncia do circuito na conversédo de tensdo é de 80 a 90%.

-

2. Chave de Estado
Sélidode 1 A

O circuito ilustrado na figura Vin 0+45a26V
é sugerido pela National O
Semiconductor e indicado para _I—I_ 5 1 =
o controle de solendides em I
automatismos, eletronica auto- Wloaic oo b l
1nF

10 nF

motiva e mecatronica a partir de Solenéide
sinais l4gicos. Sua corrente ;5
quiescente é de apenas 10 YA o I l
e cargas de até 1 A podem ser

controladas. Ele apresenta ain- o Proteg&o
da uma saida de erro que for- Emo 4
nece um sinal quando ocorre um aviso _E
curto-circuito na carga, sobre-

carga ou ainda uma inversdo acidental de bateria. O circuito é projetado para

suportar transientes de até 80 V e pode ser alimentado com tensbes de 4,5a 26 V.
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6. Circuito de

Amostragem e Retencéao

Os circuitos de amostragem e Saida o -
retencdo sdo usados em conver-
sores analégicos para digitais e
em algumas outras aplica¢des
gue envolvem a retencdo da am-

100 kQ

LM101A Y

sistor de efeito de campo na en-
trada correspondente. O amplifi-
cador operacional garante uma

plitude de um sinal por um deter- 3 1T
minado tempo. O comando da Entrada O———
amostragem é feito por um tran- 91 kQ

30 pF

Amostragem

e

+Vs

100 nF
L

alta impedéancia de entrada para o circuito, devendo o mesmo ser alimentado por uma fonte simétrica. Os
transistores de efeito de campo podem ser de tipos comuns de juncéo tais como os BF245. Observe a figura.

7. Oscilador Triangular

O circuito integrado 4136 con-
siste de amplificadores operacio- (1)
nais do tipo 741 num mesmo in- o
vélucro podendo, portanto, ser :— 4136 140k 1,4 kQ (2)
substituido pelos equivalentes em
involucros separados.

Sua fonte de alimentagéo deve
ser simétrica e os potenciémetros l
ajustam a freqiéncia e a
linearidade do sinal. O capacitor ol

10 kQ 1 MQ

1k

100 nF

4136

p———-0 Vs

C, determina a faixa de frequén- —1

cias gerada pelo circuito que, no
caso, estard com um valor centralizado em torno de 1 kHz. Veja a figura.

13. Campainha de

Extensao

150 Q
—

Com este circuito é possivel 4x
usar um buzzer DC (néo trans- 1N4148

dutor) como extenséo de cam- Linha
painha telefénica. Os diodos

podem ser substituidos por
equivalentes e o zener é de

4,7V. O capacitor de 10 uF deve —
ter uma tenséo de trabalho de \so 10 pllﬂ-I
pelo menos 12 V. Acompanhe a
figura ao lado.

47 v

[]l=z

SABER ELETRONICA ESPECIAL Ne 3/MAIO/2001

55




19. Medidor de
Intensidade de Campo

Um MOSFET de porta dupla é gvi
usado neste circuito, que aciona 3
um medidor de bobina mével de
100 pA ou préximo disso. O medi- 10 100t
dor, em alguns casos, deve ser do- 100 kQ -
tado de um resistor de 1 k ohms 1N34/1N60
para limitar a corrente. A bobina
depende da faixa de frequéncias T
na qual o circuito iré funcionar. Para = 4
afaixa de 80 a 110 MHz, por exem-
plo, esta bobina podera ser forma-
da por 4 espiras de fio 28 em for- 47 kQ
ma de 1 cm de didmetro sem nu-
cleo. A antena é do tipo telescopi-
co com 40 a 80 cm de comprimento. O diodo deve ser de germéanio e o ajuste do ponto de funcionamento
é feito no trimpot de 47 k ohms. O circuito é alimentado por uma pequena bateria de 9 V. Observe a figura.

100 nF

H

100 pA

20. Oscilador TTL
de 1 MHz

O circuito TTL apresentado na 2 1 O 5V

. . —
figura gera um sinal retangular de 10 kQ
” JUL

1 MHz dependendo do ajuste do
74LS04

trimmer de 20-200 pF. FreqUénci-
as mais baixas podem ser gera-
das com o uso de um capacitor fixo

de menor valor. O circuito € eihme'n- PR A

tado com 5V e outras fungées in- — ‘2—5;‘9
versoras disparadoras Schmitt po- 22k /I'P )

dem_ ser efnpregadas na mesma 20-200 pF
configuracdo, a qual pode ser ex-

perimentada com circuitos CMOS elevando-se para 100k ohms os valores dos resistores usados.

HI

5. Flip-Flop Com
Operacionais

100 kQ 100 kQ
| 1

. | ) | N
Na figura ao lado mostramos
como dois amplificadores ope-

racionais podem ser usados - =

para formar um Flip-Flop tipo RS Qo— ———0 Q

de excelente desempenho. & 4
As fontes de alimentagéo

d?vem ser de acordo com aten- 22 kQ 22k

sao desejada na saida. As po-

laridades dos sinais de SET e

RESET devem ser observadas. RST SET
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9. Divisor Para Bateria ,

Com este circuito é possivel Entrada
obter uma tensao intermedidria +12V
de 6 V a partir de uma bateria
de 12 V com uma corrente da
ordem de 1 A. Ele pode ser usa-
do para implementar uma fonte 1 nF-L lf
simétrica no carro ou em outras
aplicacées semelhantes. O cir- I 10k
cuito integrado de poténcia deve
ser montado num radiador de

calor. A divisdo da tensdo depende da preciséo dos resistores de 10 Q
empregados na entrada de referéncia deste circuito. Veja a figura.

10kq LT1010 100 nF

08=6V

10 nF

HH—

16. Base de Tempo CMOS

Este circuito gera sinais de 50,

100 e 200 Hz a partir de um cris- O5/15V
tal de 3,2768 MHz e tem saidas
compativeis com légica CMOS. 200 Hz 100 kHz
O trimmer serve para ajustar o
ponto ideal de partida para o
oscilador em funcao do cristal
usado. QOutras freqUéncias po-
dem ser geradas dependendo do XTAL - P16 T [ Jo
cristal empregado. A alimenta- 20 pF'—ID
¢80 pode ser feita com tensdes e
entre 5e 15V e o limite de ope- I
racéo para o cristal esta em tor-

no de 4 MHz. Observe a figura.

3-30 pF XTAL = 3,2768 MHz

10. Luz de Emergéncia

O sensor deste circuito é um & G
transistor 2N3055 do qual tenha 10kQ
sido retirada a tampa do invélu- e
MQ

012V

cro de modo a expor a pastilha
de silicio a luz. Quando a luz dei-

xa de incidir sobre o transistor —> Rl - !

2N3055, ele comuta 0 BD135 ou -

equivalente, e a lampada de car- 2N3055 Iy

ga é acionada. 500 mA
O ajuste do ponto de disparo

em funcgéo da intensidade da luz

incidente no sensor é determinado pelo ajuste do trimpot de 1 Mohms. O circuito admite
lampadas de até 500 mA e o BD135 deve ser montado num radiador de calor. O resistor
de 10 k ohms também pode ser alterado em fungédo da sensibilidade. Acompanhe a figura.
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14. Buzzer

O circuito mostrado na figura é 1 4093 14 +3/15V
ideal para produzir bips ‘ l ‘“_)3 A
intervalados num transdutor 5 “_
piezoelétrico com um consumo 2
muito baixo de corrente e alimen- ) — ‘ g 7
tacdo que pode variar entre 3 e 1 MO
15 V. O resistor de 1 M determina p—
a intermiténcia e pode ficar entre 1 pF e - 'R_1r —_
220 k ohms e 4,7 Mohms. O resis- _-|_ ol 47kQ __L
tor de 47 k determina a frequén- I

cia e pode ficar entre 10 k ohms e
220 k ohms.

Os valores mais elevados levam a sons mais graves. Com o uso de um transistor de poténcia este
circuito pode excitar pequenos alto-falantes, mas neste caso 0 consumo serd bem maior. Observamos
que alto-falantes de baixa impedéncia ndo devem ser ligados na saida deste oscilador diretamente.

4. Diferenciador para
Transicoes Negativas

O circuito sugerido na figura 1nF
ao lado diferencia o sinal a par- l lz
tir da fronte negativa de um si-
nal retangular. Para o circuito in- :100 KQ
dicado a constante de tempo é
:je 0,22 ms dependendo dos va- 2,2nF AO o Vo
ores dos componentes usados, _LJ_ I o]
e a tensdo de saida é de 7 Vdc.

O circuito emprega qualquer

amplificador operacional de uso T=022ms
geral e deve ser alimentado por Vo =7 Vdc
uma fonte simétrica de 15 V. +15V

8. Oscilador de 20 MHz

Este oscilador utiliza um tran- o+5V
sistor de uso geral que pode ter +5V 100 nF
como equivalentes os BC548, I TkQ
BF494 ou 2N2222 e gera um Z(IIT]‘}'- oA
sinal determinado pela frequién- 2,2kQ 1 l N

cia do cristal.
Os dois diodos s&o de uso 268
geral e a tensdo de alimentacéo
éde5V.Ostrés capacitores%e— 100 PF o
vem ser ceramicos. Outras fre- I
gléncias na faixa de 1 a 20 MHz
podem ser geradas pelo mes-
mo circuito. Observe a figura.

33 kQ

58
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37. Pisca-Pisca com

FET de poténcia

Lé&mpadas incandescentes . o +6/12V
de até alguns ampéres podem
ser colocadas para piscar com iMQ
este circuito. A frequéncia de- 8 2 6/12V
pende do capacitor C que pode
ter valores entre 100 nF e 10 pF.
O transistor de efeito de campo
de poténcia admite equivalentes Iy 2 Pee IRF640
e deve ser montado em radia-
dor de calor.O resistor de 1 M L

C

pode ser substituido por um "
potencidmetro de mesmo valor _L

em série com um resistor de I

10 k ohms para termos um ajus-

te de frequéncia. O 555 também admite como seu substituto o CI CMOS 7555. Veja a figura.

38.DuploT

612V

O oscilador de duplo T mostra-

HE-

do na figura gera sinais senoidais 100 kQ 100 kQ 56 KkQ

na faixa de dudio, que dependem {1 .

devem manter as relagdes de ISk, ’\/\’
valores indicadas.

cilagdo. Para os valores indica- I I 1 . | I"—‘ BC548

dos o sinal gerado estara em tor-

dos valores do duplo T, os quais
O trimpot ajusta o ponto de os- 220 nF 220 nF
no de 1 kHz. 47kQ

39. Relé LDR

-G -0+ 6/12V

No circuito mostrado na figu-
ra ao lado o relé é ativado quan- 1 MQ
do a luz deixa de incidir no K1
sensor, que é um LDR comum. ~
O trimpot de 1 M faz o ajuste de 1N4148
sensibilidade. Relés de 50 a 100 10k
mA para 6 ou 12 V podem ser
usados neste caso. LDR BC548
Maior sensibilidade e diretivi-
dade para o LDR podem ser ob-
tidas com a sua montagem num
tubo com uma lente.

H
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15. Gerador de Ruido
Branco

Aplicados a um amplificador
de audio os ruidos brancos po-
dem ser empregados como
relaxantes, uma vez que lem-
bram o ruido do vento, da chuva
ou do mar.

Um circuito modulador pode
fazer a imitagdo das ondas com
maior efeito realistico. Os ruidos
brancos também séo usados em
testes de equipamentos de tele-

- 0+9a20V
1°"QE 100 nF
I—W
s

1 MQ¢
‘ BC549
E
Q1 B
c
NC

comunicacdes e instrumentos musicais eletronicos. O som de prato, por exemplo, € obtido com um
gerador de percussao acoplado a um gerador de ruido branco de modo a haver a mistura de seus
sinais. Na figura mostra temos um gerador simples de ruido branco que aproveita o ruido térmico
gerado na jungéo base/emissor de um transistor de uso geral (qualquer um de silicio para Q,).

34. Amplificador
de Uso Geral

Este amplificador produz al-
gumas centenas de milliwatts de
audio sobre uma carga de 4 ou
8 ohms e pode ser alimentado
por pilhas comuns. Seu ganho
e impedéncia de entrada sdo su-
ficientes para torna-lo atil como
etapa de audio de projetos
como transceptores, radios ex-
perimentais, etc. O LM386 é um
circuito integrado da National

Entrada

10 kQ

Semiconductor. O potencidmetro na entrada atua como controle de volume. Observe a figura.

0+6V
100 pF
3pd -|-
LM386
L fee L
6
e 220 yF
47 nF
4/8 Q

26. Biestavel CMOS

®-

O circuito mostrado na figura
permite que um interruptor de
pressao seja usado para ligar e
desligar uma carga numa agao
biestavel, que é ajustada no
trimpot de 47 k ohms para maior
sensibilidade.

O capacitor de 1 pF deve ser
de poliéster e as outras portas
do 4093 podem ser empregadas
em aplicagbes independentes. A
tenséo de alimentagéo deste cir-
cuito pode ficar entre 5 15 V.

47 kQ

O+

s
i

o[ ]
P

L
s

1 pF

60
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29. Opto-Acoplador i

O opto-acoplador da figura *

usa transistores comuns e um
fototransistor para acionar um 12V — FT
relé sensivel (20 a 50 mA) para 200 mA
a tenséo de 12V. BC548
O circuito consiste de uma
etapa Darlington em que prati- K1
camente qualquer fototransistor
pode ser empregado. A lampa- 1N4148 o
da depende apenas da intensi-
dade de luz a ser aplicada ao

fototransistor e da distancia em
que ela deve ser posicionada.

0 12V

30. Controle TTL de LEDs

O circuito ilustrado na figura

+ 0+5V
permite controlar um LED a par-
tir de uma saida TTL, que no 3,9k Ll
caso é uma porta AND. Quando g e
as duas entradas estiverem no K BC548
—t
—

nivel alto, o transistor conduz ali-

mentando o LED. O circuito pode

ser alterado para excercer fun- Eao H
¢Oes de portas Opticas de outras 1N4148
tipos com a associagéo de ou-

tras fungdes na entrada como, por exemplo, inversores.

17. Regulador 78XX

Os circuitos integrados regula- 1N4002

dores de tenséo da série 78XX T ” 1 78XX |3 XX
podem ser encontrados com ten-
sdes de 5V (7805) a 18 V (7818) A, iL

com correntes de saidade 1 A. O 100 nF
transformador usado deve ter uma I
tensdo um pouco maior que a de- N
sejada na saida conforme o regu- 1N4002
lador escolhido, e deve ter corren- =000 WF

te de 1 A ou menos, se a saida I

assim o exigir. O circuito integrado

regulador de tensdo deve ser montado num radiador de calor. A tens@o de isolamento do capacitor eletrolitico
antes do regulador precisa ser pelo menos 7% maior que a tensdo RMS do transformador empregado. Lem-
bramos que os circuitos integrados da série 79XX tém uma pinagem diferente das encontradas nos 78XX que
possuem o terra como terminal central. O layout da placa deve ser considerado neste caso. Veja a figura.
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22. Oscilador
Multifreqiiéncia

A fregliéncia basica deste cir-
cuito é determinada pelo
capacitor de 470 nF e pelo ajus-
te do tfrimpot de 47k ohms, po-
dendo alcangar um méaximo da
ordem de 4 MHz. Esta freqlién-
cia sera dividida por poténcias de
2, conforme mostrado na figura,
obtendo-se sinais retangulares
nestas saidas. A alimentagéo do
circuito pode ser feita com ten-
sbes de 5 a 15 V. Uma aplicagdo
deste circuito € como padrdo de
frequiéncia ou num projeto de ge-
rador de fungdes onde os sinais
de saida, que séo retangulares,
podem ter sua forma de onda
alterada conforme a aplicagdo.

470 nF

O 64f

‘ 47 kQ

10kQ

4,7 kQ

9

—0 32f

O 161

O 4f

11

———————0 f

12. Opto-Acoplador Linear

O opto-acoplador MOC5010
da Motorola tem em seu inte-
rior um amplificador completo no
sensor, possibilitando a elabora-
cdo de um acoplador linear de
sinais que permite operar na fai-
xa de audio. Ele usa na entrada
um FET de jungédo comum para
acoplar o sinal de entrada e pode
ser alimentado com tensbes de
12 V.

O capacitor C deve ser esco-
Ihido de acordo com a impe-
dancia de entrada da etapa na
gual o sinal vai ser aplicado de

1|JF

IN>—

]

+12VT ‘—0+12V
1

1 MQ

c
% J}—osaica

o =
Q
o
306

(3}

L
BF245

100 Q

modo a possibilitar um bom acoplamento. Acompanhe a figura ao lado.

36. Potenciometro
Eletronico

O circuito ilustrado na figura pode ser usado para controlar a
velocidade de pequenos motores de corrente continua ou o brilho
de lampadas incandescentes. A tenséo de entrada pode ficar entre
6 e 20 volts e a corrente maxima controlada é da ordemde 5A .0
transistor 2N3055 deve ser montado em um bom radiador de calor.

2N3055

o
Vent

1kQ
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33. Transmissor de TV

O circuito apresentado na fi-
gura gera um sinal entre 50 e 100
MHz podendo, portanto, ser cap-
tado nos canais baixos da faixa
de VHF de um televisor.

O sinal pode ser modulado por
um tom externo de audio aplica-
do & base do transistor ou usado
da forma indicada (sem modula-
¢80), produzindo assim uma ima-
gem sem detalhes. O circuito
quando utiliza uma antena de 20
a 30 cm tem um alcance que
pode chegar a uns 50 metros. A
alimentacdo pode ser feita com
pilhas ou bateria comuns.

o+6/9V

#10nF

22 kQ

7,

L4

—

10 kQ2

4,7 pF
BF494

1000

32. Gerador de Ruido Rosa

O ruido rosa é usado em ins-
trumentos musicais, testes de
equipamentos de telecomunica-
¢bes e em outras aplicagoes.
Trata-se de um ruido cuja inten-
sidade ndo se mantém constan-
te ao longo do espectro. Este
gerador usa o ruido térmico na
juncdo emissor/base de um
transistor comum para obter o
sinal. O corte das freqliéncias
mais altas que caracterizam

470 kQ

2N2222

100 nF

1 kQ

09a15V

10 kQ

330 kQ 47 nF

O Saida

1k

NC

este tipo de ruido, é feito pelo capacitor de 22 nF.

2N2222

E 22 nF

28. Disparo de SCRs
por Fototransistor

O circuito da figura é sugeri-
do pela Texas Instruments para
o disparo de um SCR sensivel a
partir de um fototransistor.

O resistor de 2k2 pode ser al-
terado em fungéo da sensibilida-
de do fototransistor usado e do
préprio SCR. Para cargas in-
dutivas ligue um diodo em para-
lelo. A tens@o de carga depende
exclusivamente do SCR usado.

TIL67

+10V

+Vee

Carga

SCR

2,2kQ

H

1nF
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40. Sirene de Poténcia

Este circuito é indicado para
aplicagbes em alarmes geran-
do um tom intermitente de alta
poténcia num alto-falante co-
mum. A alimentagdo pode ser
feita com 6 ou 12 V e o transis-
tor de poténcia admite equiva-
lentes. Este transistor deve ser
montado em um bom radiador
de calor. A intermiténcia pode
ser alterada pela troca do
resistor de 1 M, enquanto que
o tom gerado depende do valor

+6M12V
? -0

Cl = 4093

5, g 114 480

Iwo nF

IRF
640

correspondente do resistor de 47 k ohms, que também podera ser trocado. Veja a figura.

35. Oscilador de Bloqueio

O oscilador que mostramos
na figura pode gerar sinais de
algumas dezenas de quilohertz
até aproximadamente 10 MHz
dependendo das bobinas L, e
L,. Nas aplicagdes praticas L,
tem 1/5 das espiras de L,. Para
gerar sinais em torno de 1 MHz,
L, tem 100 espiras de fio 22 num
bastéo de ferrite de 1 cm de di-

+6V

10 KO 10 nF

HI

ametro e L, consiste em 20 espiras do mesmo fio no mesmo bastdo so-
bre L,. Um capacitor variével pode ser ligado em paralelo com L, para
ajustar a freqiiéncia. Se o circuito ndo oscilar, inverta uma das bobinas.

3. Filtro Eliptico de 60 Hz

O circuito integrado LMF90 da National Semiconductor con-
tém todos os elementos para a elaboragéo de um filtro de 60 Hz

J—-—o -5V
2| e‘| 100 NF gube
'JLE -

controlado por cristal. Sua freqliéncia central é fixada por um Q—'-OOUT
cristal e pode ficar entre 0,1 e 30 kHz.

A precisdo maxima garantida é de 1,5% e existe a possibili- 14
dade de programar a largura da faixa de rejeicéo e atenuagéo,
além de outras. A alimentagdo pode ser feita com fontes sim- 10
ples ou simétricas, de 4 a 15 V. A atenuagéo é selecionada na
faixa de 39 a 48 dB (tip). O cristal para a freqliéncia indicada é
obtido de televisores em cores e, portanto, de facil obtengéo.

Veja a figura ao lado.

1
LMF90

e
s TN

3,579545 MHz

IlL .3-L13L7 —0 +5V
100nFE
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25. Fonte Simétrica

A tenséo desta fonte simé-
trica depende dos circuitos in-
tegrados reguladores, que po-
dem ser os 7806, 7809, 7812
ou 7815 para tensdes de 6, 9,
12 e 15V respectivamente do
lado positivo, sendo usados os
79XX equivalentes do lado ne-
gativo. O transformador deve
ter um secundério com uma
tensdo pelo menos 2 V maior

Pt

D1

‘l‘ 78XX
D2 T 1000 (F

+ VXX

§

10 PF

1000 F

Lk
1

79XX

do que a exigida na saida e corrente de até 1 A. Os circuitos integrados precisam ser monta-
dos em radiadores de calor e os capacitores eletroliticos devem ter tensées de trabalho pelo
menos 70% maiores que a tensdo do secundério do transformador. Acompanhe a figura.

k—l[l—b—l

o0V

10 |JF

- VXx

11. Teste de Fadiga Visual

Este circuito simples permite testar a fadiga visual pela capacida-
de que se tem de detectar freqiiéncias mais elevadas. Estudos reve-
lam que depois de assistir muita TV ou ficarem expostos a ilumina-
¢éo excessiva, os olhos reduzem sua capacidade de detectar varia-
¢bes de luz em freqiiéncias mais elevadas. Assim, o que este circui-

to faz & gerar sinais na faixa de 10 a 100 Hz de modo a se verificar 4,7 KQ 470 kQ

até que freqliéncia uma pessoa pode detectar as piscadas (note
que o LED esté piscando e ndo aceso continuamente). O circuito
deve ter o potenciémetro calibrado em fungéo das indicagdes dadas
por um freqliencimetro e depois usado nos testes. Observe a figura.

31. Gerador de MAT

Este circuito gera tensdes de
dezenas de milhares de volts
para projetos como filtros
eletrostaticos e experiéncias de
fisica. O transformador T, tem um
secundario de 24 V com uma
corrente de 3 A e o transistor
deve ser dotado de excelente ra-
diador de calor. O transformador
T, é um fly-back de TV no qual
tenhamos enrolado como prima-
rio 10+10 voltas de fio 22 rigido
comum com capa plastica. Os
resistores de 3,3 ohms sdo de
fio e a alta tensé@o pode superar

Ty

v

1N5404

|
1N5404 :\:I

I1000 IJF

—P {1

$1
33Q

3,3Q

47 pFI
33nF _f

221F | [3300 _L_

MJ15004

MAT

os 30 000 volts, sendo por isso necessario muito cuidado no uso de tal aparelho.
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23. Dobrador CMOS

- , Vee =
Este dobrador de tensdes é 0 +3ai5V

indicado para aplicacdes em que
se necessita de uma tenséo igual 5
ao dobro da aplicada na entrada, —
mas sob regime de muito baixa
corrente (para polarizagéo ape-
nas). A corrente de saida é limi-
tada a poucos microampéres. O Cl 4093
ajuste do ponto de melhor rendi-
mento ¢é feito no trimpot de 100 k 1

i . 1
ohms. O capacitor determina a
freqUéncia do circuito, podendo — 4
ser alterado conforme a aplicagéo. 2
Com a utilizagdo de uma etapa
de poténcia transistorizada na
saida do oscilador é possivel ele- ] ¢ 1ID kQ 142
var a capacidade de corrente des- 100 kQ 1 2Vee
te dobrador. Podemos usar um
Power-FET ou mesmo um bipolar W 47 nF 3 10 wF
como o BD135 que, evidentemen- I I
te, deve ser montado em radia-

dor de calor. Veja a figura ao lado.

J\é{z

¥1N4148

10 ]JF

10 *_—IH

&
o =
g

1N4148

A

27. Amplificador de

10Wem 2 Ohms

O amplificador apresentado
com o TDA2003 pode fornecer > .
uma poténcia de até 10 W
(rms) numa carga de 2 ohms,

100 nF 1000 F
e um pouco menos em carga . F
de 4 ohms. A tensdo méxima 2,2 pF TDA

de alimentagdo é de 18 V. O cir- IN o—[l - 2003

cuito integrado precisa ser ﬂl

montado num bom radiador de 3 1000 F

calor e os componentes da

rede de realimentagao determi-

nam o ganho de tensdo que,

no caso, é de 100 vezes (220/

2.2). 470
Os capacitores de desaco- = 100 nF 2/4‘)[;(]

plamento da fonte devem ser 470 pF o

montados o mais préximo pos- 1Q

sivel do pino 5. O circuito ndo T

inclui controle de volume, o 2209

qual deve estar no pré-amplifi- 2,20

cador. A compatibilidade do

circuito com uma tenséo de ali-

mentacdo de 13,2 V permite

que ele seja usado no carro.

18V
O (méx)

100 nF

-
==
= | 3
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24. Inversor

O inversor apresentado na fi-
gura pode gerar tensdes na faixa
de 80 a 600 volts dependendo do
transformador (Vs1). A corrente
de saida é da ordem de alguns
miliampeéres, mas o circuito pode
ser empregado em funcdes de po-
larizagao, acendimento de lampa-
das fluorescentes e néon, alimen-
tagdo de valvulas Geiger, testes

OVg

o—= Pt—r
+6/12V 8 4 1N4002 l
10kQ 7 6 Vg1 100 nF
10 kQ 555 3 1 kQ T
C - BD135 ] °
47 nF 2

a
220 nFI

R

de isolamento, etc. O BD135 admite equivalentes da mesma familia e deve ser dotado de um pequeno
radiador de calor. O valor do capacitor C deve ser escolhido para se obter o melhor rendimento na transferén-
cia de energia pelo transformador. A tensdo de entrada de 6 a 12V pode ser obtida de pilhas ou bateria.

18. Programador

de EPROM

Este circuito apenas gera a ten-
sdo que deve ser pulsada numa
EPROM para fazer a sua gravagao.
O pulsar pode ser comandado por
um circuito logico ligado & entrada
quando, entdo, o nivel 1 aplica o
pulso. Este circuito devera gerar o
pulso na largura exigida para cada
tipo de EPROM que serd gravada.
A entrada do circuito é feita com
uma tenséo de 30 V e o ajuste da
tensdo exata de pulso deve ser fei-
to nos dois frimpots. Ele também

30VO

1 b2 |1o 2

s
_ 525V

30 mA

serve de base para uma fonte de alimentagdo estabilizada de excelente qualidade bastando, para
tanto, que etapas de poténcia com transistores sejam acrescentadas. Acompanhe a figura ao lado.

21. Regulador de
Precisdo Discreto

O circuito regulador de tenséo
descrito é de alta preciséo e usa
componentes discretos (transisto-
res). Sua saida é indicada para a
alimentagao de fungdes TTL com
uma corrente de até 500 mA. O
transistor BD438 admite equiva-
lentes e deve ser montado em ra-
diador de calor. A tensdo de en-
trada deve ficar entre 7 ¢ 10 V. O
LED utilizado como referéncia no

ri mksﬂ

circuito é vermelho comum, e o ajuste exato da tenséo de saida é feito no trimpot de 1 k ohms. Outras
tensdes podem ser obtidas deste circuito com alteragéo dos valores dos componentes. Figura ao lado.

o 5V/0,5A
10 uF
1an b
1k
Bcs47 | |1ke
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DIODOS LASER

Os diodos LASER ou Lasers de injegcdo como também s&o co-
nhecidos, sdo utilizados numa grande quantidade de dispositivos
eletronicos incluindo-se algumas aplicagdes muito interessantes,
tais como os Laser Pointers, leitores de cddigo de barras e
detectores de objetos em linhas de producgdo. Eles também sdo
usados como referéncia no posicionamento de maquinas e em tre-
nas eletronicas. Como funcionam esses dispositivos e como
emprega-los em algumas aplica¢des praticas € o que veremos neste
artigo, que deve interessar aos leitores que precisam conhecer as

mais recentes tecnologias.

Laser é luz, mas luz de uma natu-
reza diferente. Para entender como
funciona um diodo LASER os leitores
devem ter antes uma nocgéo do tipo
de radiacdo que se obtém de um
LASER e de como ela é produzida.

Assim, veremos inicialmente como
funciona o LASER de um modo geral
para depois chegar aos LASERs
semicondutores ou diodos LASER.

LASER significa Light Amplification
by Stimulated Emission of Radiation
ou Amplificagdo de Luz por Emissao
Estimulada de Radiag&o. Conforme o
nome sugere, 0 LASER nada mais é
do que um dispositivo que amplifica a
luz, emitindo-a com caracteristicas di-
ferentes das fontes de luz como lam-
padas, LEDs, etc.

COMO FUNCIONA
Para efeitos didaticos vamos expli-
car como funciona um LASER toman-

do como exemplo o tipo tradicional que

68

usa um bastéo de rubi sintético e que
pode ser representado de forma
simplificada de acordo com a figura 1.

Nessa disposigdo, um bastéo cilin-
drico de rubi tem duas faces espelha-
das, sendo uma mais grossa que a
outra. O lado espelhado é o interno
de modo que a luz ou radiagdo que
seja produzida internamente ao dis-
positivo sofra reflexdes nesses espe-
lhos e, portanto, fique retida no seu
interior.

Em torno do bastédo de rubi é en-
rolado um tubo de xendnio, uma lam-
pada semelhante as encontradas nos

flashes fotograficos, porém mais po-
tente, e que é alimentada por um cir-
cuito de descarga de alta tenséo.

Quando uma descarga de alta ten-
s80 é produzida no tubo de flash ele
emite um forte pulso de luz, que é
absorvido pelos atomos do bastéao de
rubi. Essa absorgao ocorre pelos elé-
trons em torno dos atomos do materi-
al (que consiste num 6xido de alumi-
nio), os quais saem de suas orbitas
normais e passam para érbitas com
niveis de energia mais elevados, con-
forme é representado na figura 2.

O pulso de luz precisa ser extre-
mamente forte para que a maioria dos
atomos de rubi tenha seus elétrons
levados aos niveis superiores de ener-
gia, ou seja, para que haja uma “in-
verséo de populagido”.

A populagao dos elétrons que es-
tdo no nivel normal de energia passa
a ser menor do que a populagédo dos
elétrons que estéo excitados ou no
nivel mais alto de energia. Esta con-
dicdo é fundamental para que se ob-
tenha o efeito LASER.

Entretanto, depois do flash, os elé-
trons ndo podem ficar indefinidamen-
te nos niveis superiores de energia

Tubo de
xendnio Espelhamento
p,
Espelhamento i Feixe
Aol - N ¥ N N N B LASER
Bastao de Rubi Alta tenséo

Fig. 1 - Um LASER de Rubi.
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Niveis de energia (eV)

Nivel de

14

/ energia
mais alto

~

/

Py,

7
Energia Nivel de
absorvida enorgia
mais baixo

Fig. 2 - Ao pasar de um nivel de energia mais baixo
para um mais alto 0 a&tomo absorve energia.

retendo a energia absorvida. Uma fra-
¢éo de segundo depois de absorvida
a energia, os primeiros elétrons vol-
tam ao seu nivel original e, neste pro-
cesso, devolvem a energia que absor-
veram.

Conforme a distancia entre o nivel
original e o nivel em que os elétrons
estavam, temos a quantidade de ener-
gia devolvida no processo e, portan-
to, o comprimento de onda da radia-
¢ao emitida, veja exemplo na figura 3.

Um salto de energia maior signifi-
ca luz de menor comprimento de onda
ou maior freqiiéncia.

O féton de energia, que pode ser
luz visivel ou em outra freqiiéncia do
espectro, mas sempre de freqiiéncia
Unica, tem como efeito estimular os
outros elétrons do material que este-
jam no nivel mais alto de energia, fa-
zendo com que eles também tendam
a “devolver” a energia absorvida.

Assim, “batendo” num elétron pré-
ximo, o féton provoca a devolugéo de
um novo foton e passamos a ter dois
fotons emitidos dentro do material.

Dois fétons podem “bater” em dois
novos elétrons obrigando-os a descer
de nivel de energia e, conseqlente-
mente, & emissdo de mais dois fétons.
Os quatro fétons produzem oito e tudo
isso num processo em cadeia muito
rapido, conforme mostra a figura 4.

Os fotons que tendem a escapar
pelas faces do material ndo o fazem
inicialmente, voltando para o interior
do mesmo de modo a acelerar o pro-
cesso, pois as faces do rubi séo
espelhadas.

O efeito é explosivo e numa fragéo
de segundo todos os elétrons s&o obri-
gados a devolver a energia absorvida

SABER ELETRONICA ESPECIAL N ¢ 3/MAIO/2001

de uma forma quase que sincroniza-
da emitindo fétons com a mesma fre-
quéncia. A concentragéo dessa ener-
gia é tal que os espelhamentos ja néo
conseguem mais reter o feixe de
fotons produzidos e ele “escapa” pelo
lado mais fino na forma de um feixe
de radiagéo estreito, concentrado e
monocromatico, observe a figura 5.
Este é o feixe LASER que tem ca-
racteristicas especiais que diferenci-
am a sua radiagédo da luz comum.
No exemplo que demos, temos um
LASER pulsante, pois a emissao deve
ser feita com a produgéo de pulsos
intervalados do flash para que os elé-
trons absorvam e devolvam a energia.

Niveis de energia (eV)
F 3

Maior

/ nivel de
energia

=~

Menor
"', \\ energia

Maior

__/"energia
7

/

Fig. 3 - Quando os elétrons voltam para niveis mais
baixos de energia eles liberam energia.

v

2 Fétons

Féton O ———"> @

Atomo
“energizado”

Fig. 4 - Reago "em cadeia" liberando energia.

\@ﬂ@

&
e

“—

Dt ddd

Fig. 5 - Emisséo LASER.

Feixe de /

LASER
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No entanto, é possivel obter o mes-
mo efeito de forma continua em
LASERs a gas e do tipo de injecéo,
mas o principio de funcionamento é o
mesmo.

UMA RADIAGAO DIFERENTE

A radiagéo emitida é luz, e sua cor
depende do comprimento de onda ou
da energia dos fétons. No caso do rubi
essa radiagdo estd no espectro visi-
vel, aparecendo na forma de um feixe
fino de luz vermelha.

Contudo, a radiagéo emitida pelo
LASER tem caracteristicas proprias
que a diferenciam da luz comum,
como:

a) Monocromatica

Os “saltos” dos elétrons na devo-
lugéo da energia ocorrem entre niveis
bem definidos de energia. Isso signifi-
ca que a radiacdo emitida tem uma
freqliéncia Unica que determina a cor
da luz, se ela estiver no espectro visi-
vel.

E claro que a radiagdo também
pode estar na faixa do infravermelho
e mesmo do ultravioleta, dependendo
apenas das caracteristicas do materi-
al usado. Os LASERs mais comuns
atualmente s&o os que operam nas
faixas do infravermelho e visivel entre
o vermelho e o verde.

Assim, diferentemente de uma
lampada incandescente que possui
um espectro amplo onde radia¢des de
muitos comprimentos de onda ou co-
res se misturam, a radiagdo LASER
tem um espectro estreito conforme
ilustra a figura 6.

Podemos comparar uma lampada
comum a um circuito que gera um rui-
do que preenche toda uma faixa do
espectro, e 0 LASER a um circuito sin-
tonizado que emite sinais de frequién-
cia Unica.

b) Coerente

Os LASERSs sao especificados nor-
malmente como fontes coerentes de
luz, ou seja, aquelas em que a radia-
¢éo é emitida segundo um feixe muito
estreito e com fase regular e numa fai-
Xa muito estreita de freqliéncias. Na
prética, entretanto, isso ndo ocorre e
a maioria dos LASERs comuns ape-
nas se aproximam do que seria uma
fonte coerente ideal. De qualquer for-
ma, mesmo nédo sendo fonte absolu-
tamente coerente, o LASER pode ser
considerado como tal quando compa-
rado a outras fontes comuns de radia-
céo.

¢) Concentrada

Além da radiagdo do LASER ser
emitida num feixe muito estreito, ou
seja, com uma abertura muito peque-
na, ela concentra uma grande quanti-
dade de energia.

Desse modo, se a quantidade de
energia absorvida em um segundo
(que seria a duragéo do pulso do flash
excitador) for de 1 watt, se o processo
de emissdo posterior na forma de
LASER durar 1 milionésimo de segun-
do, ele corresponderda a uma potén-
cia instantédnea de 1 milhdo de watts.
Divide-se o tempo por 1 milhdo para
se multiplicar a poténcia por 1 milhao.
Isso explica porque o feixe de LASER
pode furar uma chapa de ago. Um fei-
xe que concentre de forma continua
tamanha poténcia e numa superficie

/ Lampada de xenbnio

LASER

Lampada de tungsténio

0,2 1,0

Fig. 6 - Espectro de emissao de algumas fontes.

18 " (pm)
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muito pequena gera calor suficiente
para vaporizar um material duro como
o ferro. E claro que a maioria dos
LASERs comuns, principalmente os
tipos de uso doméstico e de apare-
lhos eletrénicos como, por exemplo,
um CD-playerpossuem poténcias que
se medem em fra¢Ges de watts e, por
iss0, nao podem ter efeitos destrutivos
consideraveis. No entanto, a energia
concentrada num feixe muito estreito
pode ter efeitos prejudiciais para a vi-
sd0. Células sensiveis de nosso olho
podem ser destruidas se observarmos
diretamente um feixe de LASER.

O rétulo de PERIGO que acompa-
nha qualquer dispositivo que emita
radiacdo LASER néo é uma brincadei-
ra. Veja a figura 7.

LASER RADIATION
AVOID DIRECT EXPOSURE

* TO BEAM
MAX.

POWER: 0.25W
WAVELENGHT: 650.0 nm

Fig. 7 - Aviso de perigo que
aparece nos LASER.

UM MITO

Muitas pessoas acham que € pos-
sivel observar um feixe de LASER la-
teralmente, ou seja, que ele é visivel
como uma fina linha que deixa a fon-
te, de acordo com a figura 8.

Na verdade isso ndo acontece.
Para que a luz seja visivel ela precisa
iluminar alguma coisa.

Assim, o feixe s6 se torna visivel,
como ocorre com o feixe de luz de um
farol de automével, se ele passar por
um meio que tenha particulas em sus-
pensédo como, por exemplo, poeira,
neblina ou fumaga.

LASER SEMICONDUTOR

Um tipo de /aser que é bastante
comum nas aplicagdes eletrénicas é
0 LASER semicondutor. Pequeno, fa-
cil de ser fabricado, necessitando pou-
ca poténcia para ser alimentado, ele
pode ser usado em inimeras aplica-
¢Oes tais como leitores de cédigo de
barras, DVDs e CD-players, trenas
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Fig. 8 - Observando um feixe Laser.

eletrénicas, indicadores de nivel,
sensores industriais e muitas outras.

Na figura 9 temos a estrutura basi-
ca de um LASER semicondutor.

O principio de funcionamento lem-
bra muito o dos LEDs, uma vez que o
mesmo material € usado na sua cons-
trugdo: Arseneto de Galio ou GaAs.

menores passando ao vermelho, que
se tornaram populares com os Laser
Pointers, como o representado na fi-
gura 10.

Os pequenos moédulos dos LASER
pointers que contém uma fonte de
corrente constante para a excitacéo
dos diodos tém pregos bastante aces-

Fig. 9 - Estrutura de um
LASER de injegéo.

Espelhamento

Existem diversas formas de se es-
timular o material semicondutor de
modo a provocar a emissao de luz.

A mais utilizada é forgar a circula-
¢ao de uma forte corrente no sentido
direto de modo que ela circule pela
jungéo PN da estrutura indicada.

A diferencga bésica em relacéo ao
LED comum é que nao temos a emis-
sdo descontrolada de luz, mas sim a
existéncia de uma camara de resso-
nancia com os espelhamentos que
permitem obter o efeito da inverséo da
populagéo dos atomos excitados e,
depois, a emissédo controlada pela
volta dos elétrons aos niveis normais
de energia.

Uma das grandes vantagens dos
LASERs semicondutores é que a na-
tureza do material determina o com-
primento de onda da emisséo, ou seja,
a cor da luz. Isso significa que podem
ser fabricados LASERs com emissdes
de diversas cores ou comprimentos de
onda.

Os primeiros tipos que apareceram
eram de infravermelho e caros. Com
o tempo além do barateamento, foi
possivel obter comprimentos de onda

Fig. 10 - Um LASER
Pointer.

siveis e podem ser usados numa infi-
nidade de aplicagdes praticas.

Usos

Além do uso como LASER pointer,

(que deve ser analisada com cautela
dado o perigo que a radiagéo repre-
senta se incidir diretamente nos olhos
das pessoas), existem as aplicagbes
na industria e em equipamentos de
consumo. Nos equipamentos de con-
sumo, por exemplo, os LASERs
semicondutores fornecem o feixe que,
incidindo na superficie de um CD ou
de um DVD, iluminam os “pits” e “lands”
que correspondem aos bits gravados,
fornecendo por reflexdo o sinal para
um fotodiodo sensor.

Nas leituras de codigo de barras
um feixe de LASER varre rapidamen-
te as etiquetas dos caixas de super-
mercados e outros estabelecimentos,
fornecendo os cddigos gravados a um
sensor optico (por reflexéo).

Na industria os LASERs sdo em-
pregados em muitas maquinas como
elementos fornecedores do sinal para
sensores, por exemplo na leitura de
rotagdo ou movimento de pegas, pas-
sagem de objetos por linhas de pro-
dugao, etc.

Outra aplicagéo importante é na
medida e deteccdo de posi¢édo. O
posicionamento de uma maquina em
nivel pode ser feito de forma muito
mais precisa utilizando-se um feixe de
LASER como referéncia.

Um LASER modulado pode ser
refletido por uma parede e detectado
por um fotodiodo. Pela medida da de-
fasagem do sinal, conforme ilustra a
figura 11, pode-se ter a indicagéo exa-
ta da distancia entre os dois.

Este é o principio de funcionamen-
to das trenas eletrOnicas que operam
com LASERs. Observamos que 0
mesmo tipo de equipamento pode ser
feito também com base em ultrassons.

Finalmente temos a utilizagdo do
LASER modulado para fornecer os
sinais que atravessam as fibras
opticas. Um link a LASER capaz de
operar com freqliéncias de transmis-
sdo de terabytes por segundo foi re-
centemente testado nos Estados Uni-

que consiste na aplicagdo imediata dos, utilizando fibras dpticas. |
Emissor Laser
it e trle SR LU L L
Trena 4 8
eletronica el Fig. 11 - Medindo distancias Parede
com o LASER.
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RELHOS DE RAIO-X, ULTRA-SOM, MARCA-PASSO etc.

Programa:
Aplicagbes da eletr.analdgica/digital nos equipamentos médicos/hospitalares
Instrumentagdo baseados na Bioeletricidade (EEG,ECG,ETc.)
Instrumentagdo para estudo do comportamento humano

Dispositivos de seguranca médicos/hospitalares

Aparelhagem Eletrénica para hemodidlise

Instrumentagéo de laboratério de analises

Amplificadores e processadores de sinais

Instrumentagéo eletrénica cirdrgica

Instalagbes elétricas hospitalares

Radiotelemetria e biotelemetria
Monitores e cameras especiais

MANUTENCAO EM EQUIPAMENTOS HOSPITALARES

O OBJETIVO deste curso é preparar técnicos para reparar equipamentos da érea hospitalar, que utilizem
~ principios da Eletronica e Informatica, como ELETROCARDIOGRAFO, ELETROENCEFALOGRAFO, APA-

Vélido até 10/06/2001

Sensores e transdutores
Medicina nuclear
Ultra-sonografia
Eletrodos

Raio-X

Curso composto por 5 fitas de video

apostilas, de autoria e responsabilidade

(duragéo de 90 minutos cada) e 5

do prof. Sergio R. Antunes.

SABER MARKETING DIRETO LTDA.

PRECO: R$ 297,00 (com 5% de desc. & vista + R$ 5,00 despesas de envio) ou 3 parcelas, 1 + 2 de R$ 99,00 (neste caso
o curso também serd enviado em 3 etapas + R$ 15,00 de desp. de envio, por encomenda normal ECT.) - PEDIDOS: Utilize
a solicitagdo de compra da Ultima pagina, ou DISQUE e COMPRE pelo telefone: (11) 6942-8055

it = BU e AN R E TR ke

MODULOS HIBRIDOS
(Telecontrolli)

‘Utilidades:
@ controle remoto
I sistemas de segurancga
mssssessssen alarme de veiculos
s elc.

Obs: Maiores detalhes, leiam
artigo nas revistas Saber
Eletronica n? 313 e 314

CARACTERISTICAS:

* Frequéncia de 315, 418 ou 433,92 MHz
* Ajuste de frequéncia a LASER

* Montagem em SMD

* Placa de ceramica

Preco:
RR3 (2,5 mA)
RR5LC (0,8 a 1,2 mA)

R$ 45,90 - 2 pes
R$ 55,80 - 2 pgs

Pedidos: Disque e Compre (11) 6942-8055
Saber Marketing Direto Ltda.

GANHE DINHEIRO
INSTALANDO
BLOQUEADORES
INTELIGENTES DE TELEFONE

Através de uma senha, vocé
programa diversas fungdes, como:
- BLOQUEIO/DESBLOQUEIO de 1
a 3 digitos

- BLOQUEIO de chamadas a
cobrar

- TEMPORIZA de 1 a 99 minutos
as chamadas originadas

- E muito mais...

Caracteristicas:
Operag@o sem chave
Programével pelo préprio telefone
Programacéo de fdbrica: bloqueio
dos prefixos 900, 135, DDD e DDI
Fécil de instalar
Dimensdes:

43 x 63 x 26 mm
Garantia de um ano,
contra defeitos de
fabricagdo.

APENAS
RS 48,30

Pedidos: Disque e Compre
(11) 6942-8055

Saber Marketing Direto Ltda.




COMPONENTES UTEIS
DATA-SHEETS
COMPLETOS DA INTERSIL

Um dos grandes problemas que
todo profissional dos diversos seto-
res da Eletronica enfrenta, é ndo ter
em maos informagdes completas so-
bre determinados componentes no
momento em que precisa fazer um
projeto, uma reparagdo ou simples-
mente descobrir um equivalente.

A gigantesca quantidade de com-
ponentes e o volume extremamente
grande que uma literatura ocupa, séo
os principais impedimentos para que
mesmo as empresas nao tenham to-
dos os manuais possiveis.

A solugdo esta na Internet, entre-
tanto, nem sempre o profissional tem
acesso ou sabe onde esta exatamen-
te a informagéo que precisa, e ndo
pode perder tempo com sua busca.

Dessa forma, visando fazer desta
edicdo especial um verdadeiro banco
de dados para os profissionais, esta-
mos incluindo uma coleténea de data-
sheets que representam centenas de
paginas de informagdes sobre compo-
nentes que, ao nosso ver, séo ainda
bastante usados.

O fabricante de componentes es-
colhido foi a INTERSIL CORPORA-
TION que colaborou com esta edigdo
fornecendo uma ampla literatura téc-
nica em formato PDF, a qual passa-
mos aos leitores.

S&0 mais de 50 componentes de
grande utilidade com data-sheets
completos, enfim tudo que é preciso
saber para um projeto.

Estes componentes estéo inclui-
dos no seguinte grupos de fungdes:

a) amplificadores operacionais

b) comparadores

¢) reguladores de tens&o

d) timers

e) conversores A/D com driverpara
display

f) fungdes RS-232.

Os componentes escolhidos foram:

CA3045 CA3045
CA3039 CA3081
CA3082 CA3096

CA3096A  CA3096C
CA3078 CA3078A
CA3146 CA3146A
CA3183 CA3183A
CA3140 CA3140A
CA3160 CA3160A
CA741 CA741/C
CA723 CA723C
CA124 CA224
CA324 CA1458
CA1558 CA1524
LM741 LM741C
LM1458 LM2901
LM3302 LM324
LM2902 CA139
CA139A CA339
CA239 CA3290
CA3290A  CA3262
CA3262A  CA3275
CA3272A  CAS8292A
CA3280 CAS3280A
CA3524 HIP4080A
HIP4081A  HIP2060
HIP0045 HIP6004
HIP2106 HIP6016
HIP6020 HIP6301

FN341
FM343
FNA80
FN532
FNS85
FN741
FN788
FN795
FN1048
FAI1238
FN1836

FN2169
FN2223
FN2853
FNI2855
FN2861
FN2B65
FN2866
FNZBE7
FN3019
m‘mao
FN3158

FN3160
FN3180
FN3619
FN3BSE
FN3B59
FN3BB3
FN4047
FN4275
FN4408
FNA4SEE

FN4583

HIP6601 HIP6603
HIP6004D  HIP6500B
HIP6502B  ICL7667
ICL8048 ICL232
ICL7663S  1CL3225
ICL3227 ICL3245
ICL3221E  ICL3222E
ICL3223E  ICL7650S
ICL7106 ICL7107
ICL7107S  ICL3241E
ICL3243E  HA-4900
HA-4905 HA-4902
HA-2546 HA2556/883
HA-5020 ICM7242
ICM7555 ICM7556
ICM7170 ICM7211
ICM7212 ICM7228
IPM6220

Para acessar a informagéo comple-
ta, basta clicar no botdo data-sheet.

Toda a documentagao inserida no
CD foi fornecida pela INTERSIL
CORPORATION.

« EsPeciaL ez %(

INTERSIL
Os arquivos abaixa estan em inglés e no formato pdf, necessitandn,
para serem visualizados, do grograma Adabe Acrobat Reader ,

(CLIQUE ADLI PARA msr_nfqn 0 ACRDBAT READER 4.0)

FN47B5

FN4819
FNABSS

FN4870
FNag71

FNSE78

5

£A3280

i

© Waso20
FNA910 . ICL710B-7
CA3078 1CL76508
CA3140  LM2902-CA324

e
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APROVEITE ESTA
OMO G

(valido até 10/06/2001)

Ao comprar 6 edicoes ou mais (a sua escolha),
vocé nao pagara as despesas de envio.

PROMOGAO VALIDA PARA AS
EDICOES: de N°288/JAN/97
até Ne337/FEVEREIRO/01

Obs.: a edi¢do N2304 - (estd esgotada)

N9330 - N2333 - NS l-:b.niwn.on-wm::.u-mm ™ 2
JULHO/00 o tgial | movarc SRR oEzEMERO0 ELETRONICA

magquinas cnc / Reparando
monitores de video - a fonte de
alimentacédo / Praticas de
service - telefones celulares /
Termémetro diferencial / Uma
rapida abordagem do cédigo de
hamming / Eletroscépio / Som -
alguns termos técnicos / Médulo
de automagao por sinais alter-
nados / Gravador de eprom
2732 / Aterramento elétrico -
parte 1l / Histerese / Lm1292 -
sistema pll de video para

ELETRONICA

Gawcs
MAQUINAS CNC

L .

;

L

cOes de monitores
de video campos
magnéticos e ima-
gem / Detectando
e medindo a radia-
cédo / Luz forte
temporizada/ Alar-
me sonico / Trans-
forma seu fax anti-
go em impressora
ou scanner / Uni-
dades inglesas e

e

IEMIONES
B smAnEwE

FOLLICAG . ]
FLETROMAENE IV
cONTADDR

1AL

.

Uma introdugdo ao
DSP - (parte I)/ Mul-
timetros TRUE RMS
/ Conversor DC/DC/
Raios-orientacao
sobre procedimen-
tos gerais / Proble-
mas de EMC - como
evitar / LHO091 -
Conversores TRUE
RMS para DC / Ali-
mentando projetos a

REULTIRE (0%

TRUE A

ANALISADGRES
DE ESPLETRO

partir do PC / Motores DC e Caixas de Redugéo /
Analisadores de espectro (parte 11} / Os circuitos de
video / Teste de isolamento / Detector de nivel

equivalentes métri-
cos / Poluigéo ele-
tromagnética / Modulagdo em frequéncia / Emi -
electromagnetic interference / Contador industrial

monitores de sincronismo con-
tinuo / Lm1295 - sistema de corregéo de geometria
controlado por dc / Os padrdes vesa / Barramento 12¢
com microcontrolador /medidor de fase

microcontrolado / Controle de movimento / Como

funcionam os sensores de imagem ccd / O sensor ~ N2336 - e
PARES TERMOELETRICOS fet / Bq2057 / Ucc3895 / Quik tech 98 JANEIRO/01 L i
P g ELETRONICA
ELETRH”‘EH O A (5 THT (AN ¥0CIAGE SLTR XSO As ferramentas .,
’ e ey St
SENHA N2331 - S 2 n A
ELETRONICA SR x E Andlise da rede
ATERRAMENT AGO,STOIO,O ) ELETHE“' H Ne2334 - elétrica / Ondas
FUETRICO: oo - semdforos inteligentes / Impresso- |l ey e NOVEMBRO/0O  estacionarias/ O
ras / Como eliminar interferéncias & A astinin Lanl Analisadores de  que & PWM? / ELETRICA
e em radio§ e cd-players pares Espectro/TV DI+ Uma arquitetL;ra e
SEMA termoelétricos / Pares termoelé- . ) SR
SEMAFOROS gital - (parte Il) /' computacional Eatkily]
FELIGE! tricos / Senha eletronica / Sistema ! Telefonia Digitale teraativa /
de seguranga para automoveis / Multisservicos  COP8 Flash / COP_B_
a1 e | Apagador de eprom / Controle por el
som (vox) / Aterramento elétrico - Sobre Par-tran- L1851 - Detec-
cado / Energia  tordefugaspara [IMIHIRN

parte 1ll/ Fator de poténcia na indUstria / Etapa classe b - (push-

Li P
pull) / Conheca os diodos schottky / O mouse - Trr e Seu

Equipamento /
Os Ultrassons /
Fases de Siste-
mas de Alto-fa-
lantes / Redes Profibus e Ethernet/ Conhega os TVS
/ Reatéancia Capacitiva / Sensores de Imagens / Con-
trole DC PWM / Préticas de Service / Contador Uni-
versal Usando PIC / Pré-amplificador de Volume Cons-
tante / Fontes de Alta Corrente / Temporizador Mlti-
plo Modular / Simulador de Presenga

a terra / Placa
microcontrolada para robds méveis / Seletor de
video para cameras CCD / Fonte simétrica / Ter-

2 =
Ne332 mdmetro microcontrolado

SETEMBRO/00
usb - universal serial bus / Defeitos em equipamentos
de som/ Reparag&o de monitores de video - implosdo
e choques / Indicador de linha para deficiente visual /
Fonte de 13,8 v x 25 a/ Controle de display de 7 digi-
tos / Aromatizador eletrénico / Campainha audivel e
luminosa / Como
. “"‘"“':"“” S8 funciona o gps (glo-
mﬂ]‘nn"':ﬂ bal  positioning
R system) / Fator de
517 VW % poténcia na indus-
| tria (parte If) / Expe-
rimentos com moto-
res de passo/Lm74
- sensor digital de
temperatura /
Lm2437 e Im2438 -

N2337 -
FEVEREIRO/01
Mini-Curso - Progra-
magédo Delphi para
Eletrénica - Parte XI /
Radio digital / DSP -
Processamento em
Tempo Real - Amos-
tragem / Perigo Nucle-
y ar - O Pulso Eletro-
magnético / Néon &
CMOS / Circuitos com
Reguladores de Ten-
s&o / Fontes de Cor-
rente Constante / Acionamento de motor DC

ELETRONICH

DELPHI /i~

Pedidos:

SABER MARKETING DIRETO LTDA.
Verifique as instru¢des na solicitagdo de
compra da Ultima pégina.
Maiores informacgoes

D6 TEMPERATURS

OSCHOECOMG
x
ANALMADOR LOGHS

drive de trc para
monitores de video /
Discos flexiveis /
Osciloscopio x ana-
lisador I6gico

Disque e Compre (11) 6942-8055.
Rua Jacinto José de Araljo, 309
Tatuapé - Sao Paulo - SP -
CEP: 03087-020

microcontrolado / Inversores de Frequéncia
Vetoriais / Informagdes sobre SCRs / Uso de Relés
em Robédtica e Mecatrdnica / Usando o Provador/
Reativador de Cinescépios / Aplicagdes diferentes
para o 555 / Comande um LCD através de um PC



LITERATURA TECNICA

MICROCONTROLADOR
8051 - DETALHADO

Autor: Denys
Emilio Campion
Nicolosi - 256 pags.

O microcontrolador da familia 8051
é 0 mais consumido e aplicado no mun-
do. S&o mais de 300 milhdes de pecas
vendidas por ano!

A proposta deste livro é ensinar so-
bre os microcontroladores da familia
8051, com extenso material didatico
tedrico para o estudante melhorar sua
competéncia até poder projetar
hardware e software com boa desen-
voltura. Ele contém: revisdo geral deta-
lhada de ldgica e aritmética binaria;
circuitos légicos e memérias; teoria
especifica e detalhada do microcontro-
lador; listas completas das instrucoes;
exercicios propostos; diagramas de
programacao; extensa bibliografia e

PROCESSADORES Intel
Autores: Renato Rodrigues Paixao e
Renato Honda - 176 pags.

O objetivo principal deste livro é apresentar a evolugéo dos
Micropocessadores da Familia Intel, partindo do processador 4004
até o Pentium lll, e as tecnologias introduzidas com eles, tais como:
MEMORIA CACHE, MMX, EXECUCAQ DINAMICA, DIB, AGP, en-
tre outras. S&0 apresentadas também as caracteristicas técnicas
de Chipsets, Memérias DRAM e comparagbes de desempenho
entre os prodessadores, levando-se em conta os trés vetores
(INTEGER, FP e MULTIMEDIA), tornando o livro uma excelente
fonte de informag&o e também auxiliando na escolha adequada de
processadores, memorias e chipsets para a aquisicao de PCs, ou
especificagdo de Hardware para consultores ou departamentos
técnicos.

PROCESSADORES

Intel

Frocessadore
Expcican TNndmici

H’ €aIcA

RS 29,90

DESBRAVANDO O PIC
Baseado no microcontrolador PIC16F84
Autor: David José de Souza - 199 péags.

Um livro dedicado as pessoas que desejam conhecer € pro-
gramar o PIC. Aborda desde os conceitos tedricos do componen-
te, passando pela ferramenta de trabalho (MPASM). Desta forma
o MPLab é estudado, com um capitulo dedicado a Simulagéo e

Deshravando o

Debugagéo. Quanto ao PIC, todos 0s seus recursos s&o trata-
dos, incluindo as interrupgdes, os timers , a EEPROM e 0 modo
SLEEP Outro ponto forte da obra é a estruturagéo do texto que foi
elaborada para utilizagdo em treinamento ou por autodidatas, com
exemplos completos e projetos propostos.

indice remissivo.

RS 34,00

Microcontrolador

EWB 5 - Eletronics Workbench
Anélise e Simulacéo de Circuitos no Computador
Autor: Eng.Rémulo Oliveira Albuquerque - 143 pags.

Este é mais do que um livro sobre um software de simulag&o de
circuitos. Nele vocé encontrard, de forma simples e direta, todos os
comandos e procedimentos necessarios para montar e simular, pas- i
SO a passo, 0 seu circuito, seja digital ou analdgico. Além disso, €
descrito o funcionamento dos mais variados instrumentos usados em
um laboratério real, tais como: Osciloscopio, Gerador de Funcéo,
Multimetro, Bode Ploter, Analisador Logico e Gerador de Palavras
Bindrias, sendo fornecidos exemplos didaticos de aplicagdo com eles.

R$ 39,90

MONTAGEM, MANUTENGCAO E CONFIGURAGAO DE COMPUTADORES PESSOAIS

Este livro contém informagdes detalhadas sobre montagem de computadores pesso-
ais. Destina-se aos leitores em geral que se interessam pela Informatica. E um ingresso
para o fascinante mundo do Hardware dos Computadores Pessoais. Seja um integrador.
Monte seu computador de forma personalizada e sob medida. As informagdes estéo base-
adas nos melhores produtos de informatica. llustragdes com detalhes requissimos iréo
ajudar no trabalho de montagem, configuragéo e manutengao.

Escrito numa linguagem simples e objetiva, permite que o leitor trabalhe com computa-
dores pessoais em pouco tempo. Anos de experiéncia profissional séo apresentados de
forma clara e objetiva.

Autor:
¥ Edson D'Avila
240 pags.

R$ 39,00

SABER MARKETING DIRETO LTDA.
Verifique as instrugdes na solicitagdo de compra da Ultima pagina. Maiores informagoes
Disque e Compre (11) 6942-8055. -Rua Jacinto José de Aradjo, 309 - Tatuapé - S&o Paulo - SP
REMETEMOS PELO CORREIO PARA TODO O BRASIL




SHOPPING DA ELETRONICA

Saber Marketing Direto Ltda.
Rua Jacinto José de Aratijo, 309 - Tatuapé - Sdo Paulo - SP.

DISQUE E COMPRE (11) 6942 8055

Matriz de contatos PRONT-O-LABOR
A ferramenta indispensavel para protétipos.
PL-551M: 2 barramentos 550 pontos........c.ccoeeevinene R$ 32,00
PL-551: 2 barramentos, 2 bornes, 550 pontos....... R$ 33,50
PL-552: 4 barramentos, 3 bornes, 1 100 pontos........ R$ 60,50
PL-553: 6 barramentos, 3 bornes, 1 650 pontos......... R$ 80,00

Pregos Validos até 10/06/2001

Mini caixa
de reducao

VIDEOCOP - PURIFICADOR
DE COPIAS

Equipamento para o profissional e
amador que queira realizar copias
de fitas de video de suas reporta-
gens, sem a perda da qualidade de
imagem...R$ 163,00

VISITE NOSSA
LOJA VIRTUAL

Placa para frequencimetro Digital de 32 MHz SE FD1

Artigo publicado na revista Saber Eletrénica n® 184‘ ....R$ 10|00
Placa PSB-1

(47 x 145 mm - Fenolite) - Transfira as montagens da placa

experimental para uma definitiva ..........cccccoeeinnn R$ 10,00
Placa DC Médulo de Controle - SECL31

(Artigo publicado na Revista Saber Eletrénica n® 186) ...R$ 10,00

MATRIZ DE CONTATO

Para movimentar
antenas internas, pre-
sépios, cortinas robds
e objetos leves em
geral

R$ 39,50

www.sabereletronica.com.br

Suas compras de eletrénica Online

Somente as placas
de 550 pontos cada
(sem suporte) pacote
com 3 pegas ..... R$ 52,00

MONTE VOCE MESMO UM
SUPER ALARME ULTRA-SONS

N&o se trata de um alarme comum e sim de um
detector de intrusdo com o integrado VF 1010. (Leia ar-
tigo SE n? 251). Um integrado desenvolvido pela VSI -
Vértice Sistemas Integrados, atendendo as exigéncias
da industria automobilistica. Venda apenas do conjunto
dos principais componentes, ou seja: Cl « VF1010 - um
par do sensor T/R 40-12 Cristal KBR-400 BRTS

(ressonador)
R$ 19,80

PLACAS VIRGENS

PARA CIRCUITO
IMPRESSO

Contém: tudo do CK-
10, menos estojo e
suporte para placa

R$ 31,50

5x8cm -R$ 1,00
5x 10 cm - R$ 1,26
8 x 12 cm - R$ 1,70

MICROFONES
SEM FIO DE FM

PONTA REDUTORA

DE ALTA TENSAO MINI-FURADEIRA

Furadeira indicada para:
Circuito impresso, Artesana-
to, Gravagdes etc. 12 V - 12
000 RPM / Dimensdes: dia-

CAIXAS PLASTICAS

Caracteristicas:

- Tensdo de alimentacéo: 3
V (pilhas pequenas) - Corren-
te em funcionamento: 30 mA

(tip) -

KV3020 - Para multimetros
com sensibilidade 20 KQ/
VDC.

KV3030 - Para multimetros ¢/

Com al¢a e alojamento para
pilhas
PB 117-123x85x62 mm... R$ 7,70

sensib. 30 KQ/VDC e digitais.

As pontas redutoras sdo utili-
zadas em conjunto com multi-
metros para aferir, medir e lo-

Alcance: 50 m (max) - Faixa
de operagdo: 88 - 108 MHz -
Numero de transistores: 2 -
Tipo de microfone: eletreto

PB 118-147x97x65 mm...R$ 8,60 metro 36 x 96 mm. R$ 28,00

ACESSORIOS: 2 lixas

Com tampa plastica circulares - 3 esmeris em

PB112-123x85x52 mm... R$ 4,10

formatos diferentes (bola, tri-

calizar defeitos em alta ten- de dois A . |
sBes entre 1000 V DC a 30 terminais Para controle angulo, disco) - 1 politris e 1
KV-DC, como: foco, MAT, || (Ndo acompanha CP 012 - 130 x 70 x 30..R$ 2,80 | | 2daptor. RS 14,00
"Chupeta" do cinescépio, li- pilhas) - 4
nha automotiva, industrial etc )

R$ 15,00 Com painel e alga

R$ 44,00 PB 207-130x140x50 mm..R$ 8,30

=

Conjunto CK-10
(estojo de madeira)

SPYFONE - micro-transmissor
Um micro-transmissor secreto de FM , com microfone ultra-sen-
sivel e uma etapa amplificadora que o torna o mais eficiente do
mercado para ouvir conversas a distancia. De grande autonomia
funciona com 4 pilhas comuns e pode ser escondido em objetos
como vasos, livros falsos, gavetas, etc. Vocé recebe ou grava con-
versas & distancia, usando um rddio de FM, ge carro ou aparelho

Contém: placa de fenolite,
cortador de placa, caneta, per-
furador de placa, percloreto de

de som. ferro, vasilhame para corro-
NAO ACOMPANHA GABINE /N sdo, suporte para placa
R$ 39,50 i R$ 37,80




Com este cartdo consulta
VOCé enfra em contato com
qualguer anunciante desta revista.
Basta anotar no cartdo os nUmeros
referentes aos produtos que Ihe
inferessam e indicar com um o

“X” o tipo de atendimento.

e R e <

REVISTA @® Preencha o cartdo claramente em todos os campos.

SABER @ Coloque-o no correio imediatamente.

ELETRONICA @ Seu pedido sera encaminhado para o fabricante. ISR-40-2063/83
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Com este cart@o consulta
vOCcé entfra em confafo com
qualquer anunciante desta revista.
Basta anotar no cartdo os nidmeros

| referentes aos produtos que Ihe
interessam e indicar com um
"X” o tipo de atendimento. _

e NGB .

REVISTA @ Preencha o cartéo claramente em todos os campos.

SABER @ Cologue-o no correio imediatamente.

ELETRANICA® Seu pedido serd encaminhado para o fabricante. ISR-40-2063/83
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Cidade Estado X
03014-000 - SAO PAULO - SP

CEP Tel.
Fax N¢ empregados
E-mail
78




Solicitagdo de Compra

Para um bom atendimento, siga estas instrugoes:

T COMO PEDIR

Faca seu pedido preenchendo esta solicitacdo, dobre e coloque-a em qualquer caixa do correio. Nao
recisa selar. Pedidos com urgéncia Disque e Compre pelo telefone (11) 6942-8055.

VALOR A SER PAGO

ApOS pfeeﬂChel' 0 seu pedido, some 0s valores das mercadorias e acrescente o valor da postagem e

manuseio, constante na mesma, achando accim o valor a pagar.
COMO PAGAR - escolha uma opgao:

- Cheque = Envie um cheque nominal 2 Saber Marketing Direto Ltda. no valor total do pedido. Caso vocé
nio tenha conta bancéria, dirija-se a qualquer banco e faga um cheque administrativo.

- Vale Postal = Dirija-se a uma agéncia do correio e nos envie um vale postal no valor total do pedido, a
favor da Saber Publicidade e Promogdes Ltda, pagével na agéncia Belenzinho - SP
(n&o aceitamos vales pagéaveis em outra agéncia)

- Depésito Bancdrio = Ligue para (11) 6942-8055 e pega informacdes.
(ndo faga qualquer deposito sem antes ligar-nos)

OBS: Os produtos que fugirem das regras acima terdo instrugdo no préprio anincio.
(ndo atendemos por reembolso postal)

ESPO03
Pedido minimo R$ 25,00 VALIDO ATE 10/06/2001
Quantidade Produtos Valor R$

LL_J_L,LJ-J_J

L

I

Postagem e Manuseio 5,00

Valor total do pedido

Nome:

Enderego: Cidade:
Bairro: Fone para contato:
Cidade: Estado: CEP:
Profissdo CPF

Assinale a sua opgao:
[ 1 Estou enviando 0 chequel ] Estou enviando um vale postal | Estou efetuando um deposito bancario

DATA: / / J




corte

dobre

ISR-40-2137/83

- o
- AG.BELENZINHO

CARTA RESPOSTA

NAO E NECESSARIO SELAR

O SELO SERA PAGO POR:

Saber Marketing
4 Direto ltoa.

03014-000 - SAQ PAULO - SP
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AS A
OLUCAO PARA O ENSINO DA ELETRONICA PRATICA INSTRUMENTACAO

KIT DI DATI c o Toda a linha Minipa

MK-906 - escorano sk sansulta

Caracteristicas

300 experiéncias, divididas n [
, nos seguintes grupos: Circuit Asi a
aos Oomponentes), Blocos Eletronicos Simples (Utilizados 2 83@?@'323 é!“é?r‘iﬂﬁi‘s’

o Compleros), Circutos de Rdo, Efetos Sonoros, Jo-
Q?Jas/sEQtr()eicos,);\mp“ﬂcadomg Operacionass, Eletronica

Digital, Contadores, Circuitos de Computadores € Circuitos
de Testes e Medidas.

. Alguns componentes € 0 proto-board sa0 pré-montados.

. Conectores simples em terminais espirais.

. Alimentag&o: 6 pilhas (1,5 V)

. Dimensges: 340(L)x239(P)x58(A)mm

Contém LEDs, Display, Fotorresistor, Alto-falante, Antena,
Transformador, Capacitor Variavel, Potenciometro, Chave, Te-
clas, Proto-board, Circuitos Integrados (NAND, NOR, Contador, Decodificador, Flip-
Flop, Amplificador de Audio), Transistores, Diodos, Capacitores, Trimpot, Fone de Ouvi-
do e Resistores.

Acessorios: Manual de Experiéncias + Conjunto de componentes € Cabos.

MK'1 1 8 R$ 99,00 + desp- de envio

Caracteristicas:
. Conjunto de 118 experiéncias.
. Alimentado por pilhas.
. Algumas das experiéncias: Radio AM, Ventilador Automati-
co, Sirene de Bombeiro, Som de Fliperama, Telégrafo, Farol
Automatico e muito mais.
. Dimens0es 280(L)x1 90(A)mm
Contenm: Circuitos integrados (musical, alarme, sonoro € amplificador de poténcia),
Capacitores Eletroliticos, Ceramicos, Resistores, Variavel, Fotorresistor, Antena, Alto-
falante, Microfone, Lampadas, Chave comum € Telégrafo,Transistores PNP e NPN,
Amplificador de Alta Frequéncia, Base de montagens, Hélices e Barra de Ligagéo.
Acessorios: Manual de experiéncias ilustrado.

MK"904 R$ 619,00 + desp. de envio

Caracteristicas
500 experiéncias, com circuitos eletronicos © programagéo de microprocessadores,
divididas em 3 volumes:

Hardware - Curso de Introducao: introducdo aos componentes, Pequenos Blocos
Eletrdnicos, Circuitos de Radio, Efeitos Sonoros, J0gos Eletronicos, Amplificadores
Operaciona'ls, Gircuitos Digitais, Contadores, Decodificadores € Circuitos de Testes €
Medidas. - Curso avangado: Aprimoramento dos conhecimentos ad-
quiridos na etapa anterior, dividida nos mesmos grupos.

Software - Curso de Programagao: Introducéo ao Micropro-
cessador, Fluxograma de Programagao, Instrugdes, Formatos €
Programagao.

. Conectores simples em terminais espirais.
. Alimentag@o: 6 pilhas (1 5 V)
. Dimensoes:. 406(L)x237(P)x85(A)mm.

Contém:

L EDs, Display de 7 segmentos, Fotorresistor, Fototransistor, Alto-falante, Antena,
Transformador, Capacitor Variavel, Potencidmetro, Chave, Teclas, Microprocessador
com LCD, Teclado, Proto-board, Circuitos integrados, (NAND, NOR, Contador,
Decodificador, Flip-Flop; Temporizador, Amplificador de Audio e Operacional), Tran-
sistores, Diodos, Capagcitores, Fone de Ouvido € Resistores.

Acessorios: Manual de Experiéncias 3 volumes) + Conjunto de Componentes €
Cabos para Montagem

Ampla rede de Assisténcia Técni

Compre agora € receba via SEDEX - LIGUE JA pelo telefone:
(11) 6942-8055 - SABER MARKETING DIRETO.

ESCOLAS

MATERIAL ADEQUADO A NOVA LDB - PREGOS ESPECIAIS PARA MAIS DE 10 PEGAS.

INSTRUMENTOS PARA
TELECOMUNICA(}OES

ENVIAMOS PARA TODO O

TERRITORIO NACIONAL - FACA

vendas.saber
OuU FAX (1) 21 8;3366 EQ@1Y 294-
0286 - PEDIDO MINIMO R$ 1.400,00

SABER MARKETING DIRETO
(23 ANOS VENDENDO
A DISTANCIA)
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BREVE
2ou NAS BANCAS

A REVISTA SOBRE PC FEITA
POR QUEM ENTENDE DE
HARDWARE, HA MUITO TEMPO]
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